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Preface
This preface contains the following topics:

• “About this guide” on page viii

• “Accessing Automation Solutions user guides” on page x
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About this guide

Who should read this guide

This user guide is for people with the following job roles:

 

What this guide covers

This guide describes the BioCel System, the operation of the hardware 
components, and the use of the diagnostics software.

This guide does not provide instructions for the following:

• VWorks software or third- party software

• Agilent Technologies devices, such as the Bravo Automated Liquid Handling 
Platform, PlateLoc Thermal Microplate Sealer, Microplate Seal Piercer, 
Microplate Labeler, Vertical Pipetting Station, Microplate Centrifuge, and 
Labware Stacker.

• Third- party devices

For more information about these topics, see the relevant user guides for these 
products.

Software version

This guide documents: 

• DDR Diagnostics version 1.2.x or later

• 3- Axis Robot Diagnostics version 18.1.2 or later

• KiNEDx Robot Robot Diagnostics version 15.0.0 or later
                                                        

Job role Responsibilities

Installer Unpacks, installs, and tests the BioCel System before it is 
used.

Integrator Writes software and configures hardware.

Lab manager, 
administrator, 
or technician

• Manages the automation system that contains the 
BioCel System

• Develops the applications that are run on the system

• Develops training materials and standard operating 
procedures for operators

Operator Performs the daily production work on the BioCel System 
and solves routine problems.
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What’s new in this guide

Related guides

The BioCel System User Guide should be used in conjunction with the 
following user documents:

• BioCel System Safety Guide. Describes the potential safety hazards on the 
BioCel System and how to avoid them.

• BioCel Environmental- Control System User Guide. Describes the 
Environmental- Control System in the BioCel System, the operation of the 
relevant hardware components, and the use of the iSeries Diagnostic 
software.

• VWorks Software Quick Start. Provides an overview of how to use the 
VWorks Automation Control software.

• VWorks Automation Control User Guide. Explains how to add devices, 
create protocols, and set task parameters for each device in the system.

• VWorks Automation Control Setup Guide. Explains how to define labware, 
track labware, and manage users.

• Automation Solutions device user guides. Explain how to set up and use 
the Automation Solutions device.

• Third- party device user documents. Explain how to set up and use the 
third- party device.

Related information

                                                        

Feature and description See

The Direct Drive Robot instructions have 
been updated.

“Setting up the Direct Drive 
Robot” on page 45 and “Using 
diagnostic tools” on page 205

Instructions for the Microplate Conveyor 
are added.

“Microplate Conveyor” on 
page 285

For information about... See...

Accessing related user guides “Accessing Automation Solutions user 
guides” on page x

Reporting problems “Reporting problems” on page 203

http://www.chem.agilent.com/Library/usermanuals/Public/G5500-90003_BioCelECUG_EN.pdf
http://www.chem.agilent.com/Library/usermanuals/Public/G5415-90004_VWorksQS_EN.pdf
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Accessing Automation Solutions user guides

About this topic

This topic describes the different formats of Automation Solutions user 
information and explains how to access the user information.

Where to find user information

The Automation Solutions user information is available in the following 
locations:

• Knowledge base. The help system that contains information about all of the 
Automation Solutions products is available from the Help menu within the 
VWorks software. 

• PDF files. The PDF files of the user guides are installed with the VWorks 
software and are on the software CD that is supplied with the product. A 
PDF viewer is required to open a user guide in PDF format. You can 
download a free PDF viewer from the internet. For information about using 
PDF documents, see the user documentation for the PDF viewer.

• Agilent Technologies website. You can search the online knowledge base or 
download the latest version of any PDF file from the Agilent Technologies 
website at www.agilent.com/lifesciences/automation. 

Accessing safety information

Safety information for the BioCel System is provided in the BioCel Automation 
System Safety Guide.

Safety information for the Agilent Technologies devices appears in the 
corresponding device user guide.

You can also search the knowledge base or the PDF files for safety information.

Using the knowledge base

Knowledge base topics are displayed using web browser software such as 
Microsoft Internet Explorer and Mozilla Firefox.

Note: If you want to use Internet Explorer to display the topics, you might 
have to allow local files to run active content (scripts and ActiveX controls). To 
do this, in Internet Explorer, open the Internet Options dialog box. Click the 
Advanced tab, locate the Security section, and select Allow active content to run in 
files on my computer.

To open the knowledge base, do one of the following:
• From within VWorks software, select Help > Knowledge Base or press F1.

• From the Windows desktop, select Start > All Programs > Agilent Technologies > 
VWorks > User Guides > Knowledge Base.

http://www.agilent.com/lifesciences/automation
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Opening the help topic for an area in the VWorks window

To access the context-sensitive help feature:

1 In the main window of the VWorks software, click the help button . 

The pointer changes to . Notice that the different icons or areas are 
highlighted as you move the pointer over them.

2 Click an icon or area of interest. The relevant topic or document opens. 
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Features in the Knowledge Base window

Item Feature

1 Navigation area. Consists of four tabs:

• Contents. Lists all the books and the table of contents of the 
books.

• Index. Displays the index entries of all of the books.

• Search. Allows you search the Knowledge Base (all products) 
using keywords. You can narrow the search by product.

• Favorites. Contains bookmarks you have created.

2 Navigation buttons. Enable you to navigate through the next or 
previous topics listed in the Contents tab.

3 Content area. Displays the selected online help topic.

4 Toolbar buttons. Enable you to print the topic or send documentation 
feedback by email.
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Related information

For information about... See...

Who should read this guide “About this guide” on page viii

What this guide covers “About this guide” on page viii
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1
BioCel System overview

This chapter contains the following topics:

• “BioCel System description” on page 2

• “System specifications” on page 5

• “Hardware overview” on page 7

• “Device integration options” on page 23

• “Software description” on page 24
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BioCel System description

Description

The BioCel System is a laboratory automation platform that:

• Stores labware (microplates, tipboxes, tube racks, and others) that will be 
processed during a protocol run.

• Moves labware to and from devices for processing. The devices are 
integrated in the BioCel System and controlled by the VWorks software. 
For a list of the devices that you can integrate in the system, see “Device 
integration options” on page 23.

You can use the BioCel System for applications such as compound 
management, PCR sample preparation, cell- based assays, ADME- Tox assays, 
high- throughput screening, and so on.

Three models of the BioCel System are available: BioCel 900 System, BioCel 
1200 System, and BioCel 1800 System. An environmental- control option can be 
added in the two larger systems (the BioCel 1200 and 1800 Systems) to create 
fully contained, contaminant- free environments. See “System specifications” on 
page 5 for more information about each model.

Components

All three BioCel System models consist of the following components: Main 
body (1), computer (2), and VWorks software (not shown). In a system where 
multiple BioCel units are connected, only one computer may be provided.

BioCel 900 System

00279
Element with Keyboard
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BioCel 1200 System

BioCel 1800 System

1

2

1

2
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Before you operate the system

Related information

WARNING  For safe operation, it is imperative that you follow the precautions in the 
BioCel System Safety Guide.

For information about... See...

BioCel System features “Hardware overview” on page 7

BioCel System specifications • “System specifications” on page 5

• BioCel System Site Preparation 
Guide

Device integration options “Device integration options” on page 23

Additional devices “Additional BioCel System Devices” on 
page 241

Software that controls the BioCel 
System

“Software description” on page 24

Safety information BioCel System Safety Guide
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System specifications

Physical specifications and ambient environment requirements

For physical dimensions, required clearance, and ambient environment 
requirements, see the BioCel System Site Preparation Guide.

Environmental-control system

An environmental- control option can be added in the BioCel 1200 and 1800 
Systems to create fully contained, contaminant- free environments. See the 
BioCel Environmental- Control System User Guide for contained- system 
requirements.

Electrical requirements

Compressed air requirements

The 3- Axis Robot, KiNEDx Robot, and some integrated devices require the use 
of compressed air.

Requirement US US/EU/Asia

Voltage 120 V~ single phase 230 V~ 3 wire, 2 pole

Frequency 60 Hz 50/60 Hz

Current 30 A 20 A

Fuses 30 A 20 A

Electrical plug L5- 30 L6- 20

CAUTION Using oil compressors can cause oil to leak into the system and integrated 
devices and void your warranty.

Requirement Value

Quality Clean, dry (oil content at 0.01 ppm), compressed

Source One of the following:

• Centralized source (house)

• Compressed- air cylinders

• Portable pumps

Pressure 0.69 MPa (100 psig)

Flow rate 280 Lpm (10 cfm) Minimum

Connection 3/8 in OD poly line
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Related information

For information about... See...

BioCel System description “BioCel System description” on page 2

Detailed system requirements BioCel System Site Preparation Guide

Hardware features “Hardware overview” on page 7

Devices that can be integrated in 
the system

“Device integration options” on page 23

Additional BioCel System devices “Additional BioCel System Devices” on 
page 241

Safety information BioCel System Safety Guide
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Hardware overview

About this topic

This topic describes the following BioCel System hardware features:

• Power panel

• Environmental Controls panel (in some BioCel 1200 and 1800 Systems)

• Docking tables (optional)

• Safety windows (in BioCel 1200 and 1800 Systems, on docking tables)

• Light Curtains (in some BioCel 900 Systems)

• Air regulation panel

• Power connection

• Robot

• Controlling computer

• Communication hubs

• Status lights (in BioCel 1200 and 1800 Systems)

• Bar code power supply (optional)

• Weigh Pad hub (optional)

• Pump Modules (optional)

• Trash door and chute (optional)

• Direct plumbing (optional)

• UPS (optional in BioCel 900 Systems)

Power panel

The power panel consists of switches for power, air, and safety interlocks. The 
power panel is located on the lower half of the BioCel System (1).

1
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The following diagram shows the power panel in detail. 

Item Feature Description

1 Air switch Turns on and off the air to the system. For 
instructions, see “Startup procedure” on 
page 32.

2 Reset button Resets the emergency stop relay to allow 
electrical current to flow to the system.

Press the Reset button during startup or for 
emergency stop recovery. For details, see 
“Starting up and shutting down the BioCel 
System” on page 32 and “Recovering from an 
emergency stop” on page 175.

3 Interlock key switch Turns on and off the safety interlock.

WARNING Do not turn off the safety interlock 
under normal operating conditions.

Designed to protect you from moving- part 
hazards while the system is in operation, the 
safety interlock circuit must be closed for 
the system to operate. If you open an 
enclosure window, the safety interlock stops 
the motion of the system robot and devices.

Only an administrator who is trained in the 
safe operation of the system should be 
permitted to bypass the safety interlock. For 
detailed instructions, see “Starting up and 
shutting down the BioCel System” on 
page 32.

BioCel 1200
Control Panel
00243c

INTERLOCK RESET AIR
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EMERGENCY
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Environmental Controls panel

The Environmental Controls panel consists of switches for power and optional 
inert gas, and is located next to the power panel. Installed in some BioCel 
1200 and 1800 Systems, the panel is a part of the BioCel Environmental-
Control System. For information, see the BioCel Environmental- Control 
System User Guide.

Docking tables (optional)

If you have applications that require periodic or frequent addition or removal 
of a device in the BioCel System, you can mount the device on a docking table. 
The docking table sits on wheels so that you can easily move it. 

The table must be docked adjacent to the BioCel System to prevent movement 
during a protocol run. When you no longer need the device, you can undock 
and move the table.

For instructions on how to dock or undock a table, see “Adding or removing 
devices mounted on docking tables” on page 155.

4 Emergency Stop button Cuts power and air to the robot motor and 
integrated devices. The Emergency Stop 
button is connected to the safety interlock 
circuit that must be closed for the system to 
operate. Pressing the Emergency Stop button 
breaks the safety circuit and disables the 
robot motors and integrated devices.

For more information about stopping the 
system in an emergency, see the BioCel 
System Safety Guide

5 Power panel door lock Locks or unlocks the power panel. The 
system fuses are located inside the power 
panel.

WARNING Do not defeat the lock and open the 
door. Only Agilent Technologies personnel should 
unlock and open the door.

6 Hood Lights switch Turns on the lights in the hood. The switch 
is only used in systems with hood lights.

7 Main Power switch Turns on and off the BioCel System. For 
detailed instructions, see “Starting up and 
shutting down the BioCel System” on 
page 32.

8 Robot switch Turns on and off the system robot. For 
detailed instructions, see “Starting up and 
shutting down the BioCel System” on 
page 32.

Item Feature Description

http://www.chem.agilent.com/Library/usermanuals/Public/G5500-90003_BioCelECUG_EN.pdf
http://www.chem.agilent.com/Library/usermanuals/Public/G5500-90003_BioCelECUG_EN.pdf
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Safety windows

Sliding windows or enclosure overhead windows
Depending on the configuration, either sliding windows or enclosure overhead 
windows are installed in the BioCel 1200 or 1800 System. Because enclosure 
overhead doors are designed to be air- tight, they are installed in systems that 
require environmental control.

The sliding windows and enclosure overhead windows are part of the safety 
interlock circuit that must be closed for the BioCel 1200 or 1800 System to 
operate. Designed to protect you from moving- part hazards while the system is 
in operation, opening a window during a run will break the safety circuit and 
instantly stop the motion of the BioCel System and device robots.

IMPORTANT You cannot open windows of inert environment systems until 
the gas is purged.

For detailed safety information, see the BioCel System Safety Guide.

Removable windows on docking tables
Some docking tables have protective windows that are connected to the safety 
interlock circuit and function like enclosure windows. Designed to protect you 
from moving- part hazards while the system is in operation, removing a window 
during a run will break the safety circuit and instantly stop the motion of the 
BioCel System and device robots.

Instead of connecting to the safety interlock circuit, some protective windows 
have locks to prevent operators from entering the system while the system is 
in motion. The protective window should be locked during system operation.

For detailed safety information, see the BioCel System Safety Guide.

Light Curtains

Light Curtains are part of the safety interlock circuit that must be closed for 
the BioCel 900 System to operate. Designed to protect you from moving- part 
hazards while the system is in operation, the Light Curtains detect 
interruptions in the light beams from the posts, break the safety circuit, and 
pause the protocol run.

A Light Curtain post is located at each corner of the BioCel 900 System (1).
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For detailed safety information, see the BioCel System Safety Guide.

Air regulation panel

The air regulation panel (1) contains air supply connections, regulators, and 
filter. The panel is located behind the power panel, above the power 
connections (2). To access the panel, open the cabinet door nearest the power 
panel.

Note: Depending on the options you installed, the air regulation panel might 
look differently than shown in the diagrams.
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The following diagram shows the components that control the system air 
supply in detail.
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Item Feature Description

1 Robot gripper air 
pressure regulator

Controls how firmly the robot grips a 
microplate. This feature is available only in 
systems that have the 3- Axis Robot or 
KiNEDx Robot.

2 Delidder air pressure 
regulator (optional)

Controls the air pressure to the vacuum-
based lid remover.

3 System air pressure 
regulator

Controls the air pressure to the entire 
BioCel System. This component is only 
available in systems that have the 3- Axis 
Robot, KiNEDx Robot, or devices that 
require air supply.

4 Air filter Filters the air supply to the system and 
traps oil or liquid in the supply line.

This feature is only used in systems that 
have the 3- Axis Robot, KiNEDx Robot, or 
devices that require air supply.

5 Air supply shutoff 
valve

Turns on or off the air supply to the 
system. This feature is only available in 
systems that have the 3- Axis Robot, KiNEDx 
Robot, or devices that require air supply.

Use the valve to turn off the air supply only 
if the Air switch on the power panel is not 
working, or if the air is leaking in the 
system.

Note: A loud noise can be heard when you 
shut off the valve and residual air is 
released.

6 Air valve actuator Turns on or shuts off the air supply to the 
system. The actuator is controlled by the Air 
switch on the power panel. Pressing the 
Emergency Stop button on the power panel 
turns off the actuator, which turns off the 
air supply.

This feature is only used in systems that 
have the 3- Axis Robot, KiNEDx Robot, or 
devices that require air supply.
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Power connection

The power connections (2) are located behind the power panel, below the air 
regulation panel (1). To access the connections, open the cabinet door nearest 
the power panel.

The following diagram shows the power connections. The power source 
connects to the BioCel System as shown (1).

External utilities connections
Depending on the configuration, the connections to external utilities enter the 
system through either the main frame posts or at the top of the system. If the 
system has direct plumbing instead of using reservoirs and waste containers, 
the water lines might enter through the frame corners.
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Robot

The BioCel System uses one of the following robots:

• Direct Drive Robot

• 3- Axis Robot

• KiNEDx Robot

• Staubli Robot

Direct Drive Robot
The Direct Drive Robot is available in all three models of the BioCel System. It 
has four axes of motion and is able to grip labware in both the landscape and 
portrait orientations.

Figure Direct Drive Robot axes of movements (top view and side view)

3-Axis Robot
The 3- Axis Robot is available in the BioCel 1200 and BioCel 1800 Systems, and 
is an option in the BioCel 900 System. It is able to move along three axes: r, z, 
and theta (or t).

Note: All movements are measured from the robot home position.

1

2

3

4

Item Axis Description of robot movement

1 Waist Robot arm rotates infinitely about the waist.

2 Elbow Robot forearm rotates infinitely about the elbow.

3 Wrist Robot hand rotates infinitely about the wrist.

4 Mast Robot arm moves up and down along the mast.
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Figure The 3-Axis Robot axes of movement (top view and side view).

KiNEDx Robot
The KiNEDx Robot is in most BioCel 900 Systems and is able to move along 
four axes: x, y, z, and theta (or t).

Notes:

• The origin of the x-  and y- axes is at the center of the robot base.

• The grippers rotate about the wrist joint along the theta- axis (or t- axis).

• All movements are measured from the robot home position.

Figure The KiNEDx Robot axes of motion (top view and side view).

Staubli Robot
For information about the Staubli Robot, see the Staubli TX60 Device Driver 
User Guide.
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http://www.chem.agilent.com/Library/usermanuals/Public/G5415-90049_DDUG_EN.pdf
http://www.chem.agilent.com/Library/usermanuals/Public/G5415-90049_DDUG_EN.pdf
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Controlling computer

The supplied computer:

• Runs the VWorks software and controls the BioCel System and integrated 
devices.

• Receives barcode- labeling instructions.

• Stores data collected by microplate readers.

Note: Some microplate readers have their own computer for storing data.

• Stores log files.

• Communicates with other computers on your organization’s network for file 
exchanges and email access.

The computer is located inside the BioCel System cabinet. To access the 
computer, open the cabinet door nearest the power panel.

Network cards
The supplied computer has two Ethernet ports. One of the Ethernet ports 
connects to the Ethernet switch, the second Ethernet port connects to your 
organization’s wide area network (WAN).

For information about the network requirements and setup, see the VWorks 
Automation Control Setup Guide.

Computer monitor
A computer monitor is supplied with the BioCel System and it is mounted on 
one of the corners. If your BioCel System has a device that includes its own 
computer, you can connect that computer to the supplied BioCel System 
computer monitor. You can switch the monitor display between the two 
computers.

0
0

2
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Communication hubs

The communication hubs are located inside the BioCel System cabinet. To 
access the hubs, open the cabinet door nearest the power panel.

                                                        

Item Hub Description

1 Ethernet switch Connects the controlling computer to the serial 
hub, the Bio I/O console, various devices in the 
system that use Ethernet communication. The 
switch can also be used to connect the 
controlling computer to the local area (system) 
network.

Note: To connect the controlling computer to a 
wide area network, use the built- in network card 
in the controlling computer.

2 Serial hub Connects the controlling computer (through the 
Ethernet switch) to the various devices in the 
system that use serial communication.

3 BioCel I/O 
Interface console

Transmits signals from various sensors to the 
computer. In response to the signals, the 
computer turns on or off status lights, and opens 
or closes optional doors. The console also 
provides 24 V power to some devices such as the 
Lid Hotel Station and Vacuum Delid Station.
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Status lights

Status lights enable you to monitor the current status of the BioCel System 
from a distance. The signals monitored depends on the configuration in the 
BioCel I/O Interface.

Two types of status lights are available:

• Stack lights. Multi- color status lights are available for the BioCel 1800 
System and are optional for the BioCel 1200 System.

• Blue lights. Blue status lights are available on the frames of the BioCel 
1800 System.

Note: You can monitor the status of a BioCel 900 System in the VWorks 
software.

Stack lights
A single red, yellow, and green light fixture is located above one of the frame 
posts in the BioCel 1200 System and BioCel 1800 System. Different light 
patterns indicate different conditions.

For information about the safety interlock, see “Power panel” on page 7.

Light pattern Status

 
Red = Off

Yellow = Off

Green = On

System is idle or running in error- free 
mode.

The interlock is on.

 
Red = Off

Yellow = Flashing

Green = On

System is idle or running in error- free 
mode.

Interlock is off.

 
Red = Flashing

Yellow = Flashing

Green = Off

System has encountered a run error, the 
operator clicked the Pause button in the 
software, or one of the system doors is 
open.

Interlock is off.

 
Red = Flashing

Yellow = Off

Green = Off

System has encountered a run error, the 
operator clicked the Pause button in the 
software, or one of the system doors is 
open.

Interlock is on.

 
Red = Off

Yellow = Off

Green = Off

VWorks software is not running. 

If the software is running, the BioCel I/O 
Interface is not initialized or is 
disconnected.
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Blue status lights
A blue status light is located on each BioCel 1800 System frame post. Different 
light patterns indicate different system conditions.

Bar code power supply (optional)

The barcode power supply is an optional component that supplies power to 
auxiliary barcode readers integrated in the system. The barcode power supply 
is located under the BioCel System table. Depending on the system 
configuration, the barcode power supply is sometimes mounted on the rack 
that holds the communication hubs.

Weigh Pad hub (optional)

The Weigh Pad hub is a central electrical and communication connection point 
for one or more Weigh Pads and the controlling computer. The Weigh Pad hub 
is located under the BioCel System table. Depending on the system 
configuration, the Weigh Pad hub is sometimes mounted on the rack that holds 
the communication hubs.

                                                        

Light pattern Status

All on solid Run progressing normally

All off Not currently running

All blinking simultaneously Run error

One light on each post blinking twice, 
followed by the other light on each 
post blinking twice

Run progressing normally but with 
interlock bypass in use

All blinking in circular pattern Run complete
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Pump Modules (optional)

The Pump Module is a device that transfers fluids into and waste away from 
the Vertical Pipetting Station and Bravo accessories. The Pump Module 
contains two peristaltic pumps that are controlled using the VWorks software.

The Pump Modules are mounted under the BioCel System table. To access the 
Pump Modules, open the cabinet door. 

Trash door and chute (optional)

The trash door is located immediately below the BioCel System table surface. 
The door slides open to allow used pipette tips or labware to fall into the 
waste bin under the table.

Direct plumbing (optional)

Instead of using reservoirs and waste containers, the BioCel System can have 
direct plumbing from an external water source. Depending on the system 
configuration, the plumbing lines can enter the system at different locations. 

UPS

The UPS is included in the BioCel 1200 System and the BioCel 1800 System, 
but is an optional component in the BioCel 900 System. It is located inside the 
BioCel System cabinet. To access the UPS, open the cabinet door nearest the 
power panel.

The UPS:

• Is a backup power source for the BioCel System.

• Provides up to 15 minutes of power to the system during a power outage.

Note: Depending on the system configuration, the UPS might allow the system 
to run longer than 15 minutes during a power outage.
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Related information

For information about... See...

BioCel System description “BioCel System description” on page 2

Additional BioCel System devices “Additional BioCel System Devices” on 
page 241

BioCel System software “Software description” on page 24

BioCel System specifications “System specifications” on page 5

Safety information BioCel System Safety Guide
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Device integration options

About devices

Devices are individual pieces of equipment that are integrated in the BioCel 
System. Devices can store or process labware.

Agilent Technologies devices

Agilent Technologies devices that can be integrated in a BioCel System include:

• Bravo Automated Liquid Handling Platform

• PlateLoc Thermal Microplate Sealer

• Labware Stacker

• Microplate Centrifuge

• Microplate Seal Piercer

• Microplate Labeler

• Vertical Pipetting Station

For details on how to set up these devices, see the user guide for the device.

Additional devices can be integrated in the BioCel System. For the list of 
additional devices, see “Additional BioCel System Devices” on page 241.

Third-party devices

Many third- party devices can be integrated in a BioCel System. For a 
comprehensive list, contact Automation Solutions Customer Service.

If you would like to add other devices to the BioCel System, contact 
Automation Solutions Customer Service.

Related information

For information about... See...

BioCel System description “BioCel System description” on page 2

BioCel System hardware features “Hardware overview” on page 7

Additional BioCel System devices “Additional BioCel System Devices” on 
page 241

BioCel System software “Software description” on page 24

BioCel System specifications “System specifications” on page 5

Safety information BioCel System Safety Guide
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Software description

About this topic

You use the VWorks software and device diagnostics software to set up, run, 
and troubleshoot the BioCel System. This topic describes the VWorks software 
and robot diagnostics software. For information about the diagnostics software 
of an integrated device, see the device user guide.

VWorks software

The VWorks software allows you to:

• Set up the BioCel System. During setup, you need to create a device file 
for the BioCel System robot and integrated devices. For setup information, 
see “Setup Workflow” on page 28.

• Set up user accounts and privileges. You can set up different user 
accounts to enforce access policies. For instructions, see the VWorks 
Automation Control Setup Guide.

• Define labware. Labware definitions describe the labware you will use 
during protocol runs. For instructions, see the VWorks Automation Control 
Setup Guide.

• Create protocols. Protocols determine the sequence of tasks you want to 
automate in a run. For example, you can use a protocol to apply barcode 
labels to 100 microplates. For protocol- writing instructions, see the VWorks 
Automation Control User Guide.

• Run, pause, monitor, and stop protocols. You can start, pause, monitor, 
and stop a protocol run from the controlling computer.

For a full description and instructions on how to use the VWorks software, see 
the VWorks Automation Control User Guide.
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Robot diagnostics software

Accessed through the VWorks software, the robot diagnostics software allows 
you to:

• Create and manage profiles. Robot profile allows you to set up 
communication between the robot and the controlling computer. You create 
the profile when you set up the system. For setup information, see “Setup 
Workflow” on page 28.

• Set and edit teachpoints. Teachpoints are locations that the BioCel System 
robot will go to and from during a protocol run. You set teachpoints when 
you set up the BioCel System. You can also edit the teachpoints to correct 
or fine- tune the original teachpoints. For teachpoint setup and editing 
information, see “Setup Workflow” on page 28.

• Diagnose problems. Moving and adjusting individual hardware components 
allow you to diagnose and troubleshoot problems. For information on 
diagnosing and troubleshooting problems, see “Using diagnostic tools” on 
page 205.

The diagnostics software you use depends on the robot installed in the system. 

• If the BioCel System has the Direct Drive Robot, see the instructions for 
“DDR Diagnostics” on page 206.

• If the BioCel System has the 3- Axis Robot, see the instructions for “3- Axis 
Robot Diagnostics” on page 229.

• If the BioCel System has the KiNEDx Robot, see the instructions for 
“KiNEDx Robot Driver Diagnostics” on page 237.

Related information

For information about... See...

VWorks software instructions VWorks Automation Control User 
Guide

BioCel System description “BioCel System description” on page 2

BioCel System specifications “System specifications” on page 5

BioCel System hardware features “Hardware overview” on page 7

Additional BioCel System devices “Additional BioCel System Devices” on 
page 241

Devices that can be integrated in 
the system

“Device integration options” on page 23

Safety information BioCel System Safety Guide
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Setting up the BioCel System

This chapter explains how to set up the BioCel System for 
operation. This chapter contains the following topics:

• “Setup Workflow” on page 28

• “Adjusting the keyboard shelf and computer monitor” on 
page 30

• “Starting up and shutting down the BioCel System” on page 32

• “Adding and deleting devices in the software” on page 39
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Setup Workflow

About this topic

This topic presents the workflow for setting up the BioCel System for 
operation.

Workflow

The following table presents the steps for setting up the BioCel System. After 
setting up the BioCel System for the first time, you will not likely change any 
of the settings in the procedure unless you add a device, replace a device, or 
move the BioCel System.

IMPORTANT Before proceeding to step 5 (setting teachpoints), you should 
already have definitions for the labware you want to use. Although you can 
define labware at any time, Agilent Technologies recommends that you define 
labware before setting up the BioCel System. For instructions on how to define 
labware, see the VWorks Automation Control Setup Guide.

Step For this task... See...

1 Adjust the keyboard shelf. “Adjusting the keyboard shelf and 
computer monitor” on page 30

2 Start up the BioCel System. “Starting up and shutting down the 
BioCel System” on page 32

3 Create a device file and add 
devices in the software.

“Adding and deleting devices in the 
software” on page 39 or device 
user guide

4 Create a profile. One of the following:

• “Creating and managing Direct 
Drive Robot profiles” on 
page 47

• “Creating and managing 3- Axis 
Robot profiles” on page 113

• “Creating and managing 
KiNEDx Robot profiles” on 
page 131

• Device user guide

• Third- party device driver user 
guide
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Related information

5 Set and edit teachpoints for 
integrated devices.

One of the following:

• “Setting Direct Drive Robot 
teachpoints” on page 69

• “Setting 3- Axis Robot 
teachpoints” on page 117

• “Setting KiNEDx Robot 
teachpoints” on page 135

• Device user guide

• Third- party device driver user 
guide

6 Write protocols. VWorks Automation Control User 
Guide

Step For this task... See...

For information about... See...

Operating the BioCel System “Checking for system readiness” on 
page 166

Troubleshooting problems “Maintenance and troubleshooting” on 
page 173
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Adjusting the keyboard shelf and computer monitor

About this topic

This topic explains how to change the height of the computer keyboard shelf, 
change the tilt angle of the computer monitor, and switch monitor display 
between two computers.

Adjusting the shelf height

To adjust the keyboard shelf height:

1 Swivel the keyboard shelf toward the front (power- panel side) of the 
BioCel System.

2 Using the supplied hex wrench (attached to the back of the keyboard shelf 
frame), loosen the screw on the height- adjusting ring.

3 Move the keyboard shelf to the desired height.

4 Tighten the screw on the height- adjusting ring to set the height.
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Adjusting monitor tilt angle

To adjust the computer monitor tilt angle:

1 Turn the black knob on the back of the computer monitor.

2 Tilt the computer monitor to the desired angle.

3 Tighten the knob on the back of the computer monitor.

Switching monitor display between two computers

If your BioCel System has a device that includes its own computer, you can 
connect that computer to the supplied BioCel System computer monitor. You 
can switch the monitor display between the two computers. To switch monitor 
display between the two computers, rapidly press the SCROLL LOCK key on 
the keyboard twice.

Related information

For information about... See...

BioCel System computer “Controlling computer” on page 17

Setup workflow “Setup Workflow” on page 28

Safety information BioCel System Safety Guide
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Starting up and shutting down the BioCel System

About this topic

This topic explains how to start up and shutdown the BioCel System.

Startup procedure

When you start up the system you need to:

1 Turn on the power and the robot.

2 Turn on the computer and devices.

3 Turn on the interlock, air, and optional gases and devices.

Before you turn on the system:

1 Make sure the main power line, air line, vacuum line (optional) and 
Ethernet cable (optional) are connected.

2 Make sure external drains and water lines are attached if your BioCel 
System uses them. Make sure the hoses are not kinked and that the hoses 
go through the appropriate pumps.

3 Make sure that any autofilling reservoirs are connected.

To turn on the power and robot:

1 Turn on the power. To do this, on the power panel, turn the MAIN POWER 
switch clockwise to the ON position.

Note: The indicator light above the Main Power switch does not turn on 
when you turn on the power.
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2 If you have one or more UPS units, slide open the cabinet door nearest the 
power panel, and then turn on the UPS units. For instructions, see the 
UPS manufacturer’s user documentation.

When you turn on the UPS, the indicator light above the Main Power 
switch turns on.

3 Turn on the robot. To do this, on the power panel, turn the ROBOT switch 
counterclockwise to the on position. The indicator lights above the Main 
Power and Robot switches turn on.

To turn on the computer and devices:

1 Make sure the Ethernet and RS- 232 hub power indicator lights are on. To 
do this, open the cabinet door opposite the power panel. The hubs are 
mounted on the rack just inside the doorway.

2 Turn on all integrated devices.

3 Turn on the computer monitor.

4 Turn on the controlling computer. See the computer manufacturer’s user 
documentation for instructions.

5 Log in to the Microsoft Windows operating system.

6 Close the cabinet doors.

7 Make sure that the EMERGENCY STOP button on the power panel and the 
emergency stop buttons on the tabletop are pulled out (restored position).
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8 Press the green RESET button on the power panel. If pressing the green 
RESET button does not turn on power at all the devices, check that the 
emergency stop buttons are pulled out (restored position).

9 If there is a secondary computer for a third- party device, log in to the 
Windows operating system on that computer.

To turn on the interlock, air, and optional gases and devices:

1 Turn on the safety interlock. To do this, on the power panel, turn the 
INTERLOCK key counterclockwise. The INTERLOCK indicator light turns on.

If you have a BioCel 900 System, and the system does not have light 
curtains, you can skip this step.
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2 Turn on the air supply to the system. To do this, on the power panel, turn 
the AIR switch counterclockwise. The AIR indicator light turns on.

If the air does not come on, make sure the emergency stops buttons are 
pulled out (restored). Also, make sure the safety interlock is turned on 
(except if your BioCel 900 System does not have light curtains).

3 If you use devices that require a vacuum created by a vacuum pump:

a Check that the gauge on the vacuum pump indicates a vacuum 
pressure.

b Make sure that the vacuum system is connected correctly.

4 If you use devices that require a gas supply, make sure that the gas is 
turned on.

5 If the BioCel System has an incubator, turn on the incubator.

6 On the power panel, make sure that the indicator lights for RESET, AIR, 
ROBOT, and MAIN POWER are on. The INTERLOCK indicator light should 
also be on, except if your BioCel 900 System does not have light curtains.

If you have not previously selected the option to sense the air pressure 
automatically, check that the operating air pressures meet the 
requirements. See “System specifications” on page 5.

To start the VWorks software:

See the VWorks Automation Control User Guide.
                                                        

BioCel 1200
Control Panel
00243c

INTERLOCK RESET AIR

00

MAIN POWER

EMERGENCY

STOP

00
24

3c

00

WARNING

ROBOT HOOD LIGHTS
ON

O
FF



2   Setting up the BioCel System
Starting up and shutting down the BioCel System

36 BioCel System User Guide

Shutting down procedure

Shut down the BioCel System if you intend to:

• Leave it unused for a long period of time.

• Service the system.

• Move it to another location.

To shut down the BioCel System:

1 Make sure you have cleaned up after the last run. See “Cleaning up after 
every protocol run” on page 174 for cleanup instructions.

2 Exit the VWorks software. See the VWorks Automation Control User Guide 
for instructions.

3 If you have a secondary computer:

a Exit any software running. 

b Shut down the secondary computer (through Windows).

Wait for the operating system to shut down.

4 Shut down the main computer through Windows. Wait for Windows to exit.

5 Turn off the computer monitor.

6 If you use devices that require a vacuum pump, optionally turn off power 
at the pump if the pump has a power switch.

7 Turn off the air. To do this, on the power panel, turn the AIR switch 
clockwise. The AIR indicator light turns off. When the air is turned off, the 
3- Axis Robot and KiNEDx Robot grippers close.
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8 Turn off the robot. To do this, on the power panel, turn the ROBOT switch 
clockwise to the off position.

9 Turn off the power on the power panel. To do this, on the power panel, 
turn the Main Power switch counterclockwise to the OFF position.

10 If you have one or more UPS units, open the cabinet door nearest the 
power panel, and then turn off the UPS units. For instructions, see the 
UPS manufacturer’s user documentation.

11 If your are moving the BioCel System, disconnect the air, vacuum, other 
gases, Ethernet cables, and main power cables.
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Related information

For information about... See...

Electrical requirements “System specifications” on page 5

Cleaning up after a protocol run “Routine maintenance” on page 174

Troubleshooting startup or 
shutdown problems

“Troubleshooting error messages” on 
page 189
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Adding and deleting devices in the software

About this topic

The supplied BioCel System computer is set up with the correct device 
configuration to communicate with the BioCel System and integrated devices. 
You do not need to create a new device file unless you want to reference 
different profiles or use a different teachpoint file. You need to update the 
device file if you add or remove devices in the BioCel System.

This topic explains how to add and delete the devices in the VWorks software. 
Read this topic if you are an administrator responsible for setting up and 
managing the BioCel System.

Devices and device file defined

A device is an item in your lab automation system that has an entry in the 
VWorks software device file. A device can be a robot, an instrument, or a 
location in the system that can hold a piece of labware. The following are some 
examples of devices:

• The robot in the BioCel System

• PlateLoc Thermal Microplate Sealer

• Microplate Labeler

• Vertical Pipetting Station shelf

• Platepad

• A third- party device integrated in the BioCel System

To communicate with and to control the robot and integrated devices, the 
VWorks software uses a device file that contains the following information:

• List of devices the software will communicate with and control

• Device type of each device (for example, the robot in the BioCel System, 
PlateLoc Thermal Microplate Sealer, and any integrated device)

• Configuration information of each device (for example, approach height, 
allowed or prohibited labware, barcode access, and so on)

• Profile to use

You provide the device information in the VWorks software. The device 
information is stored in a device (.dev) file that is located in a folder you 
specify when saving the file.

For detailed information about device files and associations with profiles, 
teachpoint files, and labware definitions, see the VWorks Automation Control 
User Guide.

Creating a device file

If you are setting up the BioCel System for the first time, you need to create a 
new device file, and then add the BioCel System robot and integrated devices 
to this file.

Before you create a device file, start the VWorks software and log in. See the 
VWorks Automation Control User Guide for instructions.
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To create a new device file:

1 In the VWorks window, select File > New > Device. A Device File tab appears.

2 Select File > Save to save the device file. The file name appears in the 
Device File tab.

Adding a device 

To add a device to the device file:

1 In the Available Devices area, double- click the device that you want to add. 
Alternatively, you can drag a device from the Available Devices area into the 
Device File area.
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In the example shown, the Direct Drive Robot device is added. Notice that 
the first Direct Drive Robot device is labeled Direct Drive Robot- 1. If you 
add another Direct Drive Robot device, it will appear as Direct Drive 
Robot- 2.

If you do not see the device in the Available Devices list, check that the 
device plugin file is stored in the ...\Agilent Technologies\VWorks\Plugins 
folder.

If you added a device plugin file in the Plugins folder and you have already 
started the VWorks software, be sure to reload the plugin. To do this, close 
any open device files and protocol files, and then select Tools > Reload 
Plugins.

2 In the device properties area, type a Name for the device.

In the following example, the name for the Direct Drive Robot is BioCel DD 
Robot.

3 If applicable, select the Profile.

If the profile you want does not appear in the list, or if no profile appears 
in the list, you need to create the profile, and then return to this step to 
select it. Without the profile, you will not be able to establish 
communication with the device.

To create a profile for the BioCel System robot, see one of the following:

• “Creating and managing Direct Drive Robot profiles” on page 47

• “Creating and managing 3- Axis Robot profiles” on page 113

• “Creating and managing KiNEDx Robot profiles” on page 131

• Staubli TX60 Device Driver User Guide

To create a profile for an integrated device, see “Additional BioCel System 
Devices” on page 241, the device user guide, or the third- party device 
driver user guide.

4 If applicable, set the device properties. See “Additional BioCel System 
Devices” on page 241, the device user guide, or the third- party device 
driver user guide.

5 Select File > Save to save the device file.

http://www.chem.agilent.com/Library/usermanuals/Public/G5415-90049_DDUG_EN.pdf
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6 Repeat steps 1 through 5 to add other devices.

7 In the Device File area, click Initialize all devices to establish communication 
with the devices.

Deleting a device

To delete a device in the VWorks software:

1 In the VWorks window, select the device you want to delete in the Devices 
area.

2 Click Delete selected devices.

Related information

For information about... See...

VWorks software • VWorks Automation Control Setup 
Guide

• VWorks Automation Control User 
Guide

Setting the properties of a 
particular device

One of the following:

• “Additional BioCel System Devices” 
on page 241

• Device user guide

• Third- party device driver guide
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Creating profiles of a robot or 
device

One of the following:

• “Creating and managing Direct 
Drive Robot profiles” on page 47

• “Creating and managing 3- Axis 
Robot profiles” on page 113

• “Creating and managing KiNEDx 
Robot profiles” on page 131

• Staubli TX60 Device Driver User 
Guide

• “Additional BioCel System Devices” 
on page 241

• Device user guide

• Third- party device driver user guide

Setting teachpoints One of the following:

• “Setting Direct Drive Robot 
teachpoints” on page 69

• “Setting 3- Axis Robot teachpoints” 
on page 117

• “Setting KiNEDx Robot teachpoints” 
on page 135

• Staubli TX60 Device Driver User 
Guide

• “Additional BioCel System Devices” 
on page 241

• Device user guide

• Third- party device driver user guide

For information about... See...

http://www.chem.agilent.com/Library/usermanuals/Public/G5415-90049_DDUG_EN.pdf
http://www.chem.agilent.com/Library/usermanuals/Public/G5415-90049_DDUG_EN.pdf
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Setting up the Direct Drive Robot

This chapter explains how to set up the Direct Drive Robot for 
operation. This chapter contains the following topics:

• “Setup Workflow” on page 46

• “Creating and managing Direct Drive Robot profiles” on page 47

• “Specifying the table dimensions and robot position” on 
page 53

• “Planning Direct Drive Robot teachpoints” on page 60

• “Setting Direct Drive Robot teachpoints” on page 69

• “Setting teachpoints using a labware” on page 88

• “Verifying Direct Drive Robot teachpoints” on page 90

• “Editing existing Direct Drive Robot teachpoints” on page 102

• “Managing Direct Drive Robot teachpoints” on page 106

• “Cycling teachpoints” on page 107

Note: If the BioCel System has a 3- Axis Robot, see “Setting up the 
3- Axis Robot” on page 111. If the BioCel System has a KiNEDx 
Robot, see “Setting up the KiNEDx Robot” on page 129. If the 
BioCel System has a Staubli robot, see the Staubli TX60 Device 
Driver User Guide.

http://www.chem.agilent.com/Library/usermanuals/Public/G5415-90049_DDUG_EN.pdf
http://www.chem.agilent.com/Library/usermanuals/Public/G5415-90049_DDUG_EN.pdf
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Setup Workflow 

About this topic

This topic presents the workflow for setting up the Direct Drive Robot for 
operation.

Workflow

The following table presents the steps for setting up the Direct Drive Robot. 
After setting up the Direct Drive Robot for the first time, you will not likely 
change any of the settings in the procedure unless you add, replace, move, or 
remove a device in the system.

IMPORTANT Before proceeding to step 5 (verify the teachpoints), you should 
already have definitions for the labware you want to use. Although you can 
define labware at any time, Agilent Technologies recommends that you define 
labware before setting up the Direct Drive Robot. For instructions on how to 
define labware, see the VWorks Automation Control Setup Guide.

                                                        

Step For this task... See...

1 Add the robot to the device 
file.

“Adding and deleting devices in the 
software” on page 39

2 Create a profile for the Direct 
Drive Robot.

“Creating and managing Direct 
Drive Robot profiles” on page 47

3 Specify the table dimensions 
and the robot position.

“Specifying the table dimensions 
and robot position” on page 53

4 Plan the teachpoints. “Planning Direct Drive Robot 
teachpoints” on page 60

5 Set teachpoints for integrated 
devices.

“Setting Direct Drive Robot 
teachpoints” on page 69

6 Verify the teachpoints. “Verifying Direct Drive Robot 
teachpoints” on page 90

7 Edit the teachpoints. • “Editing existing Direct Drive 
Robot teachpoints” on page 102

• “Managing Direct Drive Robot 
teachpoints” on page 106

8 Cycle the teachpoints. “Cycling teachpoints” on page 107

9 Perform dry runs. “Performing dry runs” on page 153
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Creating and managing Direct Drive Robot profiles 

About this topic

The BioCel System computer is set up with the correct profiles to 
communicate with the Direct Drive Robot and integrated devices. You do not 
need to create new profiles unless you want to set up unique communication 
settings or use a different teachpoint file. When you integrate a new device in 
the BioCel System, you will need to create a new profile for that device. 

This topic explains how to create a new profile for the Direct Drive Robot and 
how to manage existing profiles. For instructions on how to create the profiles 
for Agilent Technologies devices, see the device user documentation. For 
instructions on how to create profiles for third- party devices, see the third-
party device driver user guide.

About profiles

IMPORTANT Each device you integrate in the BioCel System requires a 
unique profile.

A profile is a collection of settings, stored in the Windows registry, that 
manages how you connect to a device. A profile:

• Specifies the port or IP address used to establish communication between 
the device and the controlling computer.

• References a teachpoint file. For a description of teachpoint files, see 
“Setting Direct Drive Robot teachpoints” on page 69.

You use the DDR Diagnostics software to create and manage profiles.

Note: The profile is referenced by a device file. For information about device 
files, see “Adding and deleting devices in the software” on page 39. For a 
detailed description of the relationships between the device file, profile, and 
teachpoint file, see the VWorks Automation Control User Guide.

If you have more than one Direct Drive Robot in the system

Every device in the system must have a unique IP address for proper 
operation. All Direct Drive Robots are assigned the same IP address at the 
factory. Therefore, if you have more than one Direct Drive Robot installed in 
the system, you must make sure each is assigned a unique IP address. You can 
do this when creating a profile for the robot.
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Creating a Direct Drive Robot profile 

To create a Direct Drive Robot profile:

1 In the Devices area, select the Direct Drive Robot name, and then click 
Device diagnostics.

The DDR Diagnostics dialog box opens.

2 If it is not already displayed, click the Profiles tab.

3 In the Profile Management area, click Create a new profile. The Create Profile 
dialog box opens.

4 Type a name, and click OK. The name appears in the Profile Management 
area.

5 In the Robot Identifiers area, click Find Available Direct Drive Robots. The 
Discovered BioNet Devices dialog box opens.
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6 Locate the Direct Drive Robot to which you want to connect:

When you are finished, click OK to return to the DDR Diagnostics dialog 
box. Notice that the Device ID, MAC address, and IP address of the robot 
appear in the Robot Identifiers area.

Step Instruction

1 Select the correct Ethernet card for the device connection. A list 
of devices appear in the dialog box.

2 Select the Direct Drive Robot. You can use the MAC Address to 
identify the robot in the list. To successfully communicate with 
the robot, the device must show New or Matched in the Status 
column.

To correctly identify a robot by its MAC address, you might need 
to turn off all devices and all but one robot in the system.

After you have correctly identified the robot in the list, double-
click the Device ID box and type a name for the robot.

3 If you have more than one Direct Drive Robot in the system, 
make sure each robot has a unique IP address. To do this, turn 
off all but one robot in the system, select the robot in this 
dialog box, click Change IP, and then assign a new IP address. 
The IP address should have the same network and subnet 
address as the controlling computer, and have a unique host 
address. Repeat for each robot in the system.
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7 In the Miscellaneous area, make sure the All regrip stations are safe from above 
check box is not selected. You can return to the profile to select this 
option after you have set all teachpoints. 

For a description of this option, see “Selecting the All regrip stations are 
safe from above option” on page 87.

8 To save the profile using the default teachpoint file name and location that 
the software automatically creates, proceed to step 9. Later you will add 
teachpoints to this teachpoint file.

If you want to use an existing teachpoint file, in the Teachpoint File area, 
click Select. In the Select a Teachpoint File dialog box, locate and select the 
teachpoint file that you want to use, and then click Open. The file path 
appears in the Teachpoint File area.

If you want to change the teachpoint file name or storage location, in the 
Teachpoint File area, click Save as. In the Save As dialog box, type a name 
for the teachpoint file, select the storage location, and then click Save. The 
file path appears in the Teachpoint File area. Later you will add 
teachpoints to this file.

Note: If you want to use an existing teachpoint file and rename it, you 
must select the existing teachpoint file, initialize the profile to load 
information in the existing teachpoint file (step 10), and then click 
Save As in the Teachpoint File area to rename it.

9 Click Update this profile to save the changes.

10 Click Initialize this profile to:

• Establish communication with the robot.

• Load the information in the selected teachpoint file. In the Robot 
Status area, a graphical representation of the robot and teachpoints (if 
any) appear. In addition, the robot coordinates are updated.

 IMPORTANT The system table displayed in the Robot Status area 
should be representative of the actual system table. If the dimensions in 
the image appears to be incorrect (for example, a rectangular table 
appears in the software but the actual system table is square), contact 
Automation Solutions Technical Support.

CAUTION Select this option only if all regrip stations in the system are clear of 
obstacles, such as shelves or other devices, above them.

CAUTION If the teachpoint file was copied from another computer, you must verify 
the teachpoints for the new profile before using it.
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Note: During the initialization process, the teachpoints information in 
the firmware is synchronized with the information in the teachpoints 
file.

11 If you are setting up the BioCel System for the first time or if you are 
creating a new device file, return to “Adding and deleting devices in the 
software” on page 39 and continue from step 3. Otherwise, you can 
proceed to set teachpoints. See “Planning Direct Drive Robot teachpoints” 
on page 60.

Managing existing profiles

In the DDR Diagnostics Profiles tab, you can select an existing profile, and then 
rename, copy, or delete the profile.

CAUTION A copy of an existing profile references the same teachpoint file. 
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Related information

For information about... See...

Adding a device in the VWorks 
software

“Adding and deleting devices in the 
software” on page 39

Setting teachpoints • “Planning Direct Drive Robot 
teachpoints” on page 60

• “Setting Direct Drive Robot 
teachpoints” on page 69
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Specifying the table dimensions and robot position

About this topic

The Direct Drive Robot is already set up correctly in the BioCel System. You 
do not need to re- specify the table dimensions or robot position unless you 
have moved the robot to a different position in the same system, or you have 
moved the robot to a different system.

This topic explains how to specify the table dimensions and the robot position.

About the table dimensions and robot position

When you set up the robot, you must let the software know the following:

• Dimensions of the attachment surface (or table)

• Position of the robot on the table

• Orientation of the robot on the table

This information helps the software to draw an accurate representation of the 
table and display the relative positions of the robot and teachpoints in the 
Robot Status area.

To specify the table dimensions and robot position, you will be:

• “Backing up existing settings” on page 54

• “Measuring the table dimensions” on page 54

• “Determining the angle of the robot” on page 55

• “Entering the information in DDR Diagnostics” on page 57
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Backing up existing settings

Agilent Technologies recommends that you back up existing table dimensions 
and robot position settings before changing them.

To back up existing settings:

1 In the DDR Diagnostics Setup tab, click Save ALL advanced settings to file. 

2 In the Save As dialog box that opens, type a name for the backup file. You 
can use the default backup file location, or select a different location. The 
default location is 
C:\Program Files\Agilent Technologies\Settings\DDR\FirmwareBackup.

3 Click Save. The robot settings are saved in an XML file.

Measuring the table dimensions

Take the measurements that are shown in the following diagram. The crosshair 
symbol in the diagram marks the center of the robot. The W- axis is width of 
the robot- attachment surface. W1 and W2 specify the lengths of the two 
segments of the width. The line that intercepts the end of W1 and the 
beginning of W2 runs through the center of the robot base. The D- axis is the 
depth of the robot- attachment surface. D1 and D2 specify the lengths of the 
two segments of the depth. The line that intercepts the end of D1 and the 
beginning of D2 runs through the center of the robot base.
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Note: The measurements can be approximate and the axis assignment is 
arbitrary. The information is used to draw the graphic in BioCel 900 
Diagnostics and is not used for robot operation.

Determining the angle of the robot

During this procedure, you will determine the angle between the robot 0° 
position relative to the D- axis. The robot is at its 0° position when the mast 
sits directly above the robot cable connection.

The following diagram shows the robot rotated halfway between the 0° position 
and the D- axis. Notice the location of the robot cable connection (the gray 
rectangular block).

To determine the angle of the robot:

1 In DDR Diagnostics, click the Jog/Move tab, and then click Disable Motors. 
You should be able to rotate the robot waist and arm manually without 
resistance.

W1 W2

D1

D2

W1 W2

D1

D2

0°

WARNING  Be sure to wear protective eyewear when entering the system and working 
with the robot.
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2 Turn the robot waist such that the bicep is parallel to the D- axis and the 
mast is in the D2 half of the plane.

                                                        

W1 W2

D1

D2

W1 W2

D1

D2
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3 In DDR Diagnostics, note the Waist angle in the Robot Status area. This is 
the robot angle value you will use.

Entering the information in DDR Diagnostics

To set or update the table dimensions and robot position

1 In DDR Diagnostics, click the Setup tab.
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2 In the Table Dimensions and Robot Position area, type the desired values that 
define the table: W1, W2, D1, and D2.

3 Type the Robot angle value. This is the Waist angle value displayed in the 
Robot Status area.

4 When you are finished, click Apply. The changes are saved to the firmware. 
In addition, the graphic in the Robot Status area updates.
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5 Check the graphic and make sure it is correct. If necessary, repeat the 
procedures in this topic to make any necessary adjustments. For example, 
if the robot appears backwards in the software, you can rotate the D-  and 
W- axes in the Setup tab.

6 After you have verified that the table settings are correct, click Save ALL 
advanced settings to file. The values in the Setup tab are saved to an XML file. 
You can use the XML file to recover the settings if they are lost.

 

Related information

For information about... See...

Adding a device in the VWorks 
software

“Adding and deleting devices in the 
software” on page 39

Setting teachpoints • “Planning Direct Drive Robot 
teachpoints” on page 60

• “Setting Direct Drive Robot 
teachpoints” on page 69
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Planning Direct Drive Robot teachpoints

About this topic

The Direct Drive Robot is able to hold labware in both the landscape and 
portrait orientations. In addition, the A1 well can be away or toward the robot 
grippers in either labware orientation. 

The orientation flexibility permits multiple options at each teachpoint. 
Carefully planned teachpoints can optimize results and throughput. This topic 
presents the following:

• “Direct Drive Robot teachpoints” on page 60

• “Guidelines for setting teachpoints” on page 63

• “Examples” on page 64

Direct Drive Robot teachpoints

A Direct Drive Robot teachpoint consists of the following:

• Orientation coordinates

• Orientation information

• Parameters that define robot movements near and at the teachpoint

You set and edit teachpoints in the DDR Diagnostics Teachpoints tab.
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Orientation coordinates
A teachpoint is defined by a set of coordinates that define where the robot 
picks up or places labware. The teachpoint can be on an integrated device or 
a platepad. Teachpoints are relative to the robot home position. You can view 
the teachpoint or robot coordinates in the Teachpoints tab in DDR Diagnostics.

Orientation information
Each teachpoint contains the following orientation information:

Orientation Description

Robot arm Left (L), elbow joint angle 
of >= 180°

Right (R), elbow joint 
angle < 180°

Labware Landscape Portrait
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The orientation information is displayed in the Teachpoints tab in DDR 
Diagnostics.

Parameters that define robot movements
A number of parameters define the robot movements near or at a teachpoint:

• Approach height

• Approach distance

• Gripper offset at the location

• Custom actions (delidding, lidding, or stirring action)

For more information, see “Creating a new teachpoint” on page 74.

A1 well Away from the robot 
grippers in either labware 
orientation

Toward the robot grippers 
in either labware 
orientation

Orientation Description
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Guidelines for setting teachpoints

Before setting teachpoints, determine the best orientations for each location. In 
addition, be aware of how varying robot and labware orientations between 
teachpoints can affect robot speed and efficiency.

Orientations to consider
Before you set a teachpoint, take into consideration all of the following:

• Robot- arm orientation. Determine the best robot- arm orientation (left or 
right) for the location. The accessibility of a location can determine the 
robot- arm orientation. See “Examples” on page 64.

• Labware orientation. Determine the best labware orientation (landscape or 
portrait) for the location. The orientation might be determined by device 
requirements. For example, the Labware Stacker requires labware to be in 
the landscape orientation, but the portrait Plate Hub Carousel requires 
labware to be in the portrait orientation.

• A1- well orientation. Determine the A1- well orientation of the labware. In 
general, for devices that require the landscape orientation, such as the 
Labware Stacker and the landscape Plate Hub Carousel, the optimal A1-
well orientation is typically away from the grippers. For storage devices 
that require the portrait orientation, the optimal A1- well orientation 
depends on the requirements at other teachpoints in the system. See 
“Examples” on page 64.

For a description of the orientations, see “Orientation information” on page 61.

Factors that affect robot speed and efficiency
To increase robot speed and efficiency, you should:

• Maximize the robot’s ability to plan optimal paths. Wherever possible, set 
a teachpoint with as many orientations as possible so that the robot can 
determine the optimal path during the run. For example, set a teachpoint 
with both the right-  and left- arm orientations.

• Minimize the number of regrips between teachpoints. A regrip is required 
if, for example, the robot is transferring a labware from one location that 
requires one labware orientation to another location that requires a 
different labware orientation. To minimize the time required for regripping, 
wherever possible, set a teachpoint with multiple orientations and allow 
the robot to determine the optimal path during the run. Alternatively, 
consistently set teachpoints using one orientation wherever possible. For 
more information about regrip stations, see “Designating a teachpoint as a 
regrip station” on page 77.

• Maximize the gripper offset ranges. A regrip station is also used if the 
robot needs to adjust gripping height as it transfers a labware from one 
location that requires a gripper height that is different from the next 
location. To provide the system with the greatest flexibility for identifying a 
grip position that works for all locations, you should set the widest 
possible range for each gripper offset parameter. For more information 
about gripper offset ranges, see “Setting the gripper offset parameters” on 
page 83.

• Set Approach Distance at the smallest possible value. In general, rotating 
robot movements are faster than straight movements. To ensure that the 
robot rotates from the safe zone directly to the teachpoint, set the 
Approach Distance at 0. If obstacles near or at the teachpoint does not 
permit the rotating movement, set the Approach Distance at the smallest 
possible value for the location. For more information, see “Setting the 
approach distance” on page 81.
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Examples

Example 1: Robot-arm orientation
In the following example, the system window (1) and an adjacent device (2) are 
two obstacles near the desired location (3). Therefore, the left- arm orientation 
should be used when setting the teachpoint.

Example 2: Robot-arm and A1-well orientation
In the following example, there are no obstacles near the platepad in the 
portrait orientation. You can set the platepad teachpoint with the left-  (1) and 
right- arm (2) orientations.

The position of the A1 well is device dependent. So the arm orientation the 
robot uses at this platepad is determined by the A1- well orientation at the 
next teachpoint.

In the following example, the labware is placed at the platepad with the A1 
well positioned as shown (1). If the next device requires the A1 well to be 
toward the grippers (2), the robot will use the left- arm orientation. However, if 
the next device requires the A1 well to be away from the grippers (3), the 
robot will use the right- arm orientation.

1

2

3

1 2
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Example 3: Plate Hub Carousel - Bravo deck location 4 - Plate Hub Carousel
A protocol requires labware to be moved from a portrait Plate Hub Carousel 
slot to the Bravo Platform for liquid- handling tasks. After processing, the 
labware must be moved from the Bravo Platform and returned to the portrait 
Plate Hub Carousel slot.

The labware orientation option or requirement at each device is as follows:

Note: In the example setup, the robot can only approach the Bravo deck as 
shown.

A
1

00240
Bravo
Plate Orientation

1 2 3

4 5 6

7 8 9
002

A
1

A
1

1

2

3

Device Orientation option or requirement

Portrait Plate Hub Carousel 
(top view):

• Portrait

• A1 either away or toward the 
grippers

Bravo Platform (top view):

• Portrait

• A1 toward the grippers



3   Setting up the Direct Drive Robot
Planning Direct Drive Robot teachpoints

66 BioCel System User Guide

The optimal teachpoint setup at the Plate Hub Carousel would require the least 
number of regrips as the labware is transferred between the two devices.

If the Plate Hub Carousel teachpoint is set with the A1- toward orientation, the 
robot can transfer the labware from the Plate Hub Carousel to the Bravo 
Platform without regripping. Therefore, the A1- toward orientation at the Plate 
Hub Carousel is the optimal setup.

If the Plate Hub Carousel teachpoint is set with the A1- away orientation, the 
robot must regrip the labware during the transfer. Therefore, the A1- away 
orientation at the Plate Hub Carousel is not the optimal setup.

00240
Bravo
Plate Orientation

1 2 3

4 5 6

7 8 9
00240

A
1

00240
Bravo
Plate Orientation

1 2 3

4 5 6

7 8 9
00240

A
1
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Example 4: Repeating tasks and regrip frequency
A protocol requires labware to be moved from a portrait Plate Hub Carousel 
slot to the Bravo Platform for liquid- handling tasks. After processing, the 
labware must be moved from the Bravo Platform to a dispenser. Subsequent 
protocol tasks move the labware multiple times between the dispenser and the 
Plate Hub Carousel for cycles of dispensing and incubation.

The labware orientation option or requirement at each device is as follows:

Note: In the example setup, the robot can only approach the Bravo deck and 
the dispenser as shown.

The optimal teachpoint setup at the Plate Hub Carousel would require the least 
number of regrips as the labware is transferred between the three devices.

If the Plate Hub Carousel teachpoint is set with the A1- away orientation, the 
robot must regrip as it moves labware from the Plate Hub Carousel to the 
Bravo deck (1, 2), and regrip again as it moves the labware from the Bravo 
deck to the dispenser (3, 4). Thereafter, the robot can move the labware 
between the dispenser and Plate Hub Carousel without regripping (5–9). So the 
total number of regrips in this scenario is two.

Note: In general, to minimize the number of regrips, consider matching the 
orientations of consecutive teachpoints in repeating protocol tasks.

Device Orientation option or requirement

Portrait Plate Hub Carousel 
(top view):

• Portrait

• A1 either away or toward the 
grippers

Bravo Platform (top view):

• Portrait

• A1 toward the grippers

Dispenser (top view):

• Portrait

• A1 away from the grippers
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If the Plate Hub Carousel teachpoint is set with the A1- toward orientation, the 
robot can move labware from the Plate Hub Carousel to the Bravo deck 
without regripping. However, the robot must regrip as it moves labware from 
the Bravo deck to the dispenser, and then multiple times as it moves labware 
between the dispenser and Plate Hub Carousel in cycles of dispensing and 
incubation. The total number of regrips is greater than two. Therefore, the A1-
toward orientation at the Plate Hub Carousel is not the optimal setup.

Related information

00240
Bravo
Plate Orientation

1 2 3

4 5 6

7 8 9
00240

A
1

A
1

1 2

3

4

1 2

3

4

5 - 9

For information about... See...

Teachpoint files “Teachpoint files” on page 69

Setting teachpoints “Setting Direct Drive Robot teachpoints” 
on page 69
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Setting Direct Drive Robot teachpoints 

About this topic

The BioCel System is set up with the correct teachpoints to enable the robot 
to move to the correct locations during a protocol run. You do not need to add 
or modify the existing teachpoint file unless you:

• Integrate a new device in the BioCel System.

• Move the BioCel System.

• Move or replace one of the devices in the system.

• Adjust settings on the devices.

Depending on the type of device, the teachpoint setting procedure can vary.

This topic provides basic teachpoint setting concepts: how to use the supplied 
teaching jig to set, verify, and edit Direct Drive Robot teachpoints. Always 
contact Automation Solutions Technical Support when you want to integrate a 
new device.

For information about device teachpoints, see the device user guide.

Teachpoint files

The teachpoints you set are saved in the XML format in a teachpoint file. The 
default teachpoint file name is Teachpoints_<profilename>.xml, where 
<profilename> is the name of the profile. The software saves the file in the 
C:\Program Files\Agilent Technologies\Settings\DDR folder. However, you can 
select another file name and location when saving the file.

You can have multiple teachpoint files for each BioCel System if a device needs 
to serve multiple purposes. For example, a platepad can be taught as a 
platepad or as a regripping station. You can also have multiple teachpoint files 
for the system if a device is only used in some protocols but not others. For 
example, if a device is installed on a mobile device table and can be removed 
when it is not in use.

The teachpoint file is referenced by a profile. For information about profiles, 
see “Creating and managing Direct Drive Robot profiles” on page 47.

CAUTION Always edit and manage teachpoints in the Robot Diagnostics software. Do not 
edit the teachpoint file (XML file) directly. Editing the file directly can cause the robot to move 
to incorrect locations and bump into devices or other obstacles.

CAUTION Before you begin changing teachpoints, make a backup copy of the teachpoint 
file. If the original file becomes lost or damaged, you can use the backup copy instead of 
reteaching all the positions.
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Workflow

The workflow for setting a Direct Drive Robot teachpoint is as follows:

Step For this task See...

1 Install the teaching jig in 
the robot grippers.

If size restrictions at 
teachpoints prevent the 
use of the teaching jig, 
use the labware intended 
for the location.

“Installing and removing the teaching 
jig in the robot grippers” on page 71

“Setting teachpoints using a labware” 
on page 88

2 Create a new teachpoint. “Creating a new teachpoint” on 
page 74

3 Name the teachpoint. “Naming the teachpoint” on page 74

4 Specify the A1- well 
orientation.

“Specifying the A1- well orientation” 
on page 74

5 Optional. Designate a 
teachpoint as a regrip 
station.

“Designating a teachpoint as a regrip 
station” on page 77

6 Set teachpoint 
parameters:

• Set the approach 
height.

• Set the approach 
distance.

• Set the gripper offset 
range.

• Fine- tune the 
teachpoint 
coordinates.

• Select custom actions.

• “Setting the approach height” on 
page 80

• “Setting the approach distance” 
on page 81

• “Setting the gripper offset 
parameters” on page 83

• “Setting the Position Z, Waist, 
Elbow, and Wrist parameters” on 
page 84

• “Selecting custom actions” on 
page 84

7 Save the teachpoints. “Saving the teachpoints” on page 85

8 Optional. Selecting the 
All regrip stations are 
safe from above option.

“Selecting the All regrip stations are 
safe from above option” on page 87
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Before you start

Make sure:

• You review the guidelines for setting teachpoints (“Planning Direct Drive 
Robot teachpoints” on page 60).

• You have the provided Direct Drive Robot teaching jig. If size restrictions at 
teachpoints prevent the use of the teaching jig, use the labware intended 
for the location. See “Setting teachpoints using a labware” on page 88.

• You have a 2- mm hex wrench for installing and removing the teaching jig.

• The correct profile is initialized (“Creating and managing Direct Drive 
Robot profiles” on page 47).

• The safety interlock is turned off (“Power panel” on page 7).

Installing and removing the teaching jig in the robot grippers

IMPORTANT If size restrictions at a teachpoint prevent the use of the 
teaching jig, use the labware intended for the location. For information, see 
“Setting teachpoints using a labware” on page 88.

To install the teaching jig:

1 In DDR Diagnostics, click the Jog/Move tab, and then click Move to safe zone. 
The robot moves into its safe zone.
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2 In DDR Diagnostics, click the Teachpoints tab.

3 In the Labware list, select Teaching jig.

4 Click Teach Mode. The blue light on the robot hand turns on to indicate that 
it is in the teach mode. You should be able to move the robot arm without 
resistance. 

 IMPORTANT Always move the robot arm slowly when in the Teach 
Mode.
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5 Manually move the robot arm to a position that will be convenient for you 
to install the teaching jig.

6 Using the 2- mm hex wrench, turn the gripper lead screw to open the robot 
grippers so that the teaching jig can fit in the grippers. You can access the 
lead screw from both sides of the robot hand.

7 Position the teaching jig between the robot grippers. Align the two pins on 
both sides of the teaching jig with the white dimples in the grippers. The 
following diagram shows the alignment positions in the landscape mode.

8 Using the 2- mm hex wrench, turn the gripper lead screw to close the robot 
grippers. The grippers should hold the teaching jig securely.

To remove the teaching jig:

1 While in the Teach Mode, manually move the robot arm to a position that 
will be convenient for you to remove the teaching jig. Make sure you move 
the robot slowly

2 Place a hand under the teaching jig to support its weight for the next step.

3 Using the 2- mm hex wrench, turn the gripper lead screw to open the robot 
grippers so that the teaching jig is free from the grippers.
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Creating a new teachpoint

To create a teachpoint:

1 With the teaching jig in the robot grippers, slowly move the robot arm to 
the desired location. When moving the robot arm:

a Check for potential obstacles near the location.

b Keep in mind the “Guidelines for setting teachpoints” on page 63.

2 Position the teaching jig at the desired location. Make sure the teaching jig 
sits flat at the location.

3 Press the blue button on the robot hand. The blue light flashes for a 
moment. In the Teachpoints tab, a new entry appears.

Note: The blue light does not flash if the robot is at a location that is 
outside of its travel limits. Move the teachpoint location and try again.

4 To view the entire teachpoints table, click the  (Maximize/Minimize) 

button. The table expands so that all of the columns are displayed in the 
tab.

Naming the teachpoint

To name the teachpoint:
Double- click the Name box and type a new name for the teachpoint. Use a 
name that describes the location, such as the device name (for example, 
PlateLoc -  1).

Specifying the A1-well orientation

The icon under the teachpoint name indicates the following:
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Common orientations
Eight orientations are possible for each teachpoint, based on different A1- well, 
labware, and robot- arm orientations. The following table presents six common 
orientations.

Item Description

1 A1- well orientation. From the robot’s perspective, the A1 well (the 
gray corner on the icon) can be:

• Away from the robot grippers.  or  

• Toward the robot grippers.  or  

The robot cannot detect the location of the A1 well. Therefore, you 
must provide this information in the software.

To change the A1-well orientation:
Double- click the icon. The robot gripper symbol (green triangle) moves 
to the opposite side of the labware.

Note: The robot is unaware of the A1- well orientation assignment. 
Changing it in the software does not automatically or physically 
change the way the robot holds the labware.

2 Labware orientation. The location of the green robot gripper symbol 
determines the orientation:

• Landscape.  or 

• Portrait.  or 

Note: You cannot change the labware orientation. The software uses 
the gripper width to determine whether it is in the landscape or 
portrait mode.

3 Robot- arm orientation:

Left (L)  or right (R) 

Note: You cannot change the robot arm orientation. The software uses 
the elbow joint angle to determine whether it is in the left-  or right-
arm mode. A right arm has an elbow joint angle < 180°. A left arm 
has an elbow joint angle of >= 180°.
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Orientation icon Labware orientation Robot arm orientation
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Atypical orientations
The following table presents two atypical orientations. These orientations are 
used only when:

• Devices, such as the FLIPR Tetra device, require the A1 well to be toward 
the grippers.

• Two robots in the same system will use a single location to pass labware. 
One robot will approach the teachpoint using a common orientation (for 
example, landscape and A1 away), the other robot will approach the same 
teachpoint from the opposite side, using an atypical orientation (for 
example, landscape and A1 toward).

Designating a teachpoint as a regrip station

A regrip station is a location that enables the robot to:

• Change the labware orientation between teachpoints that require different 
orientations (landscape or portrait). 

• Change A1- well orientation between teachpoints that require different A1-
well orientations.

• Adjust its grip at the specified labware gripping height. The location is 
typically used after a robot picks up a labware higher than the specified 
gripping height because of physical restrictions at a teachpoint.

Note: Regrip stations cannot be used for other purposes such as deadlock 
avoidance.

To accommodate different labware orientations, add multiple orientations to 
the regrip teachpoint. In the following example, the Regrip teachpoint 
accommodates both the right-  and left- arm orientations, with the landscape 
labware orientation and the A1 well away from the grippers.

Orientation icon Labware orientation Robot arm orientation
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To designate a teachpoint as a regrip station:

Select the Regrip Station  check box.

To add additional orientations to the regrip teachpoint:

1 Create another teachpoint at the same location but with a different 
orientation. A new entry appears in the teachpoints table.

2 If necessary, set the A1- well orientation.

By default, a new teachpoint will always have the A1- away orientation. 
When adding multiple teachpoints at a regrip station, if two of the 
teachpoints have the same labware and robot- arm orientation, and it is 
difficult to tell which one should have the A1- well away or toward 
assignment unless you see the actual robot position:

                                                        

CAUTION Changes to a regrip station (from a regular teachpoint to a regrip station or from 
a regrip station to a regular teachpoint) are not applied until you save the teachpoint file.
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a Right- click the teachpoint in the teachpoints table, and then click Show 
robot position.

b In the dialog that appears, check the robot position, and the robot- arm 
and A1- well orientations.

In the following example, two teachpoints have the same labware and 
robot- arm orientations: landscape and right- arm. However, depending 
on the robot approach, the A1- well orientation will be different.

c Click OK to exit the dialog box and, if necessary, set or correct the A1-
well orientation setting.
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3 Drag the new teachpoint under an existing regrip teachpoint.

4 Set the remaining teachpoint parameters.

Setting the approach height

Approach height is the height clearance, in millimeters, the robot must 
maintain above the teachpoint as it moves towards or away from the 
teachpoint.

• Approach Ht (with labware) is the height clearance when the robot is 
holding a labware.

• Approach Ht (no labware) is the height clearance when the robot is not 
holding labware.

You can reduce the approach height to prevent collision with shelves or other 
obstacles above the teachpoint. However, make sure there is sufficient 
clearance below the labware to prevent collision with raised tabs or other 
obstacles at the teachpoint.

IMPORTANT The approach height value works in conjunction with the 
approach distance to clear obstacles near or at the teachpoint. Therefore, 
before setting the approach height value, you should determine the approach 
distance value to use. See “Setting the approach distance” on page 81.

If Approach Distance is set at the default value:

• The Approach Ht (with labware) value should allow the robot and labware 
to arrive at the teachpoint without bumping into any obstacles, such as 
raised tabs, at the front of the teachpoint.

• The Approach Ht (no labware) value should allow the robot and its opened 
grippers to arrive at the teachpoint without bumping into any obstacles, 
such as raised tabs, at the sides of the teachpoint.

Note: If the teachpoint does not have any obstacles on the front or 
sides, you can set Approach Ht (no labware) at 0. The robot will 
approach the teachpoint at the higher of the teachpoint or labware 
minimum gripper offset value.

                                                        

CAUTION The new teachpoint must have a different orientation than the existing 
regrip teachpoint. Otherwise, the software will prompt you to replace or reteach the 
existing teachpoint during the drag-and-drop operation.

Approach ht.

CAUTION Incorrect approach heights can cause the robot to crash into obstacles.
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If Approach Distance is less than the default value:

• The Approach Ht (with labware) value should allow the robot and labware 
to arrive at the teachpoint without bumping into obstacles, such as raised 
tabs, at the front and sides of the teachpoint.

• The Approach Ht (no labware) value should allow the robot and its opened 
grippers to arrive at the teachpoint without bumping into the tallest 
labware at the teachpoint.

In general, if a teachpoint has raised tabs only at the front of the teachpoint, 
the Approach Ht (with labware) value should be greater than the Approach Ht 
(no labware) value.

Agilent Technologies recommends the following Approach Ht (with labware) 
values:

* Required approach height for the device

To set the Approach Ht (with labware) and Approach Ht (no labware) parameters:

Double- click in the Approach Ht box and type the desired value. The default 
value for both parameters is 15 mm.

Setting the approach distance

Approach distance is the distance, in millimeters, from the teachpoint. Within 
this distance, the robot must:

• Maintain the specified approach height.

• Move in a straight line toward or away from the teachpoint.

Device Approach Ht 
(with labware)

Most devices 9 mm

Vertical Pipettor shelf with tipbox 6 mm

Centrifuge 5.5 mm

Plate Hub Carousel Carousel or Plate Hotel with  
standard labware

5–6 mm

Lid Hotel Station 0 mm*

Vacuum Delid Station 0 mm*
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You use the approach distance to provide clearance:

• Between the teachpoint and the robot grippers.

• If the teachpoint has obstacles on either side of the teachpoint.

For example, you can use the approach distance parameter so that the robot 
grippers can enter and exit a device such as the Microplate Centrifuge without 
bumping into the sides of the narrow entryway.

When determining the value to specify, manually move the robot away from the 
teachpoint until the grippers and the teaching jig are clear of the edge of the 
teachpoint and obstacles near the teachpoint.

In addition, consider the following:

• In general, if Approach Distance is set at the default value, you can use 
the default Approach Ht values.

• Rotating robot movements are faster than straight movements. If Approach 
Distance is set at 0, the robot will move (or mostly rotate) from the safe 
zone directly to the teachpoint at the Approach Ht.

Before setting Approach Distance at 0, you should consider the obstacles 
surrounding and at the teachpoint. If obstacles near or at the teachpoint 
do not permit the rotating movement, set Approach Distance at the 
smallest possible value for the location. 

• If Approach Distance is 0, Approach Ht (no labware) must be a higher 
value to ensure clearance for the tallest labware that will be placed at the 
teachpoint. 

• If Approach Distance is greater than 0, Approach Ht can be low enough to 
clear raised tabs at the teachpoint.

To set the Approach Distance parameter:
Double- click in the Approach Distance box and type the desired value. The 
default value is 75 mm for the landscape orientation and 125 mm for the 
portrait orientation.

CAUTION When setting Approach Distance, be aware that a large value can cause the 
robot arm to back into the raised robot base or the mast.
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Setting the gripper offset parameters

About gripper offset parameters
The robot gripper offset range parameters tell the Direct Drive Robot where to 
grip a given labware type when transferring it from one device to another. 
Each device within a system can pose different accessibility challenges when 
transferring the labware. For example, some devices can have a deep, recessed 
area, whereas others are more flat.  Some devices might have tall flanges that 
make it impossible for the robot to grip a microplate at a very low point.

The Direct Drive Robot uses three types of gripper offset ranges to determine 
the most compatible grip position for the labware type:

1 Gripper offset range for the labware. Specified on the Direct Drive Robot 
tab in the Labware Editor for each labware definition. 

2 Gripper offset range for pick- location device. Specified in the DDR 
Diagnostics software for a given device (device A).

3 Gripper offset range for place- location device. Specified in the DDR 
Diagnostics software for a given device (device B).

If the three gripper offset ranges overlap, the robot will use the smallest 
common gripper offset to perform a direct labware transfer from device A 
to device B without regripping the labware. If the three ranges do not 
overlap, the software attempts to plan a path through one or more regrip 
stations. If the robot cannot perform the transfer, an error message appears 
at the time of the requested labware transfer.

To provide the system with the greatest flexibility for identifying a grip 
position that works for all locations, you should set the widest possible range 
for each gripper offset parameter.
Note: To catch and correct potential labware transfer errors, Agilent 
Technologies recommends that you verify the teachpoints and perform a dry 
run.

Before you set the gripper offset parameters
Under some circumstances, you should consider the gripper offset ranges of 
more than two teachpoints to avoid a regrip. For example, a labware will be 
delidded as it moves from the pick location (device A) to the place location 
(device B). In this case, the gripper offset range for the delid teachpoint must 
also overlap with the gripper offset range for the labware, device A, and 
device B.

Procedure

To set the Min gripper offset and the Max gripper offset parameters for a device:
Double- click the Min gripper offset and Max gripper offset box and type the desired 
values: 

• Minimum gripper offset. The vertical distance (mm) from the teachpoint to 
the lowest point where the robot grippers can hold the microplate securely. 
The default value is 0 mm.

• Maximum gripper offset. The vertical distance (mm) from the teachpoint 
to the highest point where the robot grippers can hold the microplate 
securely. The default value is 10 mm.

Maximum
Minimum
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IMPORTANT For regrip stations, make sure the gripper offset range can 
accommodate all types of labware.

Setting the Position Z, Waist, Elbow, and Wrist parameters

If necessary, you can fine- tune the teachpoint coordinates using the following 
parameters:

• Position Z. The z- axis coordinate of the robot, measured in millimeters.

• Waist. The waist joint coordinate.

• Elbow. The elbow joint coordinate.

• Wrist. The wrist joint coordinate.

To set a coordinate parameter:
Double- click in the Position Z, Waist, Elbow, and Wrist box and type the desired 
value.

Note: You can also use the jog method when fine- tuning. For instructions, see 
“Editing existing Direct Drive Robot teachpoints” on page 102.

Selecting custom actions

Custom actions are special pick- and- place actions that the robot will perform 
after it arrives at the teachpoint. The set of custom actions include:

• Delidding at a Lid Hotel Station or a Vacuum Delid Station

• Relidding at a Lid Hotel Station

• Stirring the labware

• Pressing down a labware (for example, PCR plate) to ensure placement

You can select a custom action for when the robot picks up the labware or 
when it places the labware.

To select a custom action for a teachpoint:

1 Select the appropriate custom action from the Pick Custom Action list.

Use the Pick Custom Action to:

• Relid labware at the Lid Hotel Station. From the Pick Custom Action list, 
select Lid Hotel relid.

Note: You can select a custom action for each storage bay in the Lid 
Hotel Station. Do not assign a custom action for the platepad at the 
top of the station.

• Stir the labware at the teachpoint. From the Pick Custom Action list, 
select Stir.

                                                        

CAUTION In general, you do not need to change any of the coordinates after setting  
a teachpoint.
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2 Select the appropriate custom action from the Place Custom Action list.

Use the Place Custom Action to:

• Delid labware at the Lid Hotel Station or the Vacuum Delid Station. 
From the Place Custom Action list, select either Lid Hotel delid or Vacuum 
delid.

Note: You can select a custom action for each storage bay in the Lid 
Hotel Station. Do not assign a custom action for the platepad at the 
top of the station.

• Press down labware, such as a PCR plate, when the robot is placing 
the labware. During the place action, the robot will press down by 
2 mm, open the grippers to release the labware, and then move up  
by 2 mm. 

From the Place Custom Action list, select either Pushdown (landscape) or 
Pushdown (portrait).

Saving the teachpoints

The teachpoint information is stored in:

• The teachpoints file on the controlling computer

• The robot firmware

When you create or modify teachpoints without saving them, the changes are 
kept in computer memory only. Saving the teachpoints in DDR Diagnostics 
updates the teachpoints file and the information in the firmware.

Note: Saving teachpoints adds new teachpoints or updates only those 
teachpoints that have been modified in DDR Diagnostics. Saving teachpoints 
does not overwrite all of the existing teachpoints. For example, a teachpoint 
file contains teachpoints A and B. You modify teachpoint B and add 
teachpoint C. When you save the teachpoints, teachpoint C is added, and 
teachpoint B is updated. Teachpoint A is not touched.

To save the teachpoints:

1 Click Save teachpoints. 
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If there are any errors or warnings, such as an out- of- bounds parameter 
value, the software will list them in the Teachpoint Errors and Warnings 
dialog box.

2 Click OK to close the dialog box and return to the teachpoints table. Notice 
that error and warning symbols appear in the teachpoints table. 

3 To display the error or warning message, rest the pointer on the error or 
warning symbol.

4 Fix the errors, and then click Save teachpoints.

Be sure to remove the teaching jig from the robot grippers when you are 
finished. See “Installing and removing the teaching jig in the robot grippers” on 
page 71.
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Selecting the All regrip stations are safe from above option

The All regrip stations are safe from above option enables the robot to rotate its 
wrist above the regrip station while it prepares to change labware orientation.

If the option is selected, the robot will place the labware at the regrip station, 
lift its arm to the specified Approach Ht (no labware) distance above the 
regrip station, rotate its wrist, and then pick up the labware using the new 
orientation. The robot does not retreat into the safe zone during this process.

If the option is not selected, the robot will place the labware at the regrip 
station, retreat into the safe zone, and then pick up the labware at the regrip 
station using the new labware orientation. The specified Approach Ht and 
Approach Distance values are used during the retreat and pickup movements.

After you have finished setting all the teachpoints, review the list in the 
teachpoints table. You can select the All regrip stations are safe from above option in 
the Profiles tab if:

• There is at least one regrip station that is used to change labware 
orientations.

• There is sufficient clearance above all regrip stations to permit the robot 
to rotate its wrist during a labware orientation regrip process.

To see where you select this option in the Profiles tab, see “Creating a Direct 
Drive Robot profile” on page 48.

Related information

For information about... See...

Robot Diagnostics • “Software description” on page 24 

• “DDR Diagnostics” on page 206

Direct Drive Robot axes “Direct Drive Robot” on page 15

Quick reference of DDR 
Diagnostics commands and 
parameters

“Quick reference” on page 355
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Setting teachpoints using a labware

When to use labware instead of the teaching jig

In cases where size restriction at a teachpoint prevents the use of the teaching 
jig, you can use the labware intended for the location.

Procedure

To use a labware in the teaching procedure:

1 Teach a reference location, such as Platepad 1, using the teaching jig.

 IMPORTANT When teaching the reference location, make sure the Min 
gripper offset parameter value is less than or equal to the minimum 
gripper offset value specified for the labware in the Labware Editor.

2 Verify the Platepad 1 teachpoint.

3 Place the desired labware at Platepad 1.

4 Follow the instructions in “Picking up labware at the teachpoint” on 
page 93 to pick up the labware from Platepad 1.

5 In DDR Diagnostics, click Teach Mode. The blue light on the robot hand 
turns on to indicate that it is in the teach mode. You should be able to 
move the robot arm without resistance. Make sure you move the robot 
slowly.

6 Follow the instructions in “Creating a new teachpoint” on page 74 to create 
a new teachpoint.

7 Set the teachpoint parameters.
                                                        

CAUTION When using a labware to set teachpoints, the software assumes that the 
robot is holding the labware at the minimum gripper offset.
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8 Save the teachpoint.

9 Verify and edit the teachpoint.

Related information

For information about... See...

Workflow for setting teachpoints “Workflow” on page 70

Using other commands and 
parameters in the DDR Diagnostics

“DDR Diagnostics” on page 206

Quick reference of DDR 
Diagnostics commands and 
parameters

“Quick reference” on page 355
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Verifying Direct Drive Robot teachpoints

After you set a new teachpoint, you should verify that it is accurate. During 
the verification procedure, you will check that the robot is able to:

• Go to the teachpoint from its current location.

• Pick up labware at the teachpoint.

• Place labware at the teachpoint.

• Transfer labware from another teachpoint to this teachpoint.

You use the commands in the Jog/Move tab for the verification procedure.

Moving the robot to the new teachpoint

You use the Move to command to check that:

• The robot is able to move to the selected teachpoint.

• The approach orientation at the teachpoint is correct.

To move the robot to the teachpoint:

1 Make sure the robot has a clear path to the teachpoint. For example, you 
might want to move the robot into the safe zone.

2 Remove obstacles in the path of the robot.

3 In DDR Diagnostics, make sure the correct labware is selected in the Labware 
list.
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4 In the Speed list, select Slow.

5 Click the Jog/Move tab, and, if necessary, click Enable Motors to enable the 
robot motors.

6 In the Move area, select the teachpoint you want to verify from the list 
above the red labware. In the Robot Status area, the selected teachpoint 
turns red.

In the following example, the HotelTop teachpoint is selected. In the Robot 
Status area, the teachpoint at the top of the Plate Hotel becomes red.

7 If you selected a teachpoint with multiple orientations, such as a regrip 
station, select the specific set of orientations you want to verify.

Note: By default, all orientations defined for the teachpoint are selected.

• If multiple labware orientations are available, make sure only one 
orientation is selected. Click a triangle to select or clear the orientation 
selection. A green triangle means the orientation is selected. A white 
triangle means the orientation is not selected.

In the following example, three labware orientations are available: 
Landscape with the A1 well away from the grippers, landscape with 
the A1 well toward the grippers, and portrait with the A1 well away 
from the grippers (1). For the verification procedure, only one 
orientation is selected: Landscape with the A1 well away from the 
grippers (2).
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• If the Optimal orientation is selected to indicate that both the right-
arm and left- arm orientations are available, select Right or Left.

In the following example, the Regrip station allows for both the right-  
and left- arm orientations (1). To verify the right- arm orientation, Right 
is selected (2).

Agilent Technologies recommends that you verify one set of orientations at 
a time. If multiple sets of orientations are selected, the robot will use the 
optimal path.

8 In the Move area, click Move to under the red labware.
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Alternatively, you can right- click the red teachpoint in the Robot Status area, 
and then click Move to.

The robot moves to the selected teachpoint. The robot remains at the 
teachpoint and the grippers are open.

9 Check that the robot used the correct approach distance and approach 
height. In addition, make sure the robot is in the correct orientation as 
shown in the Move area.

In the following example, the robot should be in the right- arm mode and 
the grippers should be opened as if it was transferring a labware in the 
landscape orientation.

10 To make adjustments, proceed to “Editing existing Direct Drive Robot 
teachpoints” on page 102.

11 Repeat the procedure for another teachpoint. If you are verifying a 
teachpoint with multiple orientations, be sure to verify each orientation 
before checking another teachpoint.

Picking up labware at the teachpoint

You use the Pick from command to check that:

• The robot is using the correct approach distance and approach height as it 
moves to and from the teachpoint.

• The robot is able to pick up labware at the selected teachpoint.

• The robot picks up the labware within the specified gripper offset range.
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To pick up labware from the teachpoint:

1 Make sure the robot has a clear path to the teachpoint. For example, you 
might want to move the robot into the safe zone.

2 Remove obstacles in the path of the robot.

3 Manually place the labware at the teachpoint.

4 In DDR Diagnostics, select the labware you want to use from the Labware list.

5 In the Speed list, select Slow.

6 In the Move area, select the teachpoint you want to verify from the list 
above the red labware. In the Robot Status area, the selected teachpoint 
turns red.

7 If you selected a teachpoint with multiple orientations, such as a regrip 
station, select the specific set of orientations you want to verify.

Note: By default, all orientations defined for the teachpoint are selected.

• If multiple labware orientations are available, make sure only one 
orientation is selected. Click a triangle to select or clear the orientation 
selection. A green triangle means the orientation is selected. A white 
triangle means the orientation is not selected.

In the following example, three labware orientations are available: 
Landscape with the A1 well away from the grippers, landscape with 
the A1 well toward the grippers, and portrait with the A1 well away 
from the grippers (1). For the verification procedure, only one 
orientation is selected: Landscape with the A1 well away from the 
grippers (2).

• If the Optimal orientation is selected to indicate that both the right-
arm and left- arm orientations are available, select Right or Left.

In the following example, the Regrip station allows for both the right-  
and left- arm orientations (1). To verify the right- arm orientation, Right 
is selected (2).

Agilent Technologies recommends that you verify one set of orientations at 
a time. If multiple sets of orientations are selected, the robot will use the 
optimal path.
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8 In the Move area, click Pick from under the red labware.

Alternatively, you can right- click the red teachpoint in the Robot Status area, 
and then click Pick from.

The robot moves to the teachpoint, picks up the labware, and moves it to 
the safe zone. The labware remains in the robot grippers.

9 Check that the robot used the correct approach distance and approach 
height when picking up the labware. Also check that the robot is holding 
the labware within the specified gripper offset range.

10 To make adjustments, proceed to “Editing existing Direct Drive Robot 
teachpoints” on page 102.

11 If the robot has completed its task correctly, repeat the procedure for 
another teachpoint. If you are verifying a teachpoint with multiple 
orientations, be sure to verify each orientation before checking another 
teachpoint.
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Placing labware at the teachpoint

You use the Place to command to check that:

• The robot is using the correct approach distance and approach height as it 
moves to and from the teachpoint.

• The robot is able to place the selected labware at the selected teachpoint.

IMPORTANT To use the Place to command, you must first use the Pick from 
command to pick up a labware so that the gripper offset is known.

To place labware at the teachpoint:

1 Make sure the robot has a clear path to the teachpoint. For example, you 
might want to move the robot into the safe zone.

2 Remove obstacles in the path of the robot.

3 Make sure the robot is still holding the labware from the previous 
procedure (“Picking up labware at the teachpoint” on page 93).

4 In DDR Diagnostics, make sure the correct labware is selected in the Labware 
list.

5 In the Speed list, select Slow.

6 In the Move area, select the teachpoint you want to verify from the list 
above the red labware. In the Robot Status area, the selected teachpoint 
turns red.

Note: Alternatively, you can select the teachpoint under the blue 
labware. In the Robot Status area, the selected teachpoint turns blue.

7 If you selected a teachpoint with multiple orientations, such as a regrip 
station, select the specific set of orientations you want to verify.

Note: By default, all orientations defined for the teachpoint are selected.

• If multiple labware orientations are available, make sure only one 
orientation is selected. Click a triangle to select or clear the orientation 
selection. A green triangle means the orientation is selected. A white 
triangle means the orientation is not selected.
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In the following example, three labware orientations are available: 
Landscape with the A1 well away from the grippers, landscape with 
the A1 well toward the grippers, and portrait with the A1 well away 
from the grippers (1). For the verification procedure, only one 
orientation is selected: Landscape with the A1 well away from the 
grippers (2).

• If the Optimal orientation is selected to indicate that both the right-
arm and left- arm orientations are available, select Right or Left.

In the following example, the Regrip station allows for both the right-  
and left- arm orientations (1). To verify the right- arm orientation, Right 
is selected (2).

Agilent Technologies recommends that you verify one set of orientations at 
a time. If multiple sets of orientations are selected, the robot will use the 
optimal path.

8 In the Move area, click Place to under the red labware. 
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Alternatively, you can right- click the red teachpoint in the Robot Status area, 
and then click Place at.

With the labware in its grippers, the robot moves to the teachpoint, places 
the labware, and retreats to the safe zone.

9 Check that the robot used the correct approach distance and approach 
height when placing the labware. Also, check that the robot seated the 
labware correctly at the teachpoint. The robot should not drop the labware, 
and the labware should be centered at the teachpoint.

10 To make adjustments, proceed to “Editing existing Direct Drive Robot 
teachpoints” on page 102.

11 Repeat the procedure for another teachpoint. If you are verifying a 
teachpoint with multiple orientations, be sure to verify each orientation 
before checking another teachpoint.

Transferring labware between teachpoints

To ensure that a new teachpoint is accurate, check that the robot is able to 
transfer labware between the new teachpoint and an existing verified 
teachpoint. Incorrectly placed labware indicates that the teachpoint coordinates 
are incorrect.

To transfer labware from an existing verified teachpoint:

1 Make sure the robot has a clear path to the teachpoint. For example, you 
might want to move the robot into the safe zone.

2 Remove obstacles in the path of the robot.

3 Manually place the desired labware at the existing verified teachpoint (for 
example, platepad 1).

4 In DDR Diagnostics, select the labware you want to use from the  
Labware list.

5 In the Speed list, select Slow.
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6 In the Move area:

a Select the teachpoint you want to verify from the list above the red 
labware. In the Robot Status area, the selected teachpoint turns red.

b Select the existing verified teachpoint (for example, platepad 1) from 
the list above the blue labware. In the Robot Status area, the selected 
teachpoint turns blue.

7 If you selected a teachpoint with multiple orientations, such as a regrip 
station, select the specific set of orientations you want to verify.

Note: By default, all orientations defined for the teachpoint are selected.

• If multiple labware orientations are available, make sure only one 
orientation is selected. Click a triangle to select or clear the orientation 
selection. A green triangle means the orientation is selected. A white 
triangle means the orientation is not selected.

In the following example, three labware orientations are available: 
Landscape with the A1 well away from the grippers, landscape with 
the A1 well toward the grippers, and portrait with the A1 well away 
from the grippers (1). For the verification procedure, only one 
orientation is selected: Landscape with the A1 well away from the 
grippers (2).

• If the Optimal orientation is selected to indicate that both the right-
arm and left- arm orientations are available, select Right or Left.

In the following example, the Regrip station allows for both the right-  
and left- arm orientations (1). To verify the right- arm orientation, Right 
is selected (2).
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Agilent Technologies recommends that you first verify one set of 
orientations at a time first. After checking each set of orientations, select 
Optimal to check the optimal path the robot selects.

8 In the Move area, click the left- arrow Transfer button.

Alternatively, you can right- click the red teachpoint in the Robot Status area, 
and then click Transfer from <teachpoint_name>.

The robot picks up the labware at the reference teachpoint, places it at the 
teachpoint you want to verify, and retreats into the safe zone.

9 Check that the robot seated the labware correctly at the new teachpoint. 
The robot should not drop the labware, and the labware should be 
centered at the teachpoint.

Note: If the labware, pick- location, and place- location gripper offset 
ranges do not overlap, the software will display an error message when 
you attempt to transfer labware from teachpoint to teachpoint. Correct 
the error, and then try to transfer the labware again.

10 To make adjustments, proceed to “Editing existing Direct Drive Robot 
teachpoints” on page 102.

11 Repeat the procedure for another teachpoint. If you are verifying a 
teachpoint with multiple orientations, be sure to verify each orientation 
before checking another teachpoint.
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As a final check:

• Repeat the transfer procedure at the Fast robot speed. At step 5, select Fast.

• Transfer labware between any two teachpoints. Check for the number of 
regrips between teachpoints. Remember that the goal is to minimize the 
number of regrips during transfers.

Related information

For information about... See...

Planning Direct Drive Robot 
teachpoints

“Planning Direct Drive Robot 
teachpoints” on page 60

Using other commands and 
parameters in the Direct Drive 
Robot Diagnostics

“DDR Diagnostics” on page 206

Quick reference of DDR 
Diagnostics commands and 
parameters

“Quick reference” on page 355
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Editing existing Direct Drive Robot teachpoints

When you set a teachpoint for the first time, you might set, verify, and edit  
the teachpoint to make sure the teachpoint is correct. After the teachpoint  
is set up correctly, you will not need to adjust or redefine it unless you do  
the following:

• Move the BioCel System.

• Move or replace one of the devices in the system, such as the robot.

• Adjust settings on the devices.

• Continue to use a robot that has unevenly worn gripper pads.

• Replace the robot gripper pads.

You can edit a teachpoint in one of two ways:

• Adjust the existing teachpoint location by jogging the robot in small 
increments.

• Replace the existing teachpoint with a new teachpoint.

Adjusting the existing teachpoint

Agilent Technologies recommends that you use the teaching jig when  
adjusting teachpoints.

To adjust a teachpoint:

1 Make sure you have followed the procedure in “Verifying Direct Drive Robot 
teachpoints” on page 90 to determine the adjustments that you need to 
make to the teachpoint. For example, the robot is currently too far to the 
left of the teachpoint.

2 Manually place the teaching jig at the teachpoint.

3 In DDR Diagnostics, click the Jog/Move tab, and then select Tool space.

4 In the Move area, select the teachpoint you want to adjust, and then click 
Move to. The robot moves to the selected teachpoint. The robot remains at 
the teachpoint and the grippers are open.

5 Check the position of the robot grippers and the teaching jig. The two pins 
on both sides of the teaching jig should align with the white dimples in the 
grippers.
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6 If the distances between two adjacent pin- dimple pairs are not the same, 
make rotational adjustments. In Tool space, rotate the robot in small 
increments along the Phi- axis. You can also go into Joint space to make 
rotational adjustments.

7 If the dimples on the robot grippers are farther out or closer than the pins 
on the teaching jig (as shown in the following diagram), in Tool space, jog 
the robot in small increments along the y- axis.

8 If the pin- dimple pairs on one side of the teachpoint are closer or farther 
than the pairs on the other side (as shown in the following diagram), in 
Tool space, jog the robot in small increments along the x- axis.

9 If the dimples on the grippers are higher or lower than the pins on the 
teaching jig, decrease or increase the z- axis value.



3   Setting up the Direct Drive Robot
Editing existing Direct Drive Robot teachpoints

104 BioCel System User Guide

10 In the DDR Diagnostics Teachpoints tab, right- click the orientation icon of the 
teachpoint you are editing, and select Update with robot’s current position. The 
teachpoint coordinates are updated.

11 Click Save teachpoints.

12 Return to “Verifying Direct Drive Robot teachpoints” on page 90 to verify 
the revised teachpoint.

Replacing the existing teachpoint

To replace an existing teachpoint:

1 Create a new teachpoint. See “Creating a new teachpoint” on page 74.

2 Set all the parameters for the teachpoint.
                                                        

CAUTION The replacement procedure also replaces all the teachpoint parameter values 
such as the approach height and approach distance.
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3 Drag the new teachpoint and drop it on the existing teachpoint. The 
Replace or Reteach Existing Approaches dialog opens.

4 Click Replace. The existing teachpoint and its parameter values are 
replaced.

Related information

For information about... See...

DDR Diagnostics “Software description” on page 24

Tool space “Jogging the Direct Drive Robot” on 
page 214

Using other commands and 
parameters in the DDR Diagnostics

“DDR Diagnostics” on page 206

Quick reference of DDR 
Diagnostics commands and 
parameters

“Quick reference” on page 355



3   Setting up the Direct Drive Robot
Managing Direct Drive Robot teachpoints

106 BioCel System User Guide

Managing Direct Drive Robot teachpoints

You can rename, copy, or delete existing teachpoints.

Renaming teachpoints

To rename a teachpoint:

1 In the Teachpoints tab, select the teachpoint you want to rename.

2 Double- click the teachpoint name, and then type a new name.

3 Click Save teachpoints to save the changes in the teachpoint file.

Copying teachpoints

You can use a copy of a teachpoint to create a new teachpoint.

To create a copy of a teachpoint:

1 In the Teachpoints tab, click New Teachpoint. A new teachpoint entry appears 
at the bottom of the in the table.

2 Select the teachpoint you want to copy.

3 With the teachpoint selected, Ctrl+drag the teachpoint to the new 
teachpoint entry.

4 Modify the copy to create a new teachpoint.

5 Click Save teachpoints to save the changes in the teachpoint file.

Deleting teachpoints

To delete a teachpoint:

1 In the Teachpoints tab, select one or more teachpoints you want to delete in 
the teachpoints table.

2 Click Delete selections.

3 Click Save teachpoints to save the changes in the teachpoint file.

Related information

For information about... See...

Robot Diagnostics “Software description” on page 24

Using other commands and 
parameters in the DDR Diagnostics

“DDR Diagnostics” on page 206

Quick reference of DDR 
Diagnostics commands and 
parameters

“Quick reference” on page 355
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Cycling teachpoints 

About teachpoint cycling

After you have set and verified each teachpoint, you can have the robot 
transfer labware to and from multiple teachpoints in a cycling pattern as a 
final check. You can select the teachpoints you want to verify and specify the 
sequence in which the transfers will occur. Doing so allows you to check the 
accuracy of the selected teachpoints without having to write or run a protocol.

Cycling sequences

Two types of teachpoint- cycling sequences are available: Sequential, and all 
permutations.

Sequential
In sequential cycling of teachpoints, the robot will transfer labware to the 
selected teachpoints in the order you specify. For example, if you select five 
teachpoints, you can specify the following order:

Note: You can select a teachpoint more than once to transfer labware to that 
location multiple times, as the following example demonstrates.

All permutations
In all- permutations cycling of teachpoints, the robot will transfer robot to the 
selected teachpoints as shown:

Teachpoint 1
Teachpoint 2
Teachpoint 3
Teachpoint 4
Teachpoint 5

Teachpoint 1
Teachpoint 2

Teachpoint 1

Teachpoint 4
Teachpoint 5

Teachpoint 3
Teachpoint 2

Teachpoint 1
Teachpoint 2
Teachpoint 3
Teachpoint 4
Teachpoint 5

Teachpoint 1
Teachpoint 2
Teachpoint 3
Teachpoint 4
Teachpoint 5

Teachpoint 1
Teachpoint 2
Teachpoint 3
Teachpoint 4
Teachpoint 5

Teachpoint 1
Teachpoint 2
Teachpoint 3
Teachpoint 4
Teachpoint 5

Teachpoint 1
Teachpoint 2
Teachpoint 3
Teachpoint 4
Teachpoint 5
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Before you start

Plate stages

IMPORTANT Make sure the device plate stages are extended so that the robot 
can place labware at these teachpoints during cycling. 

The cycling function is a feature of DDR Diagnostics only. During cycling, the 
VWorks software does not send commands to the devices to open device doors 
or extend the plate stages. Therefore, you must use the commands in the 
device diagnostics to move the plate stages into positions before cycling the 
teachpoints. For instructions on how to move the plate stages into position, see 
the device user guide.

Labware lids
Be aware that there will be no sensor feedback during cycling. If an error 
occurs during a delid or relid custom action, the error will not be reported.

Procedure

To transfer labware between multiple teachpoints:

1 In DDR Diagnostics, click the Cycler tab.

2 Click Insert teachpoints. In the Select Teachpoints dialog box that opens:

a Select the teachpoints you want to verify. CRTL+click multiple 
teachpoints to add them simultaneously. 

Note: You can select the same teachpoint more than once to indicate 
that you want to transfer labware to that teachpoint multiple times.

WARNING  Be sure to wear protective eyewear when entering the system and working 
with the robot.

WARNING  Stay out of the system while the robot is in motion.
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b To arrange the order of the teachpoints, select a teachpoint in the list, 
and then select either Insert before or Insert after in the Insertion types list.

3 Click OK to return to the Cycler tab. The selected teachpoints appear in the 
Teachpoints list. They should also be in the order you specified.

4 Review the list in the Teachpoints area. To remove a teachpoint from the 
list, select the teachpoint in the list, and then click Remove teachpoints.

5 Select Pause after if you want to pause the cycling after a specific number 
of cycles. Type the number of cycles after which you want to pause in the 
cycles box.

6 Select All permutations if you want to run that type of cycling sequence. See 
“Cycling sequences” on page 107.

7 Place the labware at the first teachpoint.

8 When you are ready, click Start to begin cycling. Notice that the Start 
button changes to the Pause button.
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During teachpoint cycling, you can:

• Monitor the cycling. To do this, check the number displayed in the Cycle 
count area. You can also view the robot movements in the system or in the 
Robot Status area.

• Pause the cycling. To do this, click Pause. The robot will pause after the 
current pick- and- place action. To resume cycling, click Resume.

• Stop the cycling. To do this, click Stop. The robot will stop after the 
current pick- and- place action.

 

Related information

For information about... See...

Planning Direct Drive Robot 
teachpoints

“Planning Direct Drive Robot 
teachpoints” on page 60

Using other commands and 
parameters in the Direct Drive 
Robot Diagnostics

“Using DDR Diagnostics” on page 135

Quick reference of DDR 
Diagnostics commands and 
parameters

“Quick reference” on page 217
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4
Setting up the 3-Axis Robot

This chapter explains how to set up the 3- Axis Robot for 
operation. This chapter contains the following topics:

• “Setup Workflow” on page 112

• “Creating and managing 3- Axis Robot profiles” on page 113

• “Setting 3- Axis Robot teachpoints” on page 117

• “Verifying 3- Axis Robot teachpoints” on page 124

• “Editing existing 3- Axis Robot teachpoints” on page 127

• “Renaming 3- Axis Robot teachpoints” on page 128

Note: If the BioCel System has a Direct Drive Robot, see “Setting 
up the Direct Drive Robot” on page 45. If the BioCel System has a 
KiNEDx Robot, see “Setting up the KiNEDx Robot” on page 129. If 
the BioCel System has a Staubli robot, see the Staubli TX60 Device 
Driver User Guide.

http://www.chem.agilent.com/Library/usermanuals/Public/G5415-90049_DDUG_EN.pdf
http://www.chem.agilent.com/Library/usermanuals/Public/G5415-90049_DDUG_EN.pdf
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Setup Workflow

About this topic

This topic presents the workflow for setting up the 3- Axis Robot for operation.

Workflow

The following table presents the steps for setting up the 3- Axis Robot. After 
setting up the 3- Axis Robot for the first time, you will not likely change any of 
the settings in the procedure unless you add a device, replace a device, or 
move the BioCel System.

IMPORTANT Before proceeding to step 2 (setting teachpoints), you should 
already have definitions for the labware you want to use. Although you can 
define labware at any time, Agilent Technologies recommends that you define 
labware before setting up the BioCel System. For instructions on how to define 
labware, see the VWorks Automation Control Setup Guide.

Related information

Step For this task... See...

1 Add the 3- Axis Robot to the 
device file.

“Adding and deleting devices in the 
software” on page 39

2 Create a profile for the 3- Axis 
Robot.

“Creating and managing 3- Axis 
Robot profiles” on page 113 

3 Set teachpoints for integrated 
devices.

“Setting 3- Axis Robot teachpoints” 
on page 117

4 Verify the teachpoints. “Verifying 3- Axis Robot 
teachpoints” on page 124

5 Edit the teachpoints. • “Editing existing 3- Axis Robot 
teachpoints” on page 127

• “Renaming 3- Axis Robot 
teachpoints” on page 128

6 Perform dry run. “Performing dry runs” on page 153

For information about... See...

Operating the BioCel System “Checking for system readiness” on 
page 166

Troubleshooting problems “Maintenance and troubleshooting” on 
page 173
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Creating and managing 3-Axis Robot profiles

About this topic

The BioCel System computer is set up with the correct profiles to 
communicate with the 3- Axis Robot and integrated devices. You do not need to 
create new profiles unless you want to set up unique communication settings 
or use a different teachpoint file. When you integrate a new device in the 
BioCel System, you will need to create a new profile for that device. 

This topic explains how to create a new profile for the 3- Axis Robot and how 
to manage existing profiles. For instructions on how to create the profiles for 
Agilent Technologies devices, see the device user documentation. For 
instructions on how to create profiles for third- party devices, see the device 
driver user guide.

Profiles

IMPORTANT Each device you integrate in the BioCel System requires a 
unique profile.

A profile is a collection of settings, stored in the Windows registry, that 
manages how you connect to a device. A profile:

• Specifies the port used to establish communication between the device and 
the controlling computer.

• References a teachpoint file. For a description of teachpoint files, see 
“Setting 3- Axis Robot teachpoints” on page 117.

You use the 3- Axis Robot Diagnostics software to create and manage profiles.

Note: The profile is referenced by a device file. For information about device 
files, see “Adding and deleting devices in the software” on page 39. For a 
detailed description of the relationships between the device file, profile, and 
teachpoint file, see the VWorks Automation Control User Guide.

Creating a 3-Axis Robot profile 

To create a 3-Axis Robot profile:

1 In the Devices area, select the 3- Axis Robot name, and then click Device 
diagnostics.
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The 3- Axis Robot Diagnostics dialog box opens.

2 Click the Profiles tab.

3 In the Profile Management area, click Create a new profile. The Create Profile 
dialog box opens.

4 Type a name, and click OK. The name appears in the Profile Management 
area.

5 In the Profile Settings area, set or select the following:
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Parameter or option Description

Robot COM port The serial port that connects the 
controlling computer to the robot.

BCR COM port The serial port that connects the robot 
barcode reader to the controlling 
computer.

Gripper open delay (ms) The length of time, in milliseconds, that 
the robot waits after the grippers start 
to open. 

An optimum value allows the robot to 
fully release the labware before moving 
to the next destination. A lower- than-
optimum value causes the robot to drag 
the labware from its current location 
before releasing it at an unintended 
location.

Gripper close delay (ms) The length of time, in milliseconds, that 
the robot waits after the grippers start 
to close.

An optimum value allows the robot to 
pick up the labware at the correct 
height before moving to the next 
destination. A lower- than- optimum value 
causes the robot to hold the labware 
higher than the specified height.

Retry pushdown (mm) The distance, in millimeters, that the 
robot will push down on a labware after 
the absence of vacuum is detected at a 
vacuum filtration station, vacuum 
platepad, and vacuum shelf. The 
pressing down on the labware against 
the station, platepad, or shelf can help 
ensure a vacuum seal.
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6 Click Update this profile to save the changes.

7 Click OK to return to the VWorks software window.

8 If you are setting up the BioCel System for the first time or if you are 
creating a new device file, return to “Adding and deleting devices in the 
software” on page 39 and continue from step 3.

Managing existing profiles

In the 3- Axis Robot Diagnostics Profile tab, you can select an existing profile, 
and then copy, rename, or delete the profile.

Related information

Record serial history on 
servo errors

The option that enables the software to 
record the robot communication 
messages to a log file when a servo 
error occurs. The log file can be used to 
troubleshoot the system.

Max lines in history The maximum number of lines to record 
in the serial history file.

The parameter is available only when 
the Record serial history on servo errors 
option is selected.

Path to history file The folder in which the history file is 
stored.

Parameter or option Description

For information about... See...

Adding a device in the VWorks 
software

“Adding and deleting devices in the 
software” on page 39

Setting teachpoints “Setting 3- Axis Robot teachpoints” on 
page 117
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Setting 3-Axis Robot teachpoints

About this topic

The BioCel System is set up with the correct teachpoints to enable the robot 
to move to the correct locations during a protocol run. You do not need to add 
or modify the existing teachpoint file unless you:

• Integrate a new device in the BioCel System.

• Move the BioCel System.

• Move or replace one of the devices in the system.

• Adjust settings on the devices.

Depending on the type of device, the teachpoint setting procedure can vary.

This topic provides basic teachpoint setting concepts: what teachpoints are and 
how to use teaching jigs to set, verify, and edit 3- Axis Robot teachpoints. 
Always contact Automation Solutions Technical Support when you want to 
integrate a new device.

For information about device teachpoints, see the device user guide.

Robot teachpoints

A robot teachpoint is a set of coordinates that define where the robot picks up 
or places labware. The location can be on an integrated device or a platepad. 
Teachpoints are relative to the robot home position.

You set, edit, and save teachpoints in 3- Axis Robot Diagnostics.



4   Setting up the 3-Axis Robot
Setting 3-Axis Robot teachpoints

118 BioCel System User Guide

Teachpoint files

The 3- Axis Robot Teachpoints are saved in a text file. The default teachpoint 
file is created by Agilent Technologies and is stored in C:\Program 
Files\Agilent Technologies\VWorks\Teachpoints. However, you can select 
another location when saving the file.

You can have multiple teachpoint files for each BioCel System if a device needs 
to serve multiple purposes. For example, a platepad can be taught as a 
platepad or as a regripping station. You can also have multiple teachpoint files 
for the system if a device is only used in some protocols but not others. For 
example, if a device is installed on a mobile device table and can be removed 
when it is not in use.

The teachpoint file is referenced by a profile. For information about profiles, 
see “Creating and managing 3- Axis Robot profiles” on page 113.

Workflow

The workflow for setting a 3- Axis Robot teachpoint is as follows:

Before you start

Make sure:

• You have the provided 3- Axis Robot teaching jig.

• The correct profile is initialized (“Creating and managing 3- Axis Robot 
profiles” on page 113).

• The safety interlock is turned off (“Power panel” on page 7).

CAUTION Always edit and manage teachpoints in the Robot Diagnostics software. Do not 
edit the teachpoint file (text file) directly. In the text file, the teachpoints are in a specific order. 
Changing the order can cause the robot to move to incorrect locations and bump into devices 
or other obstacles.

CAUTION Before you begin changing teachpoints, make a backup copy of the teachpoint 
file. If the original file becomes lost or damaged, you can use the backup copy instead of 
resetting all the teachpoints.

Step For this task See...

1 Set a new teachpoint. “Setting new teachpoints” on 
page 119

2 Verify the teachpoint. “Verifying 3- Axis Robot teachpoints” 
on page 124

3 Edit the existing 
teachpoint.

“Editing existing 3- Axis Robot 
teachpoints” on page 127
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Setting new teachpoints 

Before you start, place the teaching jig at the location that will be taught (for 
example, platepad, plate stage, or device shelf). Make sure the teaching jig tab 
is on the side facing the robot.

To set a teachpoint:

1 In the Devices area, select the 3- Axis Robot name, and then click Device 
diagnostics.

The 3- Axis Robot Diagnostics dialog box opens.
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2 Click the Controls tab.

3 In the Teach/Process area, click Add new point. The New Teachpoint dialog 
box opens.

4 Type a name for the new teachpoint, and then click OK. The new 
teachpoint name appears in the Position 1 and Position 2 boxes.

5 Turn off the robot r- axis and t- axis motors. To do this, in the Servo Control 
area, select R & T servos off. The z- axis motor remains enabled.

6 Manually move the robot to the teachpoint location. If you need to change 
the robot height to reach the location, in the Position Control area:

a Type the Jog Increment you want to use.

b Click Down or Up to move the robot down or up.

When you move the robot, check its coordinates in the Position Control area. 
If the t- axis value is negative, rotate the robot arm 360° so that the t- axis 
value becomes positive.

7 Position the robot and its grippers as follows:

• The top of the teaching jig tab should be level with the top of the robot 
grippers (A). In addition, the back of the teaching jig tab should be in 
contact with the front of the robot grippers (B).
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• The teaching jig should be centered between the robot grippers.

8 If the teachpoint location has high walls or other structures that prevent 
the robot from holding the teaching jig at the correct height during pickup, 
type the height difference in the Regrip offset (mm) box that corresponds to 
Position 1.

• If the top of the gripper is higher than the top of the teaching jig tab 
(A), type a positive value for the height difference.

• If the top of the gripper is lower than the top of the teaching jig tab 
(B), type a negative value for the height difference.
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Note: After you teach the robot this location, install a new platepad in 
the BioCel System and designate its teachpoint as the regrip station. In 
a protocol, if the pick location and the place location have different 
regrip offset values, the system will automatically place the labware at 
the regrip station between the pick and place tasks to correct the grip 
height. You need to teach the robot the regrip station platepad. In 
addition, that platepad can only be used for regripping.

9 In the Approach ht. (mm) box that corresponds to Position 1, type the 
approach height you want to use. The default value is 9 mm.

The approach height is the height clearance (in millimeters) the robot must 
maintain above the teachpoint as it:

• Moves towards the teachpoint to place labware. Use this parameter if 
raised tabs or walls at the front of the teachpoint might obstruct the 
robot.

• Moves away from the teachpoint after picking up labware. Use this 
parameter if raised tabs or walls at the front of the teachpoint might 
obstruct the robot.

• Moves to and from the teachpoint when the Drop into position option is 
selected. Use this parameter if raised tabs or walls at the sides of the 
teachpoint do not obstruct but might be in contact with the robot 
grippers during labware pickup or placement.

You can reduce the approach height to prevent collision with shelves or 
other obstacles above the teachpoint.

Agilent Technologies recommends that you set Approach ht at 9 mm. For 
tipboxes on a Vertical Pipetting Station shelf, set Approach ht at 6 mm. 
Because the Centrifuge has a short opening, set Approach ht at 5.5 mm. 
For the Plate Hotel and Plate Hub Carousel, set Approach ht at 7 mm.

10 At Position 1, click Teach point here to set the teachpoint. In the confirmation 
dialog box that appears, click Yes to confirm the new teachpoint setting.

11 (Optional) Select Drop into position if you want the robot to maintain the 
specified approach height as it picks up and places labware during a 
protocol run. Use this option if the teachpoint has raised tabs or walls at 
the sides that might obstruct the robot grippers.

12 Click Apply to save the teachpoint information to the teachpoint file.

13 Manually move the robot to the safe zone, and then remove the teaching jig 
from the new teachpoint.

14 Turn on the robot r- axis and t- axis motors. To do this, in the Servo Control 
area, select R & T servos on.

CAUTION Incorrect approach heights can cause the robot to crash into obstacles.
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Related information

For information about... See...

Robot Diagnostics “Software description” on page 24

Using other commands and 
parameters in the 3- Axis Robot 
Diagnostics

“3- Axis Robot Diagnostics” on page 229

Quick reference of 3- Axis Robot 
Diagnostics commands and 
parameters

“Quick reference” on page 355
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Verifying 3-Axis Robot teachpoints

After you set a new teachpoint, you should verify that it is accurate. During 
the verification procedure, you will check that the robot is able to:

• Go to the teachpoint and is positioned correctly at the teachpoint.

• Place labware correctly at the teachpoint.

Moving the robot to the new teachpoint

You use the Move to point software command to verify that the robot is 
positioned correctly at the location. Do not use the Move to point command to 
check the approach height, because the Move to point command does not use 
the approach height parameter.

IMPORTANT If the teachpoint requires the Drop into position option, skip 
this verification step and proceed to place the labware at the teachpoint.

To move the robot to the teachpoint:

1 Remove obstacles in the path of the robot.

2 Place the teaching jig at the teachpoint. Make sure the teaching jig tab is 
on the side facing the robot.

3 Make sure the robot is not holding labware and the grippers are open. To 
open the grippers, in the Position Control area, click Open Gripper.

4 In the Teach/Process area, select the new teachpoint in the Location 1 list.

5 In the Robot speed area, select Slow.

6 In the Teach/Process area, clear the check box for Drop into position.

7 Click the Position 1 Move to point button.

The robot moves to the new teachpoint. The robot remains at the 
teachpoint and the grippers are open.

8 Make sure the robot grippers are positioned as instructed in “Setting new 
teachpoints” on page 119 (step 7 or step 8). If the robot grippers are not 
positioned correctly, proceed to “Editing existing 3- Axis Robot teachpoints” 
on page 127.

9 If the robot is positioned correctly at the teachpoint, home the robot. To do 
this, in the Position Control area, click Move to rest position. 

10 Remove the teaching jig from the teachpoint.
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Placing labware at the new teachpoint

To ensure that the teachpoint is accurate, you need to pick up labware from a 
reference teachpoint (platepad 1, an existing teachpoint that has been verified 
to be accurate) and place it at the new teachpoint. Incorrectly placed labware 
indicates that the teachpoint coordinates are incorrect.

To place labware at a reference teachpoint:

1 Remove obstacles in the path of the robot.

2 Place the desired labware at the reference teachpoint (platepad 1).

3 In the 3-Axis Robot Diagnostics Labware Settings area, select the labware you 
are using.

4 In the Robot Speed area, select Slow.

5 In the Teach/Process area:

a Select the newly created teachpoint in the Position 1 list.

b Select platepad1 in the Position 2 list.

6 If the teachpoint does not require Drop into position, in the Teach/Process 
area, clear the check box for Drop into position.

7 In the Teach/Process area, click Pick & Place 2 -> 1. The robot picks up the 
labware from the reference teachpoint (Location 2) and places it at the 
new teachpoint (Location 1).

8 Check that the robot does not hit raised walls or other structures as it 
approaches the teachpoint. If it does, proceed to “Editing existing 3- Axis 
Robot teachpoints” on page 127.

9 Check the placement of the labware at the teachpoint. If the labware is 
placed incorrectly, proceed to “Editing existing 3- Axis Robot teachpoints” 
on page 127. Depending on the placement, make one or more of the 
following adjustments:

• If the labware is placed farther out or closer to the robot than it 
should (as shown in the following diagram), adjust the r- axis value in 
3- Axis Robot Diagnostics. Decrease the r- axis value slightly so that the 
robot will place the labware closer to the front of its grippers (A). 
Increase the r- axis value so that the robot will place the labware 
farther from the front of its grippers.
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• If the labware is placed too far to the right or left (as shown in the 
following diagrams), adjust the t- axis value in 3- Axis Robot 
Diagnostics. Decrease the t- axis value to move the robot and labware to 
the left (A). Increase the t- axis value to move the robot and labware to 
the right (B).

• If the labware is dropped onto the teachpoint, decrease the z- axis 
value so that the robot will place the labware onto the teachpoint.

• If the labware is pressed onto the teachpoint, increase the z- axis value 
so that the robot will gently place the labware onto the teachpoint.

10 If the labware is placed correctly, in the Position Control area, click Move to 
rest position, and then remove the labware from the teachpoint.

You can repeat the procedure in this section to pick up labware from the new 
teachpoint and place it at the reference teachpoint. At step 7, in the Teach/
Process area, click Pick & Place 1 -> 2.

As a final check, repeat the procedure in this section to pick up and place 
labware at the Fast robot speed. At step 4, select Fast in the Robot Speed area.

Related information

For information about... See...

Robot Diagnostics “Software description” on page 24

Using other commands and 
parameters in the 3- Axis Robot 
Diagnostics

“3- Axis Robot Diagnostics” on page 229

Quick reference of 3- Axis Robot 
Diagnostics commands and 
parameters

“Quick reference” on page 355
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Editing existing 3-Axis Robot teachpoints

When you set a teachpoint for the first time, you will likely set, verify, and edit 
the teachpoint a number of times to make sure the teachpoint is correct. After 
the teachpoint is set up correctly, you will not need to adjust or redefine it 
unless you do the following:

• Move the BioCel System.

• Move or replace one of the devices in the system.

• Adjust settings on the devices.

To edit a robot teachpoint:

1 Make sure you have followed the procedure in “Verifying 3- Axis Robot 
teachpoints” on page 124 to determine the adjustments that you need to 
make to the teachpoint. For example, the robot is currently too far to the 
left of the teachpoint.

2 In the Diagnostics tab, verify that the correct teachpoint file is loaded. To do 
this, in the Teachpoint file area, check the file path.

3 In the Teach/Process area, make sure the teachpoint you want to edit is 
selected in the Position 1 list.

4 With either the teaching jig or labware at the teachpoint, edit the 
teachpoint using one or both of the following methods:

• In the Position Control area, use the jog command buttons to move the 
robot to the correct location, and set the teachpoint.

• Follow the instructions in “Setting new teachpoints” on page 119 to 
manually move the robot to the correct location, and set the 
teachpoint.

5 Click Apply to save the revised teachpoint in the teachpoint file.

Related information

For information about... See...

Robot Diagnostics “Software description” on page 24

Using other commands and 
parameters in the 3- Axis Robot 
Diagnostics

“3- Axis Robot Diagnostics” on page 229

Quick reference of 3- Axis Robot 
Diagnostics commands and 
parameters

“Quick reference” on page 355



4   Setting up the 3-Axis Robot
Renaming 3-Axis Robot teachpoints

128 BioCel System User Guide

Renaming 3-Axis Robot teachpoints

To rename a teachpoint:

1 In the Robot Diagnostics Teach/Process area, select the teachpoint you want 
to rename in the Location 1 list.

2 Click Rename point 1. The Rename teachpoint dialog box opens.

3 Type a new name for the teachpoint, and then click OK to return to the 
Diagnostics tab.

4 Click Apply to save the new teachpoint name in the teachpoint file.

Related information

For information about... See...

Robot Diagnostics “Software description” on page 24

Using other commands and 
parameters in the 3- Axis Robot 
Diagnostics

“3- Axis Robot Diagnostics” on page 229

Quick reference of 3- Axis Robot 
Diagnostics commands and 
parameters

“Quick reference” on page 355
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5
Setting up the KiNEDx Robot

This chapter explains how to set up the KiNEDx Robot for 
operation. This chapter contains the following topics:

• “Setup Workflow” on page 130

• “Creating and managing KiNEDx Robot profiles” on page 131

• “Setting KiNEDx Robot teachpoints” on page 135

• “Verifying KiNEDx Robot teachpoints and waypoints” on 
page 143

• “Editing KiNEDx Robot teachpoints and waypoints” on 
page 149

Note: If the BioCel System has a Direct Drive Robot, see “Setting 
up the Direct Drive Robot” on page 45. If the BioCel System has a 
3- Axis Robot, see “Setting up the 3- Axis Robot” on page 111. If the 
BioCel System has a Staubli robot, see the Staubli TX60 Device 
Driver User Guide.

http://www.chem.agilent.com/Library/usermanuals/Public/G5415-90049_DDUG_EN.pdf
http://www.chem.agilent.com/Library/usermanuals/Public/G5415-90049_DDUG_EN.pdf
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Setup Workflow

About this topic

This topic presents the workflow for setting up the KiNEDx Robot for 
operation.

Workflow

The following table presents the steps for setting up the KiNEDx Robot. After 
setting up the KiNEDx Robot for the first time, you will not likely change any 
of the settings in the procedure unless you add a device, replace a device, or 
move the BioCel System.

IMPORTANT Before proceeding to step 2 (setting teachpoints), you should 
already have definitions for the labware you want to use. Although you can 
define labware at any time, Agilent Technologies recommends that you define 
labware before setting up the BioCel System. For instructions on how to define 
labware, see the VWorks Automation Control Setup Guide.

Related information

Step For this task... See...

1 Add the KiNEDx Robot to the 
device file.

“Adding and deleting devices in the 
software” on page 39

2 Create a profile for the 
KiNEDx Robot.

“Creating and managing KiNEDx 
Robot profiles” on page 131

3 Set and edit teachpoints for 
integrated devices.

“Setting KiNEDx Robot teachpoints” 
on page 135

4 Verify the teachpoints. “Verifying KiNEDx Robot 
teachpoints and waypoints” on 
page 143

5 Edit the teachpoints. “Editing KiNEDx Robot teachpoints 
and waypoints” on page 149

6 Perform dry run. “Performing dry runs” on page 153

For information about... See...

Operating the BioCel System “Checking for system readiness” on 
page 166

Troubleshooting problems “Maintenance and troubleshooting” on 
page 173
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Creating and managing KiNEDx Robot profiles

About this topic

The BioCel System computer is set up with the correct profiles to 
communicate with the KiNEDx Robot and integrated devices. You do not need 
to create new profiles unless you want to set up unique communication 
settings or use a different teachpoint file. When you integrate a new device in 
the BioCel System, you will need to create a new profile for that device. 

This topic explains how to create a new profile for the KiNEDx Robot and how 
to manage existing profiles. For instructions on how to create the profiles for 
Agilent Technologies devices, see the device user documentation. For 
instructions on how to create profiles for third- party devices, see the device 
driver user guide.

Profiles

IMPORTANT Each device you integrate in the BioCel System requires a 
unique profile.

A profile is a collection of settings, stored in the Windows registry, that 
manages how you connect to a device. A profile:

• Specifies the port used to establish communication between the device and 
the controlling computer.

• References a teachpoint file. For a description of teachpoint files, see 
“Setting KiNEDx Robot teachpoints” on page 135.

You use the Robot Diagnostics software to create and manage profiles.

Note: The profile is referenced by a device file. For information about device 
files, see “Adding and deleting devices in the software” on page 39. For a 
detailed description of the relationships between the device file, profile, and 
teachpoint file, see the VWorks Automation Control User Guide.

Creating a KiNEDx Robot profile 

This section explains how to create a profile if the BioCel System uses the 
KiNEDx Robot.

To create a KiNEDx Robot profile:

1 In the Devices area, select the KiNEDx Robot name, and then click Device 
diagnostics. 
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The KiNEDx Robot Driver Diagnostics dialog box opens.

2 Click the Profiles tab.

3 In the Profile Management area, click Create a new Profile. The Create Profile 
dialog box opens.

4 Type a name and click OK. The name appears in the Profile Management 
area.

5 In the Initialization Files area, locate and select the following:
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6 Below the Initialization Files area, click Create new waypoints file.

7 In the dialog box that opens, type the following name for the waypoints 
file: Waypointsnnnn. The nnnn is the robot serial number. Save the file in 
the C:\Program Files\Agilent Technologies\VWorks\Teachpoints\ folder. 
Make sure the file path is displayed in the Initialization Files area.

8 Below the Speed Definitions area, select Check plate sensor after plate pickup.

9 In the Profile Management area, click Update this profile.

10 At the front of the KiNEDx Robot, turn on Z- Brake Normal Override (press 
the switch to the on or I position). The red light next to the switch turns 
off.

Turning on the Z- Brake Normal Override prevents the robot from dropping 
down along the z- axis.

.ini file Description

Parameters file The file that contains the robot home 
coordinates and other data.

The file is named Parametersnnnn.ini 
(where nnnn is the robot serial number). 
By default, the file is located in the 
following folder:

C:\Program Files\Agilent 
Technologies\VWorks\Teachpoints\.

Teachpoints file The file that contains the robot 
teachpoints.

The file is named Teachpointsnnnn.ini 
(where nnnn is the robot serial number). 
By default, the file is located in the 
following folder:

C:\Program Files\Agilent 
Technologies\VWorks\Teachpoints\.
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11 Move the robot arm to a safe area so that it will not bump against 
obstacles as it moves during initialization.

12 In the Profile Management area of the KiNEDx Robot Driver Diagnostics 
dialog box, click Initialize this profile. The robot moves briefly as it initializes.

13 Click Update this profile to save the changes. 

14 Click OK to return to the VWorks software window.

15 If you are setting up the BioCel System for the first time or if you are 
creating a new device file, return to “Adding and deleting devices in the 
software” on page 39 and continue from step 3.

Managing existing profiles

In the KiNEDx Robot Driver Diagnostics Profile tab, you can select an existing 
profile, and then rename, copy, or delete the profile.

Related information

For information about... See...

Adding a device in the VWorks 
software

“Adding and deleting devices in the 
software” on page 39

Setting teachpoints “Setting KiNEDx Robot teachpoints” on 
page 135
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Setting KiNEDx Robot teachpoints

About this topic

The BioCel System is set up with the correct teachpoints to enable the robot 
to move to the correct locations during a protocol run. You do not need to add 
or modify an existing teachpoint file unless you:

• Integrate a new device in the BioCel System.

• Move the BioCel System.

• Move or replace one of the devices in the system.

• Adjust settings on the devices.

Depending on the type of device, the teachpoint setting procedure can vary.

This topic provides basic teachpoint setting concepts: what teachpoints and 
waypoints are, and how to use teaching jigs to set, verify, and edit KiNEDx 
Robot teachpoints. Always contact Automation Solutions Technical Support 
when you want to integrate a new device.

For information about device teachpoints, see the device user guide.

Robot teachpoints and waypoints

A robot teachpoint is a set of coordinates that define where the robot picks up 
or places labware. The location can be on an integrated device or a platepad. 
Teachpoints are relative to the robot home position.

For each teachpoint, the KiNEDx Robot uses at least one waypoint to arrive at 
the teachpoint. A waypoint is a set of coordinates that define a location the 
robot passes through on its way to a teachpoint. Having multiple waypoints per 
teachpoint enable the robot to:

• Move around obstacles that are in a direct path to a teachpoint.

• Maneuver around obstacles in tight spaces.

The following diagram shows examples of waypoints (WP) and teachpoints 
(TP).

TP
WP1

Device

WP3
WP4

WP6

WP2

WP5
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You set, edit, and save teachpoints and waypoints in KiNEDx Robot Driver 
Diagnostics.

Teachpoint and waypoint files

The KiNEDx Robot Teachpoints are saved in a text file with the .ini file name 
extension. The default teachpoint file is created by Agilent Technologies and is 
stored in C:\Program Files\Agilent Technologies\VWorks\Teachpoints\. 
However, you can select another location when saving the file.

The waypoints are saved in the XML format with the .wpt file name extension. 
You create a new waypoint file when you create a new profile. For 
instructions, see “Creating and managing KiNEDx Robot profiles” on page 131.

You can have multiple teachpoint files for the BioCel System if a device is only 
used in some protocols but not others. For example, if a device is installed on 
a mobile device table and can be removed when it is not in use.

The teachpoint and waypoint files are referenced by a profile. For information 
about profiles, see “Creating and managing KiNEDx Robot profiles” on 
page 131.

CAUTION Always edit and manage teachpoints in the KiNEDx Robot Driver Diagnostics 
software. Do not edit the teachpoint file (text file) or the waypoint file (XML file) directly. In the 
text file, the teachpoints are in a specific order. Changing the order can cause the robot to 
move to incorrect locations and bump into devices or other obstacles.

CAUTION Before you begin changing teachpoints and waypoints, make backup copies of 
the teachpoint and waypoint files. If the original files become lost or damaged, you can use 
the backup copies instead of resetting all the teachpoints and waypoints.
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Workflow

The workflow for setting KiNEDx Robot teachpoints and waypoints is as 
follows:

Before you start

Make sure:

• You have the provided KiNEDx Robot teaching jig.

• The correct profile is initialized (“Creating and managing KiNEDx Robot 
profiles” on page 131).

• The safety interlock is turned off (“Power panel” on page 7).

Setting new teachpoints and waypoints 

To set a teachpoint:

1 Place the teaching jig on the platepad, plate stage, or device shelf you want 
to teach the robot. Make sure the teaching jig shelves face the robot.

2 In the VWorks window, select the KiNEDx Robot name in the Devices area, 
and then click Device diagnostics. 

Step For this task See...

1 Set a new teachpoint and 
associated waypoints.

“Setting new teachpoints and 
waypoints” on page 137

2 Verify the teachpoints. “Verifying KiNEDx Robot teachpoints 
and waypoints” on page 143

3 Edit existing teachpoints. “Editing KiNEDx Robot teachpoints 
and waypoints” on page 149
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The KiNEDx Robot Driver Diagnostics dialog box opens.

3 Click Launch Peak KiNEDx teach GUI. The KiNEDx Robot Teach Pendant window 
appears and displays the Teach Points tab.

4 Turn off the robot wrist, elbow, and shoulder motors. To do this, in the 
Move Controls area, select Disable Motors for Teaching.

5 Manually move the robot to the teachpoint or waypoint. 

If you need to change the robot height to reach the location, in the Move 
Controls area, clear the Disable Motors for Teaching check box to turn on the 
robot motors. Click the Jog Controls tab. In the Joint area, click the Z up or 
down button to move the robot up or down.

6 Jog the robot to fine- tune the waypoint or teachpoint. To jog the robot in 
small increments:
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a In the Teach Points tab, clear the Disable Motors for Teaching check box to 
turn on the robot motors. 

b In the Jog Controls tab, use either or both of the following:

• In the Joint area, click an arrow to move the robot wrist, elbow, 
or shoulder. You can also change the robot height. Instead of 
clicking the arrows, you can type a precise coordinate for the 
joint movement.

• In the Cartesian area, select the axis along which you want the 
robot to move, and then click an arrow or type a precise 
coordinate for the movement. In the Jog Step (deg or mm) box, set 
the jog increment in millimeters or degrees.

7 Position the robot and its grippers as follows:

• The teaching- jig shelves should be in contact with the front of the 
robot grippers (1).

• The top of the teaching- jig wing should be level with the top of the 
robot gripper wing (2).

• The teaching jig should be centered between the robot grippers.

00287
KRobot teachplate
00287
KRobot teachplate

1

2
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8 Click the Teach Points tab. In the Teach Points area, name the teachpoint or 
waypoint you are setting. To do this:

a In the Point list, select an unused number, and then click Rename. The 
New Teachpoint dialog box opens.

b Type a name for the teachpoint or waypoint, and then click OK. The 
new teachpoint or waypoint name appears in the Point list. 

Assign names that will help identify the teachpoint. For example, if the 
teachpoint is a platepad, type Platepad n, where n indicates the specific 
platepad on the table. A waypoint for platepad n can be named Platepad n 
Waypoint m, where m indicates the specific waypoint in the sequence of 
waypoints.

The following diagram shows how the teachpoint and waypoints should be 
numbered in the diagnostics software. Notice that the waypoint number 
increases as the robot approaches the home position.

9 In the Move Controls area, double- click in the Shoulder Position, Z Position, Elbow 
Position, and Wrist Position boxes to display the robot’s current coordinates.

CAUTION Do not reorder the teachpoint or waypoints using the arrow buttons or by 
editing the teachpoint file. Doing so can result in robot crashes.

1: TP
2: WP1

Device

4: WP3
5: WP4

7: WP6

3: WP2

6: WP5
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10 In the Teach Points area, click Teach. In the confirmation dialog box that 
appears, click OK. The new teachpoint or waypoint is saved in the 
teachpoint file.

11 Manually move and jog the robot to the next point you want to set, and 
then repeat steps 8 through 10 to set the point.

You do not need to create a waypoint at a location directly above the 
teachpoint. You can specify the height clearance in a later step.

The first waypoint should provide clearance between the teachpoint and 
the robot grippers. To create the first waypoint, move the robot towards its 
home position such that the grippers are clear of the edge of the 
teachpoint.

12 Close the KiNEDx Robot Teach Pendant window.

13 Home the robot. To do this, in the KiNEDx Robot Driver Diagnostics dialog box, 
click Rehome.

TP

70 mm



5   Setting up the KiNEDx Robot
Setting KiNEDx Robot teachpoints

142 BioCel System User Guide

14 Click the Waypoints tab. The list of teachpoint and waypoints appear in the 
table.

15 For each point in the To reach this point column:

a Select the point that precedes it in the Must go to this point first column. For 
the terminal waypoint (the point closest to the home position), select 
Retract to move the robot into the safe zone.

b Select the speed at which to approach the point in the At this speed 
column.

c Select the check box in the Using offset column to have the robot use 
the device approach height specified in the device file. Doing so allows 
the robot to approach the teachpoint at the correct clearance height.

Note: The check box is not available for terminal waypoints (points 
closest to the home position).

The following example shows how to link the teachpoint, the point above 
the teachpoint, and the waypoints.

Related information

For information about... See...

KiNEDx Robot Driver Diagnostics 
description

“Software description” on page 24

Using other commands and 
parameters in the KiNEDx Robot 
Driver Diagnostics 

“KiNEDx Robot Driver Diagnostics” on 
page 237

Quick reference of KiNEDx Robot 
Driver Diagnostics commands and 
parameters

“Quick reference” on page 355
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Verifying KiNEDx Robot teachpoints and waypoints

After you set a teachpoint and corresponding waypoints, you should verify that 
they are accurate. During the verification procedure, you will check that the 
robot is able to:

• Move to any point.

• Move between any two points.

• Move labware between two teachpoints.

Moving to a waypoint or teachpoint

When you move a robot to a new waypoint or teachpoint, you can check that 
the robot is moving through the waypoints in the specified order. In addition, 
you can verify that the robot is positioned correctly at the teachpoint.

Agilent Technologies recommends that you verify each waypoint, starting from 
the waypoint closest to the robot home position. Repeat the verification 
procedure by moving the robot to the adjacent waypoint until you arrive at the 
teachpoint. Doing so allows you to find and correct any missing or incorrect 
waypoint links in the Waypoints tab.

To move the robot to a waypoint or teachpoint:

1 Remove obstacles in the path of the robot.

2 Make sure the robot is not holding labware and the grippers are open. To 
open the grippers, in the KiNEDx Robot Driver Diagnostics Controls tab, click 
Open gripper.

3 In the Robot speed list, select Slow.

4 In the Simple Move area, set the parameters:
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5 In the Simple Move area, click Move. The robot moves from its current 
position to the selected waypoint or teachpoint. It pauses briefly at all the 
waypoints that precede the selected waypoint or teachpoint. The robot 
remains at the selected waypoint or teachpoint, and the grippers are open.

6 Proceed to “Editing KiNEDx Robot teachpoints and waypoints” on page 149 
if:

• The robot skips a waypoint on its way to the selected waypoint or 
teachpoint. You need to locate and add the missing waypoint link in 
the waypoints file.

• The robot moves through the waypoints in the incorrect sequence. You 
need to check the sequence of waypoints and make sure the links are 
correct.

• The robot arrives at the teachpoint but is not positioned as described 
in “Setting new teachpoints and waypoints” on page 137 (step 7). You 
need to correct the robot and gripper position.

List or parameter Description

Teachpoint The list of teachpoints in the teachpoint 
file.

Select the teachpoint you want to verify.

Departure height The height clearance, in millimeters, that 
the robot must maintain above the 
teachpoint as it moves away from the 
teachpoint.

Set Departure height at the value you 
specified for the device Approach height. 
You can find the device Approach Height 
value in the Device Properties area of the 
VWorks software.

Arrival height The height clearance, in millimeters, that 
the robot must maintain above the 
teachpoint as it moves toward it.

Set Arrival height at the value you 
specified for the device Approach height. 
You can find the device Approach Height 
value in the Device Properties area of the 
VWorks software.

Offset Set Offset at 0.
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7 If the waypoints are not missing, the waypoints are in the correct 
sequence, and the robot is positioned correctly at the teachpoint:

a Turn off the robot motors. To do this, click Launch Peak KiNEDx teach GUI. 
In the KiNEDx Robot Teach Pendant dialog box, click the Teach Points tab. In 
the Move Controls area, select Disable Motors for Teaching.

b Manually move the robot back to its home position or in the safe zone.

Alternatively, you can home the robot (click Rehome) as long as no 
obstacles or shelves are in the straight- line path of the robot to its home 
position. When rehoming, the robot moves directly back to the home 
position without moving through the specified waypoints.

Moving labware between teachpoints

To ensure that the teachpoint is accurate, you need to pick up labware from a 
reference teachpoint (platepad 1, an existing teachpoint that has been verified 
to be accurate) and place it at the new teachpoint. Incorrectly placed labware 
indicates that the teachpoint coordinates are incorrect.

Agilent Technologies recommends that you use this method instead of the 
Simple Move method when verifying the robot is able to move labware between 
teachpoints.

To move labware between teachpoints:

1 Remove obstacles in the path of the robot.

2 Place the desired labware at the reference teachpoint (platepad 1).

3 In the Robot speed list, select Slow.

4 In the Source-to-Destination Move area:

List or parameter Description

Source teachpoint The reference teachpoint you want to 
use.

Select Platepad 1 or a teachpoint that has 
been verified to be accurate.
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5 In the Source-to-Destination Move area, click Move. The robot picks up the 
labware from the source (reference teachpoint, platepad 1), moves through 
all the waypoints, and places the labware at the destination (new 
teachpoint).

6 Check that the robot does not hit raised walls or other structures as it 
approaches the teachpoint. If it does, you might need to add an additional 
waypoint between the point above the teachpoint and the first waypoint. 
Proceed to “Editing KiNEDx Robot teachpoints and waypoints” on page 149 
to add the waypoint.

7 Check the placement of the labware at the teachpoint. If the labware is 
placed incorrectly, proceed to “Editing KiNEDx Robot teachpoints and 
waypoints” on page 149. Depending on the placement, make one or more of 
the following adjustments:

                                                        

Destination teachpoint The teachpoint you want to verify.

Select from the list.

Offset Set Offset at 0.

Departure height The height clearance, in millimeters, that 
the robot must maintain above the 
reference teachpoint as it moves away 
from the teachpoint.

Set Departure height at the value you 
specified for the device Approach height. 
You can find the device Approach Height 
value in the Device Properties area of 
the VWorks software.

Arrival height The height clearance, in millimeters, that 
the robot must maintain above the 
teachpoint as it moves toward it.

Set Arrival height at the value you 
specified for the device Approach height. 
You can find the device Approach Height 
value in the Device Properties area of 
the VWorks software.

Pushdown overextended The additional z- axis distance, in 
millimeters, that the robot moves down 
past the teachpoint to secure the 
placement of the labware.

Set Pushdown overextended at 0 unless it is 
a vacuum station that requires the slight 
pushdown.

List or parameter Description
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• If the labware is placed farther out or closer to the robot than it 
should (as shown in the following diagrams), adjust the x-  and y- axis 
values slightly so that the robot will place the labware closer to or 
farther from the front of its grippers.

• If the labware is placed too far to the right or left (as shown in the 
following diagrams), adjust the t- axis value.

• If the labware is dropped onto the teachpoint, decrease the z- axis 
value so that the robot will place the labware onto the teachpoint.

• If the labware is pressed onto the teachpoint, increase the z- axis value 
so that the robot will gently place the labware onto the teachpoint.

8 If the labware is placed correctly, home the robot, and then remove the 
labware from the teachpoint.

Repeat the procedure in this section to pick up labware from the new 
teachpoint and place it at the reference teachpoint. At step 5, in the Source-to-
Destination Move area, click Swap source and destination before you click Move.
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Related information

For information about... See...

KiNEDx Robot Driver Diagnostics 
description

“Software description” on page 24

Using other commands and 
parameters in the KiNEDx Robot 
Driver Diagnostics 

“KiNEDx Robot Driver Diagnostics” on 
page 237

Quick reference of KiNEDx Robot 
Driver Diagnostics commands and 
parameters

“Quick reference” on page 355



149

5   Setting up the KiNEDx Robot
Editing KiNEDx Robot teachpoints and waypoints

BioCel System User Guide

Editing KiNEDx Robot teachpoints and waypoints

When you set a teachpoint and corresponding waypoints for the first time, you 
will likely set, verify, and edit the teachpoint and waypoints a number of times 
to make sure the points are accurate. After the points are set up correctly, you 
will not need to adjust or redefine them unless you do the following:

• Move the BioCel System.

• Move or replace one of the devices in the system.

• Adjust settings on the devices.

To edit a KiNEDx Robot teachpoint or waypoint:

1 Make sure you have followed the procedure in “Verifying KiNEDx Robot 
teachpoints and waypoints” on page 143 to determine the adjustments you 
need to make to the teachpoint or waypoints. For example, the robot is 
currently too far to the left of the teachpoint.

2 In the Profiles tab, verify that the correct teachpoint and waypoint files are 
loaded. To do this, in the Initialization files area, check the file paths.

3 If you are searching for missing waypoints or waypoint links:

a Click the Waypoints tab.

b Check the table for missing waypoints and waypoint link.

c Follow the instructions in “Setting new teachpoints and waypoints” on 
page 137 to add new and link waypoints.
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4 If you are adjusting an existing teachpoint, with the teaching jig or labware 
at the teachpoint, edit the teachpoint using one or both of the following 
methods:

a Click Launch Peak KiNEDx teach GUI. In the Teach Points tab, select the 
teachpoint or waypoint you want to edit. In the Jog Controls tab, use the 
Joint or Cartesian jog commands and parameters to move the robot to 
the correct location. In the Teach Points tab, set the coordinates and 
teachpoint.

b Follow the instructions in “Setting new teachpoints and waypoints” on 
page 137 to manually move the robot to the correct location, and set 
the teachpoint.

Related information

For information about... See...

KiNEDx Robot Driver Diagnostics 
description

“Software description” on page 24

Using other commands and 
parameters in the KiNEDx Robot 
Driver Diagnostics 

“KiNEDx Robot Driver Diagnostics” on 
page 237

Quick reference of KiNEDx Robot 
Driver Diagnostics commands and 
parameters

“Quick reference” on page 355
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6
Preparing for a protocol run

Before you start a protocol run, you should check the various 
devices in the BioCel System to ensure optimum operation.

This chapter contains the following topics:

• “Workflow for preparing a protocol run” on page 152

• “Performing dry runs” on page 153

• “Reviewing protocols and planning for the run” on page 154

• “Adding or removing devices mounted on docking tables” on 
page 155

• “Checking for system readiness” on page 166

• “Replacing the waste bin” on page 167

• “Loading labware in the system” on page 169

• “Stopping a run in an emergency” on page 171
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Workflow for preparing a protocol run

Workflow

The workflow for preparing a protocol run is as follows:

Related information

Step For this task... See...

1 Review the protocol and plan 
for the run.

“Reviewing protocols and planning 
for the run” on page 154

2 Add devices that are mounted 
on docking tables.

“Adding or removing devices 
mounted on docking tables” on 
page 155

3 Check the system for 
readiness.

“Checking for system readiness” on 
page 166

4 Replace the waste bin. “Replacing the waste bin” on 
page 167

5 Load labware in the system. “Loading labware in the system” on 
page 169

For information about... See...

Setting up the system “Setting up the BioCel System” on page 27

Setting teachpoints One of the following:

• “Setting Direct Drive Robot 
teachpoints” on page 69

• “Setting 3- Axis Robot teachpoints” on 
page 117

• “Setting KiNEDx Robot teachpoints” on 
page 135

Troubleshooting the system “Maintenance and troubleshooting” on 
page 173
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Performing dry runs

What is a dry run?

A dry run is when you run a protocol using empty labware. A dry run allows 
you to troubleshoot a protocol or a component of the system without wasting 
valuable reagents and samples. You should always perform a dry run to check 
a new protocol.

Correcting teachpoint errors

After setting the teachpoints, be sure to perform a dry run as a final check for 
any teachpoint errors. The dry run also allows you to fine- tune orientation 
settings in systems that have the Direct Drive Robot.

Preparing for a dry run

You prepare for a dry run the same way you would prepare for a real protocol 
run. For the preparation workflow, see “Workflow for preparing a protocol run” 
on page 152.

Related information

For information about... See...

Writing protocols VWorks Automation Control User 
Guide

Preparing for a run “Workflow for preparing a protocol run” 
on page 152

Workflow for setting teachpoints One of the following:

• “Setting Direct Drive Robot 
teachpoints” on page 69

• “Setting 3- Axis Robot teachpoints” 
on page 117

• “Setting KiNEDx Robot teachpoints” 
on page 135

• Staubli TX60 Device Driver User 
Guide

http://www.chem.agilent.com/Library/usermanuals/Public/G5415-90049_DDUG_EN.pdf
http://www.chem.agilent.com/Library/usermanuals/Public/G5415-90049_DDUG_EN.pdf
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Reviewing protocols and planning for the run

Procedure

Before you start a run, make sure you review the protocol and determine:

• The devices used in the protocol and how to prepare them for operation. 
For example, you might need to load a roll of seal on the PlateLoc Sealer 
or install a pipette head on a Vertical Pipettor. See the device user guides 
for setup instructions.

• The optimal device setup sequence. In general, you first set up devices that 
do not hold time- sensitive reagents. Leave complex preparations, which 
might use expensive and unstable reagents, until last.

• The labware used in the protocol and where they should be positioned 
before the run starts. For example, you might have to load labware into 
one or more storage devices such as the Labware Stacker and the Plate 
Hub Carousel.

• The waste bins that should be emptied.

• The reservoirs that must be filled.

Be sure to check the protocol User Message tasks for setup information. If the 
User Message tasks prompt you to place counterweight labware, you do not 
have to include these steps in the setup.

Related information

For information about... See...

Creating or revising protocols VWorks Automation Control User Guide

Adding or removing devices that 
are on docking tables

“Adding or removing devices mounted on 
docking tables” on page 155

Checking the system for 
readiness

“Checking for system readiness” on 
page 166

Replacing the waste bin “Replacing the waste bin” on page 167

Troubleshooting the system “Loading labware in the system” on 
page 169

Stopping the protocol run in an 
emergency

“Stopping a run in an emergency” on 
page 171
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Adding or removing devices mounted on docking tables

About this topic

Only trained BioCel System administrators should perform the procedures in 
this topic.

For a description of docking tables, see “Docking tables (optional)” on page 9.

Workflow for adding or removing devices mounted on docking tables

Adding devices mounted on docking tables
The workflow for adding devices that are mounted on docking tables is as 
follows:

Removing devices mounted on docking tables
The workflow for removing devices that are mounted on docking tables is as 
follows:

WARNING  Unlocking and removing protective windows, defeating interlocks and 
reconfiguring the system can expose you to serious hazards and may invalidate the safety 
compliance certification.

Step For this task... See...

1 Multiple docking- table systems 
only. Remove the protective 
window from the side of the 
system where the table will be 
docked.

“Removing and installing protective 
windows” on page 156

2 If applicable, connect the 
interlock cables to the E- STOP 
connectors on the system 
patch panel.

“Connecting to and disconnecting 
from the interlock system” on 
page 157

3 Dock the table. One of the following:

• “Docking and undocking the 
table automatically” on 
page 158

• “Docking and undocking the 
table with levers” on page 161

• “Docking and undocking the 
table with leveling casters” on 
page 163
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Removing and installing protective windows

In modular systems where multiple docking tables are interconnected, 
removable windows are installed on sides that permit the addition of docking 
tables. In these systems, you must first remove the protective window before 
docking a table, and install the protective window after undocking a table.

Removing the protective window on a docking table

To remove the protective window:

1 Windows without interlocks only. Using a 9- mm hex wrench, turn the two 
locks to unlock the window from the frame (1).

2 Windows with interlocks only. Turn the two black knobs on the window to 
unlatch the window from the frame (1).

3 While holding the handles (2), pull the bottom of the window outwards a 
few inches, then lift the window up until the window clamps are free from 
the top of the frame (3).

Step For this task... See...

1 Undock the table. One of the following:

• “Docking and undocking the 
table automatically” on 
page 158

• “Docking and undocking the 
table with levers” on page 161

• “Docking and undocking the 
table with leveling casters” on 
page 163

2 If applicable, disconnect the 
interlock cables from the E-
STOP connectors on the 
system patch panel.

“Connecting to and disconnecting 
from the interlock system” on 
page 157

3 Multiple docking- table systems 
only. Install the protective 
window on the side of the 
system that is exposed.

“Removing and installing protective 
windows” on page 156
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Installing the protective window

To install the protective window:

1 While holding the handles on the window, slide the window downward 
onto the front of the frame. Behind one of the frame posts are two screws. 
Make sure the corresponding window clamp fits between the two screws, 
as shown.

2 Windows with interlocks only. Turn the black knobs on the windows to 
secure the window latches.

3 Windows without interlocks only. Using a 9- mm hex wrench, turn the lock 
to secure the window latches. 

Connecting to and disconnecting from the interlock system

If devices on the docking table or if the protective windows on the docking 
table use the safety interlock system, you must connect them to the system 
interlock circuit when docking the table. When undocking the table, you must 
disconnect the devices or windows from the interlock circuit.

IMPORTANT The safety interlock circuit must be closed for the system to 
operate. You can use the supplied jumper to close the circuit after 
disconnecting the devices.

2

1

3

00398
l i h i
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Connecting to the interlock circuit

To connect the devices or windows to the interlock circuit:

1 Devices only. Remove the jumpers from the E-STOP connectors on the 
system patch panel (in the lower cabinet of the system).

2 Connect the interlock cables from the devices or windows to the E-STOP 
connectors on the system patch panel (in the lower cabinet of the system). 
Turn the connector clockwise until the connection is secure. 

Note: The patch panel configuration can vary by system. Use the labels 
on the panel to identify the correct connectors for the devices and 
windows.

Disconnecting from the interlock circuit

To disconnect the devices or windows from the interlock circuit:

1 Disconnect the device or window interlock cables from the E-STOP 
connectors on the system patch panel. Turn the connectors 
counterclockwise to loosen and remove the connectors.

2 Devices only. Install the supplied jumpers at the device E-STOP connectors 
on the system patch panel.

Docking and undocking the table automatically

If the docking table is equipped with the QuickDock feature, the docking and 
undocking processes are automated.

To dock the table using the QuickDock feature:

1 Move the docking table so the red alignment tab on the docking table faces 
the two red alignment tabs on the BioCel System.

2 Push the table against the BioCel System, making sure the red alignment 
tab on the docking table fits between the two red alignment tabs on the 
BioCel System.

00401
pathc panel
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3 Check the docking pendant. The pendant should display UNDOCKED and 
READY. If it does not, check the alignment of the table.

4 Press the pendant button. Lights on the pendant flash momentarily.

When the table is docked securely, the pendant displays READY and 
DOCKED.

5 Follow instructions in one of the following sections to verify the 
teachpoints of the devices on the docking table:

• “Verifying Direct Drive Robot teachpoints” on page 90

• “Verifying 3- Axis Robot teachpoints” on page 124

• “Verifying KiNEDx Robot teachpoints and waypoints” on page 143

To undock the table using the QuickDock feature:

1 Check the docking pendant. The pendant should display READY and 
DOCKED.
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2 Press the pendant button. Lights on the pendant flash momentarily.

When the table is undocked, the pendant displays UNDOCKED and READY.

3 Move the docking table away from the BioCel System.

Docking and undocking the table with levers

If the docking table is equipped with levers, the docking and undocking 
processes are performed manually.

Docking the table that has levers

To dock the table that has levers:

1 Move the docking table so the red alignment tab on the docking table faces 
the two red alignment tabs on the BioCel System.

2 Push the table against the BioCel System, making sure the red alignment 
tab on the docking table fits between the two red alignment tabs on the 
BioCel System.
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3 Under the docking table, firmly push up the two red levers until you hear 
them click. The click sound confirms that the table is docked.

4 Check that the table is securely docked. To do this, make sure the table 
does not move when you try to pull it away from the BioCel System.

                                                        



163

6   Preparing for a protocol run
Adding or removing devices mounted on docking tables

BioCel System User Guide

5 Follow instructions in one of the following sections to verify the 
teachpoints of the devices on the docking table:

• “Verifying Direct Drive Robot teachpoints” on page 90

• “Verifying 3- Axis Robot teachpoints” on page 124

• “Verifying KiNEDx Robot teachpoints and waypoints” on page 143

Undocking the table that has levers

To manually undock the table that has levers:

1 Under the docking table, firmly push down the red levers.

2 Move the docking table away from the BioCel System.

Docking and undocking the table with leveling casters

If the docking table is equipped with leveling casters, the docking and 
undocking processes are performed manually.

Docking a table with leveling casters

To dock a table with leveling casters:

1 Position the docking table adjacent to the system.

2 Turn the red wheel counterclockwise to extend the foot at each caster. 
Make sure the table is level.
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3 Follow instructions in one of the following sections to verify the 
teachpoints of the devices on the docking table:

• “Verifying Direct Drive Robot teachpoints” on page 90

• “Verifying 3- Axis Robot teachpoints” on page 124

• “Verifying KiNEDx Robot teachpoints and waypoints” on page 143

Undocking a table with leveling casters

To undock a table with leveling casters:

1 Turn the red wheel clockwise to raise the foot at each caster before moving 
the table.

2 Move the table away from the system.

Related information

00402
leveling caster

For information about... See...

Docking tables “Docking tables (optional)” on page 9
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Mounting devices on the docking 
table

Automation Solutions Technical Support

Devices that can be integrated in 
the BioCel System

“Device integration options” on page 23

Available devices “Additional BioCel System Devices” on 
page 241

For information about... See...
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Checking for system readiness

Procedure

To check that the BioCel System is ready for a protocol run:

1 Remove labware at robot- accessible locations, including:

• Platepads

• External device plate stages

• Third- party device areas that will accept labware from the BioCel 
System

2 Remove any obstacle in the robot’s pathways.

3 Make sure all devices are set up correctly and prepared for the run. For 
instructions, see the user documentation for the device.

4 Make sure all devices are turned on, the compressed air is turned on, and 
the vacuum is turned on.

For the devices that require compressed air, make sure the air pressures 
meet the operating requirements. For the BioCel System compressed air 
requirements, see “System specifications” on page 5. For other devices, see 
the user documentation for the device.

5 Turn on the safety interlock. For instructions, see “Startup procedure” on 
page 32.

Related information

For information about... See...

Creating protocols VWorks Automation Control User 
Guide

Starting, pausing, monitoring, and 
stopping protocol runs

VWorks Automation Control User 
Guide

Stopping a run in an emergency BioCel System Safety Guide
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Replacing the waste bin

About this topic

If the BioCel System has an optional waste bin, make sure you empty the bin 
before starting a protocol run. The waste bin can be free- standing or on a 
hanger. This section explains how to replace the waste bin on a hanger.

Removing the waste bin

To remove the waste bin from its hanger:

1 Open the cabinet door nearest the bin.

2 Hold the bin at the top- right corner with your right hand.

3 Lifting the front side of the bin upwards with your right hand, place your 
left hand underneath at the bottom- left corner.

4 Supporting the bin with both hands, lift it up and off the hanger.

5 Slide the bin out of the BioCel System.

6 Close the cabinet door.

Installing the waste bin

To replace the waste bin on its hanger:

1 Open the cabinet door nearest the bin.

2 Slide the empty bin into the BioCel System until it lies underneath the 
waste opening, with the side of the bin resting against the hanger.

3 Lifting the front side of the bin upwards with your right hand, place your 
left hand underneath at the bottom left corner.

4 Using both hands, lift the bin up, over the hanger, and down so the hanger 
supports the underside of the lip.

5 Close the cabinet door.
                                                        

WARNING  If the BioCel System has an automatic door over the waste bin, use caution 
when removing or replacing the waste bin. If a protocol is running, the automatic door for 
the waste opening might open or close at any time. Do not attempt to retrieve or place the 
waste bin during a protocol run.
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Related information

For information about... See...

BioCel System air source 
requirements

“System specifications” on page 5

External device air source 
requirements

External device user documentation

Diagnosing air pressure problems “Troubleshooting hardware problems” 
on page 183
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Loading labware in the system

When you need to manually load labware in the system

Depending on the protocol, you might need to manually place microplates, 
tipboxes, reservoirs, or counterweights onto platepads, hotel shelves, device 
shelves, or labware storage devices before starting the run. For example, you 
generally need to load labware into Labware Stackers or one or more cassettes 
(racks) in the Plate Hub Carousel.

How you load the labware in various devices depends on the type of robot in 
the system and the device. This topic provides the following:

• “Direct Drive Robot guidelines” on page 169

• “3- Axis Robot and KiNEDx Robot guidelines” on page 169

• “Plate Hotel and Plate Hub Carousel guidelines” on page 170

Direct Drive Robot guidelines

Before loading labware in storage devices, always review the teachpoint file for 
labware orientation information. The labware must be loaded in the same 
orientation as specified in the teachpoint file.

3-Axis Robot and KiNEDx Robot guidelines

In systems that use the 3- Axis Robot or the KiNEDx Robot, always load 
labware into storage devices so that the A1 well is in the top- left corner from 
the robot’s perspective.
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Plate Hotel and Plate Hub Carousel guidelines

Before you start
Before loading labware in the Plate Hotel and Plate Hub Carousel, make sure 
the racks and slots used in the protocol are defined in the Plate Hub Carousel 
profile. For detailed instructions, see “Plate Hotel and Plate Hub Carousel” on 
page 319.

Review the “Direct Drive Robot guidelines” on page 169 or “3- Axis Robot and 
KiNEDx Robot guidelines” on page 169 so that you know how the labware 
should be loaded.

Procedure
With the Plate Hotel or Plate Hub racks in the BioCel System, load labware 
into the slots.

IMPORTANT Although they are removable, Agilent Technologies recommends 
that you leave the Plate Hub Landscape racks in the BioCel System while 
loading labware. Doing so ensures the teachpoints are maintained and prevents 
potential spills in the hotel or carousel.

Related information

For information about... See...

Plate Hotel and Plate Hub 
Carousel

“Plate Hotel and Plate Hub Carousel” 
on page 319

Direct Drive Robot teachpoints “Direct Drive Robot teachpoints” on 
page 60
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Stopping a run in an emergency

About this topic

You should know how to stop the run in case of an emergency. This topic 
explains how to stop the BioCel System in an emergency situation.

To pause and continue a run, use the Pause command in the VWorks software. 
You can also stop a run using the Stop command in the software. For 
instructions, see the VWorks Automation Control User Guide.

Using the EMERGENCY STOP button

To stop a protocol run in an emergency:

Press the EMERGENCY STOP button on the power panel or on the BioCel 
System table (1). The BioCel System robot stops immediately. The integrated 
devices stop immediately.

To restore the system for normal operation, see “Recovering from an 
emergency stop” on page 175.
                                                        

CAUTION You cannot resume a protocol run after pressing the EMERGENCY STOP button.

WARNING  After you press the EMERGENCY STOP button, the Vertical Pipettor will 
finish the current task before stopping.
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Using the light curtains (BioCel 900 System only)

IMPORTANT Do not use the light curtains to routinely stop a protocol run. 
Instead, use the Pause or Stop command in the software.

To use the light curtain in an emergency:

1 Interrupt the light beams from the light curtains. The safety interlock 
circuit is interrupted. The BioCel System operation stops. The INTERLOCK 
indicator light on the power panel turns off.

2 To resume or recover from the stop, see “Recovering from an emergency 
stop” on page 175.

Related information

For information about... See...

Recovering from an emergency 
stop

“Recovering from an emergency stop” 
on page 175

Shutdown procedure  “Starting up and shutting down the 
BioCel System” on page 32

General safety information BioCel System Safety Guide

http://www.chem.agilent.com/Library/usermanuals/Public/G5500-90004_BioCel_Safety_EN.pdf
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7
Maintenance and troubleshooting

This chapter explains how to maintain the BioCel System and 
provides troubleshooting information.

This chapter contains the following topics:

• “Routine maintenance” on page 174

• “Recovering from an emergency stop” on page 175

• “Recovering from a power outage” on page 179

• “Recovering from servo errors” on page 180

• “Troubleshooting plate- sensor errors” on page 182

• “Troubleshooting hardware problems” on page 183

• “Troubleshooting error messages” on page 189

• “Reporting problems” on page 203
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Routine maintenance

About this topic

This topic provides recommendations for maintaining the BioCel System. For 
the maintenance of integrated devices, see the user documentation for the 
devices.

General maintenance

In general, practice good housekeeping by cleaning up spills and following the 
post- run clean- up procedures.

Cleaning up after every protocol run

To clean up after a run:

1 Follow the VWorks software prompts for post- run procedures, such as 
unloading the labware. See the VWorks Automation Control User Guide for 
detailed instructions.

2 Unload used labware from the devices.

3 Remove manually placed labware from devices.

4 See the device user documentation for cleanup instructions.

5 Check run logs for errors.

6 If you have administrator or technician privileges and you have modified 
the protocol, including selected options, you can save the protocol.

7 Log out of the software. See the VWorks Automation Control User Guide 
for instructions.

Monthly inspection and maintenance

Once a month, check the following:

• Robot gripper pads are not torn, cracked or otherwise worn. To replace the 
robot gripper pads, contact Automation Solutions Technical Support.

• Liquid- handling tubing is not torn, cracked or discolored. See the liquid-
handling device user documentation for detailed instructions. 

• Table top is free of debris, such as pieces of chipped microplates and 
microtubes.

Related information

For information about... See...

Shutdown procedure  “Shutting down procedure” on page 36

Safety BioCel System Safety Guide

Reporting problems “Reporting problems” on page 203
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Recovering from an emergency stop

About this topic

This topic explains how to recover from an emergency stop after you:

• Pressed the EMERGENCY STOP button on the power panel or on the 
system table

• Interrupted the light beams in the light curtains

After you pressed the EMERGENCY STOP button

After pressing the Emergency Stop button, you must restore the system for 
normal operation.

IMPORTANT You cannot resume or recover a protocol run after pressing the 
Emergency Stop button on the power panel or on the BioCel System table. You 
will need to rerun the protocol after restoring the system for normal operation.

Before you restore the system, make sure you remove labware that was 
dropped during the emergency stop. Also remove labware at teachpoints or 
other locations.

To restore the BioCel System after an emergency stop:

1 Restore power and air to various system components. To do this:

• On the power panel, pull out the EMERGENCY STOP button.

• On the BioCel System table, turn the EMERGENCY STOP buttons 
clockwise. The spring- loaded buttons pop up.
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2 On the power panel, press the green RESET button.

3 If the BioCel System has light curtains, turn off the safety interlock. To do 
this, on the power panel, turn the INTERLOCK key clockwise. The 
INTERLOCK indicator light turns off.
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4 In each of the device dialog boxes opened in the software, select one of the 
following commands to restore the device for normal operation. For 
example, you might need to use the device diagnostics software to release 
labware, replace the lid on a labware, home the robot, or verify the device 
teachpoint.

5 If there is labware in the BioCel System robot gripper, release it and move 
it back to the pickup location. To do this:

a Determine the location from which the labware was picked up.

b In the Robot Error dialog box, click Diagnostics.

c Hold the labware in your hand so that the labware does not drop when 
you release it from the robot grippers. 

d Click Open Gripper to release the labware to your hand.

e Place the labware at the pickup location.

6 If the BioCel System has light curtains, turn on the safety interlock. To do 
this, on the power panel, turn the INTERLOCK key counterclockwise.

7 Click Abort Process in the Stop dialog box.

8 Exit and restart the VWorks software. Communication with the devices that 
lost power is re- established.

After you interrupted the Light Curtain

If you interrupted the light beams in the Light Curtains during a protocol run, 
the Scheduler Paused dialog box opens in the VWorks software.

To resume the run or recover the system after interrupting the light beams in the Light 
Curtains:

1 In the VWorks software, click one of the following in the Scheduler Paused 
dialog box:

Selection Description

Diagnostics Opens the device diagnostics dialog box.

Note: This selection is available only when you are in 
the middle of a protocol run and not while you are 
already in the device diagnostics software.

Retry Attempts to restart the current command or task in 
the run.

Ignore and 
continue

Ignores the current command or task and continues 
to the next command or task in the protocol 
sequence.

Abort Aborts the current command or task in the run. 
Select Abort if you have determined that the protocol 
run is not recoverable.

Selection Description

Continue Ignores the current command or task and continues 
to the next command or task in the protocol 
sequence.
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2 In the Robot Error dialog box, click one of the following:

Related information

Diagnostics Allows you to select the device and opens the device 
diagnostics dialog box.

Note: This selection is available only when you are in 
the middle of a protocol run and not while you are 
already in the device diagnostics software.

Abort process Aborts the current command or task in the run. 
Select Abort if you have determined that the protocol 
run is not recoverable.

Selection Description

Selection Description

Diagnostics Opens the device diagnostics dialog box.

Note: This selection is available only when you are in 
the middle of a protocol run and not while you are 
already in the device diagnostics software.

Retry Attempts to restart the current command or task in 
the run.

Ignore and 
continue

Ignores the current command or task and continues 
to the next command or task in the protocol 
sequence.

Abort Aborts the current command or task in the run. 
Select Abort if you have determined that the protocol 
run is not recoverable.

For information about... See...

Pausing and resuming protocol 
runs

VWorks Automation Control User 
Guide

Shutting down the system “Shutting down procedure” on page 36

Using commands in Robot 
Diagnostics

“Using diagnostic tools” on page 205

Safety BioCel System Safety Guide

Reporting problems “Reporting problems” on page 203
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Recovering from a power outage

About this topic

This topic explains how to recover the BioCel System from a power outage.

During the power outage

During a power outage, if the BioCel System has a UPS, the following occurs:

• The UPS starts to beep while providing power to the devices. 

• The VWorks software writes an error message to the log, displays an error 
message on the screen, and notifies you if you have specified email 
notification during setup.

• If the system is running a protocol, it will continue until the UPS charge 
passes the thresholds specified in VWorks software. When the threshold is 
reached, the VWorks software exits and the computer shuts down 
automatically.

If the BioCel System does not have a UPS, the system stops during a power 
outage. If the system is running a protocol, the run stops.

Recommended actions during a power outage (systems with UPS only)

If a running protocol is nearly finished, you might consider letting it continue 
until it is finished.

If you started running a protocol and you anticipate a lengthy power outage, 
you might consider stopping the run.

When the power is restored

If the BioCel System was not shut down during the power outage, the system 
will receive power, the UPS recharges, and the protocol (if running) continues.

If the BioCel System does not have a UPS and the running protocol was 
stopped, you need to restore the system and rerun the protocol. Follow the 
instructions in “Recovering from an emergency stop” on page 175 to restore 
the system.

Related information

For information about... See...

Setting the VWorks software UPS 
threshold

VWorks Automation Control User 
Guide

Turning on the BioCel System “Starting up and shutting down the 
BioCel System” on page 32

Safety BioCel System Safety Guide

Reporting problems “Reporting problems” on page 203
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Recovering from servo errors

About this topic

This topic explains how to recover from servo errors.

Causes of servo errors

A servo system controls the robot’s motions. The servo cuts power to the robot 
if it encounters resistance to movement that is slightly higher than that 
expected from the inertia of the robotic arm holding a labware. When the 
power is cut, a servo error is generated.

Most servo errors occur when the labware being carried crashes into another 
labware that is on a device. 

Procedure

To recover from a servo error:

1 Check the BioCel System table to determine the cause of the collision and 
remove the obstruction. For example, it might be a labware from a previous 
run.

2 Check the labware that is held by the robot to make sure it is not damaged 
and that its contents are not spilled.

3 Make sure the labware did not move in the robot gripper during the 
collision.

4 If the labware has not moved in the robot gripper and was not damaged 
during the collision, in the error message dialog box, click one of the 
following:

                                                        

Selection Description

Diagnostics Opens the device diagnostics dialog box.

Note: This selection is available only when you are in 
the middle of a protocol run and not while you are 
already in the device diagnostics software.

Retry Attempts to restart the current command or task in 
the run.

Ignore and 
continue

Ignores the current command or task and continues 
to the next command or task in the protocol 
sequence.

Abort Aborts the current command or task in the run. 
Select Abort if you have determined that the protocol 
run is not recoverable.
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5 If the labware has moved during the collision or was damaged, in the error 
message dialog box, click Diagnostics and move the labware manually:

a Move the robot to a position that is easy for you to access.

b While holding the labware with your hand, in the diagnostics software, 
use the available software command to open the robot grippers. The 
robot releases the labware. For diagnostics software instructions, see 
“Using diagnostic tools” on page 205.

c Place the labware at the destination location manually.

d Close the robot diagnostics software.

e Click in the next error message dialog box, click Ignore and continue.

6 If the crash was severe, home the robot. To do this, in the robot 
diagnostics software, use the available command to home the robot. For 
diagnostics software instructions, see “Using diagnostic tools” on page 205.

Related information

For information about... See...

Emergency stop circuits “Power system” on page 348

Power panel “Power panel” on page 7

Verifying teachpoints One of the following:

• “Verifying Direct Drive Robot 
teachpoints” on page 90

• “Verifying 3- Axis Robot teachpoints” 
on page 124

• “Verifying KiNEDx Robot 
teachpoints and waypoints” on 
page 143

Reporting problems “Reporting problems” on page 203
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Troubleshooting plate-sensor errors

About this topic

This topic explains how to troubleshoot plate- sensor errors in systems that 
have the 3- Axis Robot.

Procedure

To troubleshoot a plate-sensor error:

1 If the robot is not holding labware in the gripper, determine whether the 
labware was:

• Knocked out of the gripper. In this case, find out what knocked the 
labware out of the gripper.

• Missing from the location at which the robot attempted to pick it up. 
In this case, place the correct labware in the location and click Retry in 
the Robot Error dialog box.

• Not picked up. In this case, there might be a problem with either the 
labware definition for the labware or a teachpoint. Check the labware 
definition. Check the teachpoint at the position where it failed to pick 
up the labware, and the teachpoint at the previous position. If there 
does not seem to be a teachpoint error, contact Automation Solutions 
Technical Support.

2 If the labware is held in the gripper but is not seated correctly, establish 
whether the labware was positioned correctly at the pickup location.

• If the labware was not positioned correctly at the pickup location, 
reposition the labware and click Retry in the Robot Error dialog box.

• If the labware was positioned correctly at the pickup location, there 
might be a problem with the approach or departure height. 
Alternatively, there might be a problem with the labware, the labware 
definition, a teachpoint, or the plate sensor. In this case, you should 
contact Automation Solutions Technical Support.

Related information

For information about... See...

Emergency stop circuits “Power system” on page 348

Verifying teachpoints One of the following:

• “Verifying Direct Drive Robot 
teachpoints” on page 90

• “Verifying 3- Axis Robot teachpoints” 
on page 124

• “Verifying KiNEDx Robot 
teachpoints and waypoints” on 
page 143

Reporting problems “Reporting problems” on page 203
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Troubleshooting hardware problems

About this topic

This topic lists possible hardware problems, the causes of the problems, and 
ways to resolve the problems. If you are still experiencing problems with the 
BioCel System after trying the solutions, contact Automation Solutions 
Technical Support.

Note: This topic presents problems and solutions that are specific to the Direct 
Drive Robot, 3- Axis Robot, and KiNEDx Robot. Problems and solutions that are 
common in the three robots and the Staubli Robot are also presented. For 
problems specific to the Staubli TX60 Robot, see the Staubli TX60 Device 
Driver User Guide.

Hardware problems

Problem Cause Solution

The system does not 
turn on.

The system electrical requirements 
are not met.

Make sure the system electrical 
requirements are met. See “Electrical 
requirements” on page 5.

The BioCel System is not 
connected to the power source.

Connect the BioCel System to the 
power source. See “Power 
connection” on page 14.

The power supply circuit breaker 
switches have been tripped.

Reset the circuit breakers. If the 
switches continue to trip, check and 
make sure the system electrical 
requirements are met. See “Electrical 
requirements” on page 5.

The UPS is not turned on or is not 
working properly.

Turn on the UPS. See “Starting up 
and shutting down the BioCel 
System” on page 32.

The internal fuse is blown. Contact Automation Solutions 
Technical Support.

A hissing sound can 
be heard.

A leak is present in the air 
connection or inside the system.

Turn off the air at the power panel 
(“Power panel” on page 7) and the 
utilities panel (“Air regulation panel” 
on page 11).

Check the air connections at the 
utilities panel and at the source 
(house, cylinder, or pump). 

If the connections look fine, the leak 
might be inside the system. Contact 
Automation Solutions Technical 
Support.

Oil is present inside 
devices or the system.

The compressed air is not from an 
oil- free compressor and oil has 
leaked into the system.

Contact Automation Solutions 
Technical Support.

http://www.chem.agilent.com/Library/usermanuals/Public/G5415-90049_DDUG_EN.pdf
http://www.chem.agilent.com/Library/usermanuals/Public/G5415-90049_DDUG_EN.pdf
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Labware drops or is 
held loosely by the 
robot.

Direct Drive Robot.

• The labware definition for the 
microplate type might contain 
incorrect information.

• The Grip torque parameter 
value is incorrect for the 
labware.

• The Gripper offset range in 
incorrect.

• The robot gripper pads are 
dirty.

• The grippers are damaged.

Direct Drive Robot.

• Check the labware definition for 
errors.

• In Labware Editor, change the 
Grip torque value for the 
labware.

• In the Labware Editor and the 
DDR Diagnostics, change the 
Gripper Offset Range values.

• Clean the robot gripper pads.

• Call Automation Solutions 
Technical Support to replace the 
damaged robot grippers.

3- Axis Robot, KiNEDx Robot, and 
Staubli robot.

• The labware definition for the 
microplate type might contain 
incorrect information.

• The system air pressure is too 
low or too high, or the air is 
turned off.

3- Axis Robot, KiNEDx Robot, and 
Staubli Robot. 

• Check the labware definition for 
incorrect information.

• Check the air pressure and 
connections at the utilities panel 
and at the source (house, 
cylinder, or pump). If the air is 
turned off, turn on the air. 

• If the air is turned on, adjust the 
system air pressure. If the 
grippers are bent outward from 
the labware, the pressure is too 
high.

See “Air regulation panel” on 
page 11 for the location of the air 
pressure gauge. See “Compressed air 
requirements” on page 5 for air 
pressure specifications.

Labware bends when 
held by the robot.

Direct Drive Robot. 

The Grip torque parameter value is 
incorrect for the labware.

Direct Drive Robot. 

In Labware Editor, change the Grip 
torque value for the labware.

3- Axis Robot, KiNEDx Robot, and 
the Staubli Robot. 

The system air pressure is too high 
so that the robot is holding the 
labware too tightly.

3- Axis Robot, KiNEDx Robot, and 
Staubli Robot. 

Decrease the system air pressure. 
See “Air regulation panel” on 
page 11 for the location of the air 
pressure gauge. See “Compressed air 
requirements” on page 5 for air 
pressure specifications.

Problem Cause Solution
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The robot is not 
moving to and from 
the teachpoints 
accurately.

All robots.

The robot axes need to be 
recalibrated.

All robots.

Home the robot. See one of the 
following:

• “Homing the Direct Drive Robot 
and grippers” on page 207

• “Homing the 3- Axis Robot” on 
page 230

• “Homing the KiNEDx Robot” on 
page 238

• Staubli TX60 Device Driver User 
Guide.

All robots.

The teachpoint coordinates or 
orientations are inaccurate. The 
approach height value might be 
incorrect.

All robots.

Verify and edit the teachpoint. See 
one of the following:

• “Verifying Direct Drive Robot 
teachpoints” on page 90

• “Verifying 3- Axis Robot 
teachpoints” on page 124

• “Verifying KiNEDx Robot 
teachpoints and waypoints” on 
page 143

• Staubli TX60 Device Driver User 
Guide.

Problem Cause Solution

http://www.chem.agilent.com/Library/usermanuals/Public/G5415-90049_DDUG_EN.pdf
http://www.chem.agilent.com/Library/usermanuals/Public/G5415-90049_DDUG_EN.pdf
http://www.chem.agilent.com/Library/usermanuals/Public/G5415-90049_DDUG_EN.pdf
http://www.chem.agilent.com/Library/usermanuals/Public/G5415-90049_DDUG_EN.pdf
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The robot is unable to 
place labware at the 
target location 
accurately.

All robots.

• The target location teachpoint 
is incorrect.

• The teachpoint of the 
previously scheduled device is 
incorrect.

• The target device was moved or 
reconfigured and the 
teachpoint was not updated.

• Approach height setting is 
incorrect.

• The labware might be damaged 
or deformed.

• The robot gripper pads are 
dirty.

• The robot gripper pads are 
worn unevenly or are damaged.

All robots.

Verify and edit the teachpoints. See 
one of the following:

• “Verifying Direct Drive Robot 
teachpoints” on page 90

• “Verifying 3- Axis Robot 
teachpoints” on page 124

• “Verifying KiNEDx Robot 
teachpoints and waypoints” on 
page 143

• Staubli TX60 Device Driver User 
Guide.

• Check the approach height 
setting.

• Clean the robot gripper pads.

• Replace the damaged or 
deformed labware.

Contact Automation Solutions 
Technical Support to replace the 
robot grippers pads or the robot 
grippers.

Direct Drive Robot.

Incorrect gripper offset range is 
specified.

Direct Drive Robot.

Check and correct the gripper offset 
ranges for the labware, the pick 
location, and the place location. See 
“Setting the gripper offset 
parameters” on page 83.

Direct Drive Robot 
only. The robot placed 
the labware such that 
the A1 well is in the 
wrong orientation.

Direct Drive Robot.

The incorrect A1- well orientation 
is specified for the teachpoint.

Direct Drive Robot.

In the teachpoint file, verify the A1-
well orientation specification. Change 
the specification if necessary. See 
“Specifying the A1- well orientation” 
on page 74.

Direct Drive Robot 
only. The robot 
collides with devices 
or obstacles when 
moving from 
teachpoint to 
teachpoint.

Direct Drive Robot.

The incorrect robot- arm 
orientation, approach height, or 
approach distance values are used.

Direct Drive Robot.

In the teachpoint file, check and 
correct the robot- arm orientation, 
approach height value, and approach 
distance value. See “Creating a new 
teachpoint” on page 74.

Problem Cause Solution

http://www.chem.agilent.com/Library/usermanuals/Public/G5415-90049_DDUG_EN.pdf
http://www.chem.agilent.com/Library/usermanuals/Public/G5415-90049_DDUG_EN.pdf
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The Lid Hotel Station 
is not delidding or 
relidding properly.

• The rollers in the Lid Hotel 
Station are dirty.

• The robot is holding the 
labware at the lid instead of 
below at the microplate.

• Barcode labels are applied to 
the lid and the labware, 
preventing the lid from being 
removed.

• Too many layers of barcode 
labels are applied to the 
labware.

• The lids have sticky residues 
from the barcode labels.

• Clean the rollers in the Lid Hotel 
Station.

• Check and adjust the robot 
gripper offset for the labware.

• Check how the barcode labels 
are applied to the labware. Make 
sure the labels are applied 
correctly.

• Remove excess layers of old 
barcode labels before applying 
new labels.

• Clean the barcode label residues 
from the labware lids.

The Vacuum Delid 
Station is not working 
properly.

Air flow to the Vacuum Delid 
Station is insufficient.

• Check the air pressure and 
connections at the utilities panel 
and at the source (house, 
cylinder, or pump).

• Check for leaks in the air supply 
line.

Holes in the black rubber suction 
cups are causing vacuum leaks.

Contact Automation Solutions 
Technical Support to replace the 
black rubber suction cups.

The Vacuum Delid Station 
teachpoint is incorrect.

Check and correct the teachpoint. 
Make sure you check the approach 
height value.

Direct Drive Robot. Check the 
approach distance value and the 
custom action selected. See “Setting 
the approach distance” on page 81 
and “Selecting custom actions” on 
page 84.

Problem Cause Solution
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Related information

For information about... See...

BioCel System component names “Hardware overview” on page 7

Software error messages “Troubleshooting error messages” on 
page 189

Diagnosing problems “Using diagnostic tools” on page 205

Reporting problems “Reporting problems” on page 203



189

7   Maintenance and troubleshooting
Troubleshooting error messages

BioCel System User Guide

Troubleshooting error messages

About this topic

This topic lists the following:

• DDR error messages

• 3- Axis Robot error messages

If the BioCel System has the KiNEDx Robot, see the Peak KiNEDx Robot user 
documentation for maintenance and troubleshooting instructions. For problems 
specific to the Staubli TX60 Robot, see the Staubli TX60 Device Driver User 
Guide.

DDR error messages

The following table lists error messages that might appear in DDR Diagnostics, 
the causes of the errors, and ways to resolve the errors. If you are still 
experiencing problems with the BioCel System after trying the solutions, 
contact Automation Solutions Technical Support.

For protocol- related errors, see the VWorks Automation Control User Guide.

The following error messages are listed by error message ID.

ID Error message Cause Solution

124 The current speed setting 
<speed> exceeds the 
maximum speed specified 
by the newly selected 
labware <speed>. Would 
you like to reduce the 
speed setting to match the 
maximum speed <speed>?

After selecting a speed in 
DDR Diagnostics, you select 
a labware. The speed setting 
of the labware (in Labware 
Editor) is slower than the 
speed selection in DDR 
Diagnostics. 

Select Yes to change the 
speed selection in DDR 
Diagnostics to match the 
labware speed setting. 
Select No to use the 
current speed selection in 
DDR Diagnostics. Note that 
the Labware speed setting 
will not be changed. 

125 Failed to open a 
connection to 
<profileName: 
errorString>.

Connection cannot be 
established with the robot 
specified by the profile. The 
desired robot or the 
controlling computer is not 
connected to the system.

Make sure the robot and 
controller computer are 
both connected to the 
system network.

145 Failed to disable the arm 
power.

Connection cannot be 
established with the robot 
specified by the profile. The 
desired robot or the 
controlling computer is not 
connected to the system.

Make sure the robot and 
controller computer are 
both connected to the 
system network.

146 Failed to enable the arm 
power.

Connection cannot be 
established with the robot 
specified by the profile. The 
desired robot or the 
controlling computer is not 
connected to the system.

Make sure the robot and 
controller computer are 
both connected to the 
system network.

http://www.chem.agilent.com/Library/usermanuals/Public/G5415-90049_DDUG_EN.pdf
http://www.chem.agilent.com/Library/usermanuals/Public/G5415-90049_DDUG_EN.pdf
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167 Would you like to change 
the selected labware to 
Teaching Jig?

If not, make sure the 
selected labware is gripped 
at its minimum gripper 
offset.

You clicked Teach Mode in 
DDR Diagnostics, but you 
have not yet selected the 
teaching jig.

Click Yes to select the 
teaching jig in DDR 
Diagnostics. Click No to 
exit the error dialog box. 
The existing labware is 
still selected.

When using a labware to 
set teachpoints, the 
software assumes that the 
labware is held at the 
minimum gripper offset.

179 There are unsaved 
teachpoint modifications. 
Would you like to save?

While closing the profile, the 
software found unsaved 
teachpoint modifications.

Click Yes to save the 
changes and close the 
profile. Click No to close 
the profile without saving 
the changes.

212 This action will create 
<orientation>. This 
orientation already exists 
in this teachpoint. Would 
you like to exchange the 
parameters of these two 
orientations?

Changing the A1- well 
orientation of the selected 
orientation will result in 
duplicate orientations for a 
teachpoint. 

Click Yes to keep the two 
A1- well orientations and 
exchange the parameters of 
these two orientations. 
Click No to exit the error 
dialog box without making 
any changes.

250 The teachpoint <teachpoint 
name> does not exist. 
Before starting the cycler, 
you must remove this 
teachpoint.

You are attempting to start 
the teachpoint cycler, but a 
teachpoint no longer exists. 
The teachpoints list in the 
Cycler tab is not 
synchronized with the 
teachpoints list in the 
Teachpoints tab. Teachpoints 
that were removed in the 
Teachpoints tab still appear 
in the Cycler tab.

Remove the obsolete 
teachpoint from the Cycler 
tab before starting the 
teachpoint cycler.

252 The center of the approach 
orientation <plate, A1, and 
arm orientation> is not 
within 25 mm of the 
center of the orientations 
found in the target 
teachpoint: <teachpoint 
name>.

Continue?

All orientations of a single 
teachpoint should have the 
same center coordinates with 
a 25- mm tolerance along the 
x- , y- , or z- axis. The 
orientation you are adding is 
likely for a different 
teachpoint, because its center 
is greater than 25 mm from 
that of the target teachpoint.

Click Continue to add the 
orientation to the 
teachpoint despite the 
warning. When you save 
the teachpoint file, the 
same warning message will 
appear.

Click Cancel to exit the 
dialog box without making 
the change.

ID Error message Cause Solution
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344 You are attempting to 
update the orientation 
<original plate 
orientation, original A1 
orientation, original arm 
orientation> with the 
robot's current approach 
orientation: new plate 
orientation, new A1 
orientation, new arm 
orientation. Because of this 
mismatch, the update is 
not allowed.

You moved the robot to a 
new position and the 
orientation (landscape/
portrait, right/left) does not 
match the teachpoint you 
selected for the update 
action. For example, the 
robot is currently in the 
landscape orientation but the 
teachpoint you selected has 
the portrait orientation.

Make sure you have 
selected the correct 
teachpoint for updating. 
Make sure you have moved 
the robot to the correct 
position and the 
orientation is correct.

363 Because the specified zip 
file name does not start 
with DDRFirmware, you 
cannot use this file to 
update the DDR firmware.

The .zip file you are using 
for firmware update must 
contain the DDRFirmware 
string in its name.

Make sure you selected the 
correct file for upgrading 
the firmware. The filename 
must start with the 
DDRFirmware string.

9041 Gripper motor could not 
initialize. If a plate is 
currently being gripped, 
removing it should allow 
the gripper motor to 
initialize.

The gripper was holding a 
labware when you initialized 
the robot.

Remove the labware, and 
then reinitialize.

9051 z- axis motor over 
temperature (digital).

The digital input that is 
connected to the z- axis 
temperature sensor indicates 
that this axis temperature is 
equal to or above 
approximately 110 °C.

Home the robot.

9052 z- axis motor over 
temperature (analog).

The analog input that is 
connected to the z- axis 
temperature sensor indicates 
that this axis temperature is 
equal to or above the 
factory- specified threshold.

Home the robot.

9081  Error while homing robot. The robot grippers cannot 
move to the home position. 
An obstacle might be in the 
way, or the grippers are 
opened too far.

If the grippers are holding 
labware, remove the 
labware and retry homing.

If an obstable is in the 
way, remove the obstacle 
and retry homing.

Close the robot grippers 
and try again.

9082 Error while homing robot 
(fine homing error).

The robot is unable to move 
to the home position.

Move the robot to a 
different position, and then 
try to home the robot 
again.

ID Error message Cause Solution
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9115 Communication error 
(destination not set).

An internal software error 
occurred.

Contact Automation 
Solutions Technical 
Support.

9131 Teachpoint name not 
found.

An internal software error 
occurred.

Contact Automation 
Solutions Technical 
Support.

9132 Approach orientation index 
out of range.

An internal software error 
occurred.

Contact Automation 
Solutions Technical 
Support.

9138 Could not find the 
specified approach 
orientation.

The firmware has 
encountered a situation in 
which the desired approach 
orientation(s) does not exist 
in the specified teachpoint. 
For example, the operator 
has issued a ‘Move to’ 
command to teachpoint ‘A’, 
and specified that the 
Portrait, A1 away from the 
gripper, Lefty orientation be 
used. When the robot 
executes this command it is 
determined that the specified 
approach orientation does 
not exist for teachpoint ‘A.’

Reset the teachpoint with 
the correct orientations.

9140 Final gripper position is 
less than target position.

The gripper settings need to 
be adjusted.

When gripping a plate in 
landscape or portrait 
position, the gripper is 
closed until the labware-
specified torque is reached. 
After reaching this torque, 
the grippers are stopped. 
The gripper position is 
checked against the Gripper 
settings found in the Setup 
tab. If the gripper position 
does not fall within the 
tolerance specified by these 
settings, this error is 
displayed.

In the DDR Diagnostics Setup 
tab, adjust the close target 
and the close tolerance 
settings.

ID Error message Cause Solution
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9141 Final gripper position is 
greater than target 
position.

The gripper settings need to 
be adjusted.

When gripping a plate in 
landscape or portrait 
position, the gripper is 
closed until the labware-
specified torque is reached. 
After reaching this torque, 
the grippers are stopped. 
The gripper position is 
checked against the Gripper 
settings found in the Setup 
tab. If the gripper position 
does not fall within the 
tolerance specified by these 
settings, this error is 
displayed.

In the DDR Diagnostics Setup 
tab, adjust the close target 
and the close tolerance 
settings.

9146 While picking: Error 
occurred during transfer 
from <SRC> to <DST>.

The robot was unable to 
move to the pick location 
because an obstacle was in 
the way.

Remove any obstacle in the 
robot's path and try again.

9147 While picking: Optical 
sensor failed to sense 
plate.

The software and firmware 
are out of date.

Update the DDR 
Diagnostics software to 
version 1.1 or later, and 
update the robot and 
gripper firmware to 
version 1.1 or later.

9149 Homing error: Home index 
pulse off.

Hardware error occurred in 
the motor, encoder, sensor, 
or all.

Contact Automation 
Solutions Technical 
Support.

9150 Homing error: Home index 
pulse on.

Hardware error occurred in 
the motor, encoder, sensor or 
all.

Contact Automation 
Solutions Technical 
Support.

9151 Homing error: Error on 
encoder falling edge.

Hardware error occurred in 
the motor, encoder, sensor or 
all.

Contact Automation 
Solutions Technical 
Support.

9152 Homing error: Error on 
encoder rising edge.

Hardware error occurred in 
the motor, encoder, sensor or 
all.

Contact Automation 
Solutions Technical 
Support.

9153 Homing error: Pulse width 
error found during homing.

Hardware error occurred in 
the motor, encoder, sensor or 
all.

Contact Automation 
Solutions Technical 
Support.

9154 Homing error: Error 
moving away from the 
latched position during 
homing.

An error occurred during the 
homing process.

Contact Automation 
Solutions Technical 
Support.

ID Error message Cause Solution
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9155 Homing error: Error 
moving off of index.

Hardware error occurred in 
the motor, encoder, sensor or 
all.

Contact Automation 
Solutions Technical 
Support.

9156 Homing error: Error 
finding next index.

Hardware error occurred in 
the motor, encoder, sensor or 
all.

Contact Automation 
Solutions Technical 
Support.

9157 Homing error: Via the look 
up table, the absolute 
position of the axis could 
not be determined. Move 
the robot to a new position 
and then retry homing.

Hardware error occurred in 
the motor, encoder, sensor or 
all.

Move the robot to a new 
position and try again.

9158 Homing error: Invalid state 
index specified.

Hardware error occurred in 
the motor, encoder, sensor or 
all.

Contact Automation 
Solutions Technical 
Support.

9161 Labware not present in 
grippers.

The software and firmware 
are out of date.

Update the DDR 
Diagnostics software to 
version 1.1 or later, and 
update the robot and 
gripper firmware to 
version 1.1 or later.

9163 Gripper was not empty 
when it should have been.

You issued a command that 
requires the robot to pick up 
a labware, but the robot is 
currently holding another 
labware.

Remove the labware from 
the robot’s grippers and 
try again.

9164 Gripper should have been 
holding labware.

The software and firmware 
are out of date.

Update the DDR 
Diagnostics software to 
version 1.1 or later, and 
update the robot and 
gripper firmware to 
version 1.1 or later.

9165 Gripper servo error. The robot bumped into an 
obstacle.

Remove all obstacles and 
try again. See the topic on 
recovering from servo 
errors.

9167 While picking: Error 
picking plate from <SRC>.

The software and firmware 
are out of date.

Update the DDR 
Diagnostics software to 
version 1.1 or later, and 
update the robot and 
gripper firmware to 
version 1.1 or later.

9180 Error while homing robot. 
Index transition was not 
found.

Hardware error occurred in 
the motor, encoder, sensor or 
all.

Move the robot to a new 
position and try again.

9183 The robot is in an 
indeterminate position.

Hardware error occurred in 
the motor, encoder, sensor or 
all.

Move the robot to a new 
position and try again.

ID Error message Cause Solution
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9203 Invalid secondary 
teachpoint specified for 
position interpolation.

While setting teachpoints for 
storage devices such as the 
Lid Hotel Station, an 
incorrect coordinate was 
used to determine the 
location of storage slots 
below the reference location 
(top- most platepad in the 
Lid Hotel Station).

Check the reference 
teachpoint, and then reset 
the teachpoints of the 
remaining storage slots.

9204 The position is outside the 
valid Z- axis range.

The robot is unable to move 
to the specified teachpoint. 
The specified gripper offset 
range results in a z- axis 
coordinate that is outside of 
the robot’s physical limit.

Edit the teachpoint. Make 
sure the gripper offset 
range works with the 
desired z- axis coordinate.

9205 Invalid gripper offset 
setting. 

The minimum offset value is 
larger than the maximum 
offset value.

Reset the gripper offset 
values.

9217 The gripper firmware is 
incompatible -  please 
update your gripper 
firmware to the correct 
version.

You have updated the robot 
firmware, but have not yet 
updated the gripper 
firmware.

Update the gripper 
firmware. You must always 
update both firmware at 
the same time.

9224 Error while homing robot. 
Insufficient data found for 
commutation.

During homing of the waist, 
elbow, or wrist the homing 
process could not be 
completed.

Move the robot to a new 
position and try again.

9225 Z- axis commutation timed 
out.

The homing process is too 
long and timed out.

Move the robot to a new 
position and try again.

9242 While retracting after 
place: Error occurred 
during transfer from <SRC> 
to <DST>.

The robot was unable to 
retract to the safe zone 
because an obstacle was in 
the way.

Remove any obstacle in the 
robot's path and try again.

9244 While picking: The 
specified pick location 
would cause the robot to 
move beyond its limits.

The pick action requires that 
the robot move to a location 
that is out of the robot's 
reach.

Check and edit the 
teachpoint. Make sure the 
robot is able to reach the 
location.

9245 While placing: The 
specified place location 
would cause the robot to 
move beyond its limits.

The place action requires 
that the robot move to a 
location that is out of the 
robot's reach.

Check and edit the 
teachpoint. Make sure the 
robot is able to reach the 
location.

11028 Hard E- stop. The Emergency Stop button 
was pressed.

See the topic that explains 
how to recover from an 
emergency stop. You 
cannot resume a run after 
an emergency stop.

ID Error message Cause Solution



7   Maintenance and troubleshooting
Troubleshooting error messages

196 BioCel System User Guide

11028 Hard E- stop. The Emergency Stop button 
was pressed, or something 
interrupted the light beams 
from the Light Curtain posts, 
breaking the safety circuit 
and disabling the robot 
motors.

If you pressed the 
emergency stop button, see 
the topic that explains how 
to recover from an 
emergency stop.

If you interrupted the light 
curtain, remove obstacles 
that might be placed in the 
Light Curtain light paths, 
and then resume the run.

11610 Controller overheating. The CPU exceeded its 
operating temperature for 
too long and the controller 
automatically turned off. If 
this occurs during a run, the 
run will automatically stop. 
The run cannot resume.

Wait approximatly 
10 minutes for the robot to 
cool, power cycle the robot, 
and then try again.

11612 Power supply relay stuck. The robot will not turn on. Restart the robot. The 
power switch is on the 
front of the robot power 
supply.

If restarting the robot does 
not help, the power supply 
unit might need to be 
replaced.

11613 Power supply shorted. Power has been disabled 
because the motor power 
supply has detected that it is 
shorted.

The robot power supply 
unit might need to be 
replaced.

11614 Power supply overloaded. Power has been disabled 
because the motor power 
supply has detected an 
overload condition.

The robot power supply 
unit might need to be 
replaced.

11615 Power supply reset stuck. The robot motor power will 
not turn on.

Restart the robot. The 
power switch is on the 
front of the robot power 
supply.

If restarting the robot does 
not help, the power supply 
unit might need to be 
replaced.

11616 Shutdown due to 
overheating.

The CPU exceeded its 
operating temperature for 
too long and the controller 
automatically turned off.

Wait approximatly 
10 minutes for the robot to 
cool, power cycle the robot, 
and then try again.

13100 Position tracking error 
exceeded threshold.

The robot was unable to 
follow its intended trajectory, 
possibly because it bumped 
into an obstacle.

Remove all obstacles and 
try again.

ID Error message Cause Solution
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13104 Motor duty cycle exceeded. An obstacle is preventing the 
robot from moving.

Remove all obstacles and 
try again.

13105 Motor stalled. The robot bumped into an 
obstacle.

Remove all obstacles and 
try again.

13106 Axis over- speed. This error is generated when 
power is enabled or during 
normal running if the system 
detects that an axis has 
violated a speed limit.

Remove all obstacles and 
try again.

13107 Amplifier over- current. An obstacle is preventing the 
robot from moving.

Remove all obstacles, home 
the robot, and try again.

13109 Amplifier under- voltage. The DC motor bus has 
dropped too low.

Check all cable 
connections. If the cables 
are correctly connected, 
the power supply might be 
be failing.

In the DDR Diagnostics 
Advanced tab, note the Bus 
Voltage values and report 
the values to Automation 
Solutions Technical 
Support.

13113 Motor commutation setup 
failed.

The configuration files are 
corrupted.

Click Retry in the error 
dialog box.

13117 Amplifier RMS current 
exceeded.

An obstacle is preventing the 
robot from moving.

Remove all obstacles and 
try again.

13122 Position tracking error 
exceeded threshold.

The robot was unable to 
follow its intended trajectory, 
possibly because it bumped 
into an obstacle.

Remove all obstacles and 
try again.

ID Error message Cause Solution
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3-Axis Robot error messages

The following table lists error messages that might appear in 3- Axis Robot 
Diagnostics, the causes of the errors, and ways to resolve the errors. If you are 
still experiencing problems with the BioCel System after trying the solutions, 
contact Automation Solutions Technical Support.

For the list of error message that might appear during a protocol run, see the 
VWorks Automation Control User Guide.

The following error messages are listed alphabetically within each category:

• During initialization

• During operation

During initialization
The following error messages are displayed during the initialization process.

Error message Cause Solution

Could not open 
robot COM port.

Another program is using the 
robot’s COM port.

Quit the program that is using the COM 
port. If necessary, restart the VWorks 
software.

If the problem continues, contact 
Automation Solutions Technical 
Support.

Could not open BCR 
COM port.

Another program is using the 
BioCel System barcode reader COM 
port.

Quit the program that is using the COM 
port. If necessary, restart the VWorks 
software.

If the problem continues, contact 
Automation Solutions Technical 
Support.

Could not 
communicate with 
the robot.

The robot is not connected to the 
controlling computer.

Check that the robot is connected to 
the controlling computer.

The incorrect profile is used. In the 3- Axis Robot Diagnostics Profiles 
tab, make sure the correct profile is 
selected.

Could not 
communicate with 
robot during 
firmware version 
query.

The robot is not connected to its 
power source or is not turned on.

Make sure the robot is connected to its 
power source. Make sure the robot is 
turned on.

If the problem persists, contact 
Automation Solutions Technical 
Support.

The Agilent Technologies macros 
are not loaded into the robot.

Load the macros in the robot. For 
details, contact Automation Solutions 
Technical Support.

Could not 
communicate with 
robot during macro 
file query.

The software is unable to locate 
the correct macro file.

Contact Automation Solutions Technical 
Support.

Incorrect macro file 
loaded in robot.

The upgraded robot ActiveX 
requires updated macros.

Contact Automation Solutions Technical 
Support to update the macros.
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During operation
The following 3- Axis Robot Diagnostics error messages are displayed during 
diagnostic operation.

Error retrieving 
robot status.

The robot returned a response not 
recognized by the software.

Contact Automation Solutions Technical 
Support.

A servo error 
occurred during 
homing.

The robot was unable to move to 
its home position, because 
something is blocking its path.

Remove any obstacles in the robot’s 
path and retry the initiation procedure.

If the problem persists, contact 
Automation Solutions Technical 
Support.

Timeout waiting for 
robot to home.

The robot did not reach its home 
position in the time expected.

Make sure obstacles are not preventing 
the robot from moving. Retry the 
command.

If the problem persists, contact 
Automation Solutions Technical 
Support.

Error message Cause Solution

Error message Cause Solution

A robot macro did not 
complete execution.

The robot was commanded to carry 
out a task but did not signal that 
it has completed the task.

Retry the command.

If the problem persists, contact 
Automation Solutions Technical 
Support.

Is <location> an illegal 
teachpoint? Check that 
z- height is within 
robot's work envelope.

The robot was asked to move to a 
location it cannot reach.

Check the teachpoint of the target 
location. Make sure the location is 
within the robot’s workspace.

Time out waiting for 
teachpoint <teachpoint 
name> upload 
response.

The robot was commanded to carry 
out a task but did not signal that 
it has completed the task.

Retry the command.

If the problem persists, contact 
Automation Solutions Technical 
Support.
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Failed to sense plate 
when picking from 
<location>.

The labware was not in the robot’s 
grips as expected because:

• The labware might have been 
knocked out of the robot’s 
grips.

• The labware is missing at the 
expected location.

• The robot did not pick up the 
labware.

Check the labware definition. Make 
sure the parameter values are set 
correctly for the particular labware.

Check the teachpoint of the pickup 
location. Edit the teachpoint if 
necessary.

Check that the labware is placed 
correctly at the teachpoint.

Check the approach and departure 
height values.

If the problem persists, contact 
Automation Solutions Technical 
Support.

The plate sensor requires 
calibration.

Contact Automation Solutions 
Technical Support.

Could not retrieve 
status from robot.

The software is unable to receive 
robot status.

Make sure:

• The system is turned on.

• The communication hubs are 
turned on.

• The communication cables 
between the robot and the 
computer are connected.

After placing at 
<location>, a plate was 
sensed in the gripper 
when it should be 
empty.

The robot air pressure might not 
be correct.

Check and adjust the air pressure to 
the robot. Make sure there are no 
leaks in the air line.

The plate sensor requires 
calibration.

Contact Automation Solutions 
Technical Support.

A plate was not 
detected in the gripper 
during the place to 
<location>.

The robot air pressure might not 
be correct.

Check and adjust the air pressure to 
the robot. Make sure there are no 
leaks in the air line.

The plate sensor requires 
calibration.

Contact Automation Solutions 
Technical Support.

After one failed delid 
attempt, the robot 
could not re- energize 
servos and retract the 
arm.

During delidding, the servo power 
to the robot died. The system 
automatically attempts to reactivate 
the servos but fails.

Restart the system.

If the problem persists, contact 
Automation Solutions Technical 
Support.

A servo error occurred 
on: <location>.

Something is blocking the robot’s 
path.

Remove obstacles in the robot’s path.

The robot is commanded to move 
faster than its capability given its 
current load.

Reduce the robot speed in the 
Labware Editor.

Error message Cause Solution
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A servo error has 
occurred but it could 
not be determined 
which axis failed.

Something is blocking the robot’s 
path.

Remove obstacles in the robot’s path.

The robot is commanded to move 
faster than its capability given its 
current load.

Reduce the robot speed in the 
Labware Editor.

Robot emergency stop 
or door interlock 
detected.

Something interrupted the light 
beams from the Light Curtain 
posts, breaking the safety circuit 
and disabling the robot motors.

Remove objects that might be placed 
in the Light Curtain light paths. See 
“Recovering from an emergency stop” 
on page 175.

The Emergency Stop button is 
pressed.

See “Recovering from an emergency 
stop” on page 175.

The robot did not 
acknowledge that it 
completed its last 
move.

The robot did not signal that it has 
completed the task.

Retry the command.

If the problem persists, contact 
Automation Solutions Technical 
Support.

Error resetting COM 
port.

The controlling computer cannot 
close and reopen the robot port.

Retry the command.

If the problem persists, contact 
Automation Solutions Technical 
Support.

Regripping necessary, 
but the regripping 
station has not been 
taught.

The robot needs to regrip a 
labware, but the regripping station 
is not found.

Set the teachpoint for the regripping 
station.

The regripping station 
cannot be used as a 
pickup or dropoff 
location until it has 
been taught.

The robot needs to regrip a 
labware, but the regripping station 
is not found.

Set the teachpoint for the regripping 
station.

Lid detection error. The incorrect labware type is used 
in the protocol.

Check the labware type used in the 
protocol.

Lid Hotel Station sensors are not 
working.

Make sure the delidder device is 
connected to its power source. If it 
is, do the following:

1 Open the Lid Hotel Station 
Diagnostics.

2 Depress the delidder arms on the 
robot’s left side.

3 Check and see if the status lights 
of the arms you pressed turn on.

If the status lights do not turn on as 
you press them, contact Automation 
Solutions Technical Support.

Lid Hotel Station teachpoints are 
incorrect.

Verify the Lid Hotel Station 
teachpoints. Edit them if necessary.

Error message Cause Solution
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Related information

For information about... See...

BioCel System component names “Hardware overview” on page 7

Hardware problems “Troubleshooting hardware problems” 
on page 183

Recovering from emergency stops “Recovering from an emergency stop” 
on page 175

Recovering from power outage “Recovering from a power outage” on 
page 179

Recovering from servo errors “Recovering from servo errors” on 
page 180

Troubleshooting plate- sensor error “Troubleshooting plate- sensor errors” 
on page 182

Safety BioCel System Safety Guide

Reporting problems to Agilent 
Technologies

“Reporting problems” on page 203
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Reporting problems

Contacting Automation Solutions Technical Support 

If you find a problem with the BioCel System, contact Automation Solutions 
Technical Support at one of the following:

Europe

Phone: +44 (0)1763850230

email: euroservice.automation@agilent.com

US and rest of world

Phone: 1.800.979.4811 (US only) or +1.408.345.8011

email: service.automation@agilent.com

Note: You can also send a software bug report from within the VWorks 
software.

Reporting hardware problems

When contacting Agilent Technologies, make sure you have the serial number 
of the device ready.

Reporting software problems

When you contact Automation Solutions Technical Support, make sure you 
provide the following:

• Short description of the problem

• Software version number

• Error message text (or screen capture of the error message dialog box)

• Screen capture of the About VWorks software dialog box.

• Relevant software files

To find the VWorks software version number:

In the VWorks software, select Help > About VWorks.

To find the Diagnostics software version number:

1 Open Diagnostics.

2 Read the version number on the title bar of the diagnostics window.

To send compressed protocol and associated files in VZP format:

In the VWorks software, select File > Export to export and compress the 
following files:

• Protocol file

• Device file (includes the device profile and teachpoint file)

• Labware definitions

• Liquid classes

• Pipette techniques

• Hit- picking files

mailto:euroservice.automation@agilent.com
mailto:service.automation@agilent.com
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• Plate map files

• Barcode files

• Error library

• Log files

• Form file (*.VWForm)

Reporting user guide problems

If you find a problem with this user guide or have suggestions for 
improvement, send your comments using one of the following methods:

• Click the feedback button ( ) in the online help.

• Send an email to documentation.automation@agilent.com.
Related information

For information about... See...

Hardware problems “Troubleshooting hardware problems” 
on page 183

Software error messages “Troubleshooting error messages” on 
page 189

Recovering from emergency stops “Recovering from an emergency stop” 
on page 175

Recovering from power outage “Recovering from a power outage” on 
page 179

Recovering from servo errors “Recovering from servo errors” on 
page 180

Troubleshooting plate- sensor error “Troubleshooting plate- sensor errors” 
on page 182

Safety BioCel System Safety Guide

mailto:documentation.automation@agilent.com
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8
Using diagnostic tools

This chapter explains how to use the provided software tools to 
diagnose and troubleshoot the BioCel System.

Agilent Technologies recommends that only administrators and 
experienced personnel use the procedures in this chapter to 
diagnose problems with the BioCel System.

This chapter contains the following topics:

• “DDR Diagnostics” on page 206

• “3- Axis Robot Diagnostics” on page 229

• “KiNEDx Robot Driver Diagnostics” on page 237

For information about the Staubli robot, see the Staubli TX60 
Device Driver User Guide.

http://www.chem.agilent.com/Library/usermanuals/Public/G5415-90049_DDUG_EN.pdf
http://www.chem.agilent.com/Library/usermanuals/Public/G5415-90049_DDUG_EN.pdf
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DDR Diagnostics

About DDR Diagnostics 

The DDR Diagnostics software allows you to control the motions of the Direct 
Drive Robot. The software has six tabs: Jog/Move, Teachpoints, Cycler, Setup, 
Advanced, and Profiles. You use the commands and parameters available in the 
these tabs to troubleshoot problems.

 

This topic explains the following:

• “Homing the Direct Drive Robot and grippers” on page 207

• “Moving the Direct Drive Robot into the safe zone” on page 208

• “Disabling and enabling the Direct Drive Robot motors” on page 210

• “Stopping the robot motors” on page 211

• “Changing the Direct Drive Robot speed” on page 211

• “Changing the robot speed definitions” on page 212

• “Jogging the Direct Drive Robot” on page 214

• “Opening and closing the Direct Drive Robot grippers” on page 216

• “Changing the gripper settings” on page 218

• “Checking the Direct Drive Robot microplate sensor” on page 220

• “Changing the Direct Drive Robot display” on page 221

• “Checking the temperature and bus voltage” on page 222

• “Restoring the robot settings” on page 223

• “Updating the firmware” on page 224

• “Backing up the robot firmware” on page 226
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• “Restoring existing firmware” on page 226

• “Viewing the DDR Diagnostics log area” on page 228

See “Quick reference” on page 355 for the complete list of available commands 
you can use.

For instructions on setting and verifying teachpoints, see “Setting Direct Drive 
Robot teachpoints” on page 69.

For information about using the Profiles tab, see “Creating and managing 
Direct Drive Robot profiles” on page 47.

Homing the Direct Drive Robot and grippers

You can home the grippers independently of the robot.

Homing the robot
Homing the robot sends the robot to the factory- defined home position for 
each of the axes of motion. To home the grippers, see “Homing the robot 
grippers” on page 208.

Home the robot if you notice that the robot is not accurately picking up or 
placing labware. You might also want to home the robot after recovering from 
an emergency stop.

Note: The robot homes automatically only when you initialize the robot. If the 
robot is already homed, the robot will skip the homing process during 
initialization.

To home the robot:

In the Jog/Move tab, click Home robot. The robot moves its joints until it finds 
the home position. 

                                                        

WARNING  Be sure to wear protective eyewear when entering the system and working 
with the robot.

WARNING  Stay out of the system while the robot is in motion.
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The homing process can take up to 2 minutes. During this time, the robot:

1 Checks for the presence of labware in its grippers. If labware is present, 
the software presents an error message. You must first remove the labware 
before homing.

2 Homes the grippers.

3 Looks for the home position for each joint (waist, elbow, and wrist) and 
moves to the home positions.

4 Looks for the home position along the z- axis and moves to the home 
position.

Note: If the robot hand is at the same height as the robot base, the robot will 
first raise the arm to clear the base before starting the homing sequence.

Homing the robot grippers
Homing the grippers does not home the rest of the robot. 

To home the robot grippers:
In the Jog/Move tab, click Home grippers. The robot opens and closes its gripers 
until it finds the home position.

Moving the Direct Drive Robot into the safe zone

The safe zone is the region within which the robot is allowed to move without 
colliding with external devices. For the Direct Drive Robot, it is the cylindrical 
region within the red- dotted line as shown in the following diagram. The 
radius of the cylinder, measured from the center of the base, is 29.1 cm 
(11.4 in).

WARNING  Be sure to wear protective eyewear when entering the system and working 
with the robot.

WARNING  Stay out of the system while the robot is in motion.
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In general, the Direct Drive Robot moves into the safe zone after it completes 
a Move to, Pick from, Place to, or Transfer command. However, you can move 
the robot into the safe zone at other times to move it out of the way.

To move the robot into the safe zone:

Click one of the following:

29.1 cm

CAUTION Make sure you save new teachpoints in the teachpoint file before moving the 
robot. The robot can crash into devices at unknown (unsaved) teachpoints.

WARNING  Stay out of the system while the robot is in motion.
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Disabling and enabling the Direct Drive Robot motors

Disabling the robot motors allows you to move the robot by hand. When you 
disable the robot motors, the robot will first finish the current command 
before stopping.

IMPORTANT You can disable the robot joint motors, but you cannot disable 
the z- axis motor. Therefore, you can move the robot by hand in the plane of 
the robot arm, but you cannot change its height.

Note: If the system is not running a protocol, and the robot remains inactive 
for 10 minutes, the motors are automatically disabled.

To disable or enable the robot motors:

In the DDR Diagnostics Jog/Move tab, click Disable Motors or Enable Motors. 

 

Command Description

Move to safe zone The robot searches for the closest teachpoint, 
and then uses the safest path from that 
teachpoint to the safe zone.

If the robot is unable to find a teachpoint 
nearby, it retracts radially into the safe zone.

Use the Move to safe zone command if it is 
close to a teachpoint and the path from that 
teachpoint to the safe zone is clear of 
obstacles.

Retrace to safe zone The robot searches for the closest teachpoint, 
and then uses the path from that teachpoint 
to the safe zone.

If the robot is unable to find a teachpoint 
nearby, it will retreat into the safe zone by 
retracing the path it took to reach the current 
location.

Use the Retrace to safe zone command when, 
for example, the robot grippers are within a 
device, and using the Move to safe zone 
command might cause the robot to run into 
the sides of the device or other obstacles.

WARNING  The robot arm might move when the motors are being enabled. Stay out of 
the system when you enable the robot.
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Stopping the robot motors

In an emergency, you can use the Stop Motors command to cut power to the 
robot motors, thus stopping the robot immediately.

To stop the robot motors:
In DDR Diagnostics, click Stop Motors at the bottom of the dialog box. The robot 
stops immediately. 

Alternatively, if the pointer or cursor is not currently in any text box in the 
dialog box, you can press the space bar on the keyboard to stop the robot 
motors.

 

For information about using the emergency stop button on the power panel or 
the system table, see “Stopping a run in an emergency” on page 171.

Changing the Direct Drive Robot speed

You can select the robot speed to accommodate the task you are performing. 
For example, you can select the Slow speed when you are creating new 
teachpoints or diagnosing problems with the system. When you are confident 
that problems are resolved and want to run a final check, you can select the 
Fast speed.

The speed you select in DDR Diagnostics applies only to the robot commands 
in DDR Diagnostics (jog direction, Move to, Pick from, Place to, and Transfer).

To select the robot speed:
In DDR Diagnostics, select one of the following from the Speed list: Fast, Medium, 
or Slow.

Note: During a protocol run, the robot will use the speed selection in the 
VWorks software Tools > Options dialog box. If the robot is holding a 
microplate, the slower of the following will be applied: the speed in the 
Labware Editor or the speed in the Tools > Options dialog box. For more 
information, see the VWorks Automation Control Setup Guide and VWorks 
Automation Control User Guide.
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Changing the robot speed definitions
Three robot speeds (Fast, Medium, Slow) are available for selection in DDR 
Diagnostics, VWorks Options (under the Tools menu), and Labware Editor. You 
select a robot speed to accommodate the task you are performing. For 
example, you can select the Slow speed when you are creating new 
teachpoints, creating and testing protocols, or diagnosing problems with the 
system.

Each speed is defined as a percentage of the factory- set maximum speed. By 
default, the percentages are defined as follows:

You can change these speed definitions to accommodate your laboratory’s 
needs.

IMPORTANT The speed definitions are universal and apply to the speeds you 
select in DDR Diagnostics, Labware Editor, and the VWorks Options dialog box.

Note: The speed you select in DDR Diagnostics applies only to the robot 
commands in DDR Diagnostics (Jog, Move, Transfer, and so on). If the robot is 
holding a labware, the slower of the following will be applied: the speed you 
selected in the Labware Editor, or the speed you selected in DDR Diagnostics.

Similarly the speed selection in VWorks Options (under the Tools menu) 
applies to protocol runs. If the robot is holding a labware, the slower of the 
following will be applied: the speed you selected in the Labware Editor, or the 
speed you selected in VWorks Options.

Backing up existing settings
Agilent Technologies recommends that you back up the existing speed 
definitions before changing them.

To back up existing settings:

1 In the DDR Diagnostics Setup tab, click Save ALL advanced settings to file. 

Speed Default

Slow 20%

Medium 50%

Fast 80%
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2 In the Save As dialog box that opens, type a name for the backup file. You 
can use the default backup file location, or select a different location. The 
default location is 
C:\Program Files\Agilent Technologies\Settings\DDR\FirmwareBackup.

3 Click Save. The robot settings are saved in an XML file.

Specifying new speed definitions

To change the speed definitions:

1 In DDR Diagnostics, click the Setup tab.
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2 In the Speed Definitions area, type the new percentage for one or more of 
the speeds you want to re- define.

3 When you are finished, click Apply. The changes are saved to the firmware.
 

Jogging the Direct Drive Robot

Jogging the robot moves the robot in small, precise increments. You can jog the 
robot to fine- tune its position when creating and editing teachpoints or during 
troubleshooting.

The Direct Drive Robot movements can be controlled or monitored from two 
different perspectives:

• Joint space. You can use a joint- space command to rotate the robot about 
its waist (1), rotate its forearm about the elbow (2), or rotate the hand 
about the wrist (3). In addition, you can move the robot arm up and down 
along the mast or z- axis (4).

• Tool space. You can use a tool- space command to move a combination of 
robot joints so that the labware moves to its target location along the x- or 
y- axis. In addition, you can rotate the labware (Phi angle) and move the 
robot arm up and down along the mast or z- axis. In tool space, all 
movements are measured with respect to the center of the labware.

1

2

3

4
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To select a perspective:

In the Jog/Move tab, select Tool space (1) or Joint space (2).

To jog the robot:

1 Select or type the jog increment for the axis or joint you want to move. 
The jog increments are in millimeters or degrees.

                                                        

A
1

CAUTION Always select small jog increments so that the robot does not bump into 
obstacles in its path.
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2 Click one of the jog direction buttons. 

In the Robot Status area, the current joint and z- axis coordinates are 
updated.

 

Opening and closing the Direct Drive Robot grippers

You can open the robot grippers to release labware. You can close the robot 
grippers to hold labware.

To open or close the robot grippers:
In the Jog/Teach tab, click Open or Close for the desired orientation.

WARNING  Stay out of the system while the robot is in motion.

WARNING  Be sure to wear protective eyewear when entering the system and working 
with the robot.

WARNING  Stay out of the system while the robot is in motion.



217

8   Using diagnostic tools
DDR Diagnostics

BioCel System User Guide

Alternatively, you can right- click the robot arm or mast in the Robot Status 
area, and then click the open or close gripper command for the desired 
orientation.

To open or close the grippers incrementally:

1 In the Jog/Teach tab, select or type the jog increment for the grippers.

 IMPORTANT The jog increment applies to both grip directions.

CAUTION Always select smaller jog increments so that the robot does not bump into 
labware when it opens its grip, or bend the labware when it closes its grip.
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2 Click either the open or close gripper buttons.

 

Changing the gripper settings
The following gripper settings are set at the factory:

The default gripper settings should work for labware that meet the American 
National Standards Institute (ANSI) standards. However, you can fine- tune the 
settings to accommodate different labware materials, such as soft PCR 
microplates.

Gripper setting Description

Open pos The distance, in millimeters, between the grippers 
when they are open. The default values are:

• 132 mm (landscape)

• 95 mm (portrait)

Close target The approximate distance, in millimeters, between 
the grippers when they are closed. The default 
values are:

• 123.5 mm (landscape)

• 81.5 mm (portrait)

The Close target value is always used with the 
Close tolerance value. When picking up labware, 
the grippers close until the Grip torque (set in 
the Labware Editor) is reached. Then, the robot 
checks to see if the distance between the grippers 
is within the Close target value +/-  the Close 
tolerance value. If it is outside the summed value, 
the software will display an error message.

Close tolerance The distance, in millimeters, the Close target is 
allowed to vary without causing an error. The 
default value is +/- 3 mm.
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Backing up existing settings
Agilent Technologies recommends that you back up the existing gripper 
settings before changing them.

To back up existing settings:

1 In the DDR Diagnostics Setup tab, click Save ALL advanced settings to file. 

2 In the Save As dialog box that appears, type a name for the backup file. 
You can use the default backup file location, or select a different location. 
The default location is 
C:\Program Files\Agilent Technologies\Settings\DDR\FirmwareBackup.

3 Click Save. The robot settings are saved in an XML file.

Specifying new settings

To change the gripper settings:

1 In DDR Diagnostics, click the Setup tab.
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2 In the Gripper Settings area, type the new values you want to use for Open 
pos, Close target, and Close tolerance.

3 When you are finished, click Apply. The changes are saved to the firmware.

Checking the Direct Drive Robot microplate sensor

The microplate sensor under the robot hand is used to detect the presence of 
labware in its grip. If you suspect that the microplate sensor is not working 
correctly, you can check to see if it requires recalibration.

To check the microplate sensor:

1 Move the robot to a teachpoint that has a labware.

2 Move the robot up so that it is at the correct robot gripper offset for the 
labware.

3 Close the gripper.

4 Move the robot away from the teachpoint. The microplate sensor is highly 
sensitive and might detect the plate stage or platepad as labware. Moving 
the robot away from any teachpoint would provide the most accurate 
detection result.
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5 In the Robot Status area, check the Plate sensor indicator.

If the indicator light is on, the microplate sensor is detecting a labware in 
its grippers.

If the indicator light is off, the microplate sensor is not detecting labware. 
Contact Automation Solutions Technical Support to see if the sensor needs 
to be recalibrated.

6 Open the gripper to release the labware.
 

Changing the Direct Drive Robot display

In the Robot Status area, a graphical representation of the Direct Drive Robot 
shows the robot posture, teachpoints, and the system table. You can change the 
view using the buttons above the image.

                                                        

Button Description

 Pans, or moves the image. Click the button, and then drag 
the image in the desired direction.

 Rotates the image. Click the button, and then drag the image 
to rotate it in the desired direction. Alternatively, click the 
middle mouse button or wheel, and then drag the image to 
rotate it.

 Increases or reduces the image magnification. Click the 
button, and then drag the image upward or downward to 
increase or decrease the magnification respectively. 
Alternatively, scroll the mouse wheel to change the 
magnification.

 Resets the image to the default view.

 Saves the current view as the default view.
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Checking the temperature and bus voltage

The robot temperature and bus voltage can be useful for troubleshooting 
problems. This topic explains where you can find the temperature and bus 
voltage information.

Checking the temperature
Sensors inside the robot monitor the temperature of different components. The 
temperatures are displayed in the Advanced tab, and the values are updated 
every 2 seconds.

If the any of the temperatures rise above the factory- set threshold value, the 
robot will shut down and display an error. If this happens, contact Automation 
Solutions Technical Support.
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Checking the bus voltage
Voltages delivered to robot motors are displayed in the Advanced tab. The 
values are updated every 2 seconds.

The voltage values can be used to troubleshoot problems. For example, the bus 
voltage values are reduced signficantly when the motors are disabled. If this 
happens and you did not disable the motors, contact Automation Solutions 
Technical Support.
 

Restoring the robot settings

In the Setup tab, when you click the Save ALL advanced settings to file, the 
software saves all of the values that are in the Setup tab to an XML file, also 
called a configuration file. If any of the settings were lost, you can recover 
them using the XML file.

To restore the robot settings:

1 In the Setup tab, click Restore All advanced settings from file.
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2 In the Open dialog box, locate and select the desired configuration file.

3 Click Open. The settings are restored.

Updating the firmware

The Direct Drive Robot is controlled by the following:

• Robot firmware. Controls the robot arm.

• Gripper firmware. Controls the robot grippers only.

This section explains how to check the firmware versions you are using and 
update both firmware.

Agilent Technologies recommends that only administrators and trained 
personnel use the procedures in this topic to update the BioCel System 
firmware.

Firmware compatibility
Agilent Technologies will release compatible robot and gripper firmware 
together, so you should always update both the robot firmware and the gripper 
firmware at the same time. Failure to do so will cause an error message 
during initialization.

CAUTION The procedures in this topic is for BioCel 900 robot firmware version 1.2.0 or 
later. For robot firmware version 1.1.x or earlier, contact Automation Solutions Technical 
Support before updating the firmware.
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Before you start
Before you start to update the existing firmware:

• Save the existing robot settings. In the Setup tab, click Save ALL advanced 
settings to file.

• Make sure you have the correct files for the update process:

– DDRFirmwareUpdate_x_x_x- .zip. Updates the existing robot firmware 
and retains the existing robot settings, such as robot table dimensions.

– DDRGripperx.x.sw. Installs the new gripper firmware.

Note: At the beginning of the update process, the software will automatically 
back up the current robot firmware. You do not need to manually back up the 
firmware.

Checking the firmware versions you are running

To check the firmware versions you are currently running:
In DDR Diagnostics, click the About button at the bottom of the dialog box. The 
About DDR Plugin dialog box appears and displays the robot and gripper 
firmware version numbers. Note the firmware version numbers.

Updating the robot and gripper firmware

To upgrade the robot and gripper firmware: 

1 In the Advanced tab, click one of the following:

• Update robot firmware

• Update gripper firmware

2 In the Open dialog box that appears, locate and select the desired firmware 
file:

• DDRFirmwareUpdate_x_x_x- .zip (if you are updating the robot 
firmware)

• DDR_Gripperx.x.sw (if you are updating the gripper firmware)

 IMPORTANT Robot firmware update only. If you select a file that does 
not have the DDRFirmware character string in the name, the update 
procedure will fail.

3 Click Open. Follow the instructions on the screen to install the firmware.

CAUTION If you have BioCel 900 robot firmware version 1.1.x or earlier, contact 
Automation Solutions Technical Support before updating the firmware.
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Backing up the robot firmware

You should back up the robot firmware in case it becomes damaged. The 
backup process backs up the robot firmware only. It does not back up the 
gripper firmware.

This topic explains how to back up the existing robot firmware.

Agilent Technologies recommends that only administrators and trained 
personnel use the procedures in this topic to back up the BioCel System 
firmware.

To back up the existing firmware

1 In the DDR Diagnostics Profiles tab, make sure the correct profile is selected, 
and then click Initialize this profile.

 IMPORTANT Communication must be established with the robot for the 
backup procedure to be successful.

2 In the DDR Diagnostics Advanced tab, click Backup firmware.

3 In the Save As dialog box that opens:

a Type a name for the backup file.

IMPORTANT The file name must contain the character string 
DDRFirmware. The software uses the string to identify the file 
during firmware updates. For example, a valid name is 
DDRFirmwareBackup_20100310_112905.zip.

b Use the default backup file location, or select a different location. The 
default location is 
C:\Program Files\Agilent Technologies\Settings\DDR\Firmware Backup.

4 Click Save. The robot firmware is saved in a ZIP file.

Restoring existing firmware

In case the firmware files become damaged and the robot no longer operates, 
you can use a backup copy of the firmware to restore robot operation.

This topic explains how to use firmware backup files to restore robot 
operation.

Agilent Technologies recommends that only administrators and trained 
personnel use the procedures in this topic to restore the BioCel System 
firmware.
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Before you start
Make sure you have the correct files for the procedure:

• DDRFirmwareBackup_<date>.zip. The backup copy of the existing robot 
firmware.

• DDRGripperx.x.sw. The gripper firmware file that accompanies the robot 
firmware update file from Agilent Technologies.

• <filename>.xml. The XML file that contains the robot settings, such as robot 
table dimensions, gripper settings, and so on. This file is created when you 
click Save ALL advanced settings to file in the Setup tab.

Installing the robot and gripper firmware

To restore or install the robot and gripper firmware: 

1 In the Advanced tab, click one of the following:

• Update robot firmware

• Update gripper firmware

2 In the Open dialog box that appears, locate and select the desired firmware 
file:

• DDRFirmwareBackup_<date>.zip (if you are restoring the robot 
firmware using a backup copy)

• DDR_Gripperx.x.sw (if you are installing the gripper firmware)

 IMPORTANT Robot firmware update only. If you select a file that does 
not have the DDRFirmware character string in the name, the procedure 
will fail.

3 Click Open. Follow the instructions on the screen to install the firmware.

4 To restore the robot settings, in the Settings tab, click Restore ALL advanced 
settings from file.

CAUTION Use the instructions in this topic only if you have determined the firmware files 
are damaged. If you are not sure, contact Automation Solutions Technical Support for 
assistance.

CAUTION Do not use this procedure to update firmware. The restoration procedure will 
install the backup firmware and erase existing robot settings.

CAUTION The procedure in this topic is for BioCel 900 robot firmware version 1.2.0 or later. 
For robot firmware version 1.1.x or earlier, contact Automation Solutions Technical Support.
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Viewing the DDR Diagnostics log area

The log area at the bottom of the dialog box shows the status of the commands 
or actions issued while you are working in the dialog box.

 

Related information

For information about... See...

Direct Drive Robot description “Direct Drive Robot” on page 15

Setting up the Direct Drive Robot “Setting up the Direct Drive Robot” on 
page 45
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3-Axis Robot Diagnostics

About 3-Axis Robot Diagnostics 

The 3- Axis Robot Diagnostics software allows you to control the motions of the 
3- Axis Robot. The software has two tabs: Diagnostics and Profiles. You use the 
command and parameters available in the Diagnostics tab when 
troubleshooting problems.

This topic explains the following:

• “Homing the 3- Axis Robot” on page 230

• “Resting the 3- Axis Robot” on page 230

• “Disabling and enabling the 3- Axis Robot motors” on page 231

• “Changing the 3- Axis Robot speed” on page 231

• “Jogging the 3- Axis Robot” on page 232

• “Opening and closing the 3- Axis Robot grippers” on page 233

• “Checking the 3- Axis Robot plate sensor” on page 234

• “Scanning a barcode label” on page 235

• “Ignoring 3- Axis Robot errors” on page 235

• “Checking communication time” on page 236

See “Quick reference” on page 355 for the complete list of available commands 
you can use.

For instructions on setting and verifying teachpoints, see “Setting 3- Axis Robot 
teachpoints” on page 117.

For information about using the Profiles tab, see “Creating and managing 3-
Axis Robot profiles” on page 113 and “Quick reference” on page 355.
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Homing the 3-Axis Robot

Homing the robot sends the robot to the factory- defined home position for 
each of the three axes of motion. The homing process recalibrates the robot 
position along each axis so that the home z, r, and t coordinates are 0, 0, 0.

Home the robot if you notice that the robot is not accurately picking up or 
placing labware. You might also want to home the robot after recovering from 
an emergency stop or after the robot collides with an obstacle.

Note: The robot homes automatically each time you start the VWorks software.

To home the robot:
In the Controls tab Position Control area, click Home.

Resting the 3-Axis Robot

Resting the robot sends the robot directly to the factory- defined home position 
without recalibrating each axis of motion. Therefore, resting the robot is faster 
than homing the robot.

Use the command when you want to move the robot to the home position 
quickly without recalibration.

To rest the robot:

In the Controls tab Position Control area, click Move to rest position.
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Disabling and enabling the 3-Axis Robot motors

Disabling the robot motors allows you to move the robot by hand, making it 
easier to set and edit teachpoints.

Note: You can disable the robot r- axis and t- axis motors. You cannot disable 
the z- axis motor. Therefore, you can move the robot by hand in the plane of 
the robot arm, but you cannot change its height.

To disable or enable the robot motors:
In the Controls tab Servo Control area, click one of the following:

For the description of the axes, see “Jogging the 3- Axis Robot” on page 232.

Changing the 3-Axis Robot speed

You can select the robot speed to accommodate the task you are performing. 
For example, you can select the Slow speed when you are creating new 
teachpoints, creating and testing protocols, or diagnosing problems with the 
system. When you are ready to run a protocol that you have tested, you can 
select the Fast speed.

To select the robot speed:
In the Controls tab Robot Speed area, select one of the following: Fast, Medium, or 
Slow.

The speed you select in 3- Axis Robot Diagnostics applies only to the robot 
commands in Robot Diagnostics (jog direction, Move to point, Pick & Place, 
and so on). If the robot is holding a microplate, the slower of the following will 
be applied: the speed you selected in the Labware Editor or the speed you 
selected in 3- Axis Robot Diagnostics.

Note: During a protocol run, the robot will use the speed selection in the 
VWorks software Tools > Options dialog box. If the robot is holding a 
microplate, the slower of the following will be applied: the speed in the 
Labware Editor or the speed in the Tools > Options dialog box. For more 
information, see the VWorks Automation Control User Guide.

Selection Description

R & T servos on Turns on the r- axis and t- axis motors.

R & T servos off Turns off the r- axis and t- axis motors.
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Jogging the 3-Axis Robot

Jogging the robot moves the robot and robot grippers in small, precise 
increments along one of the axes. You can jog the robot to fine- tune its 
position when creating and editing teachpoints or during troubleshooting.

To jog the robot:

1 In the Controls tab, enable the robot motors. See “Disabling and enabling 
the 3- Axis Robot motors” on page 231.

2 If you intend to pick up a labware, specify the gripper offset, the height at 
which the robot should grip the labware (usually 2–3 mm above the 
teachpoint height). To do this, in the Labware Settings area, either:

• Select a labware from the list. The offset value for that labware 
appears in the Gripper offset box.

• Enter a temporary value directly in the Gripper offset box. The 
temporary value is used only during the current diagnostic session. To 
save the new value for the labware, use the Labware Editor. For 
instructions, see the VWorks Automation Control Setup Guide.

3 To set or change the jog increment, in the Jog increment (mm or degrees) box, 
type the increment value you want to use.

 IMPORTANT The jog increment applies to all jog directions.

                                                        

CAUTION Always select smaller jog increments so that the robot does not bump into 
obstacles in its path.
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4 In the Position Controls area, click one of the following jog direction buttons. 
The display to the left of the jog direction buttons shows the current 
coordinates of the robot relative to the home position.

Opening and closing the 3-Axis Robot grippers

You can open the robot grippers to release labware. You can close the robot 
grippers to hold labware.

To open or close the robot grippers:

1 In the Position Control area, set or change the open or close increment. To 
do this, in the Jog increment (mm or degrees) box, type the increment value 
you want to use.

 IMPORTANT The jog increment applies to both grip directions.

Command Description

 Down Jogs the robot down by the specified increment.

 Up Jogs the robot up by the specified increment.

 In Jogs the robot inward by the specified increment.

 Out Jogs the robot outward by the specified increment.

 CW Jogs the robot clockwise by the specified 
increment.

 CCW Jogs the robot counterclockwise by the specified 
increment.

CAUTION Always select smaller jog increments so that the robot does not bump into 
labware when it opens its grip, or bend the labware when it closes its grip.
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2 Click one of the following:

Checking the 3-Axis Robot plate sensor

The plate sensor in the robot gripper is used to detect the presence of labware 
in its grip. If you suspect that the plate sensor is not working correctly, you 
can check to see if it requires recalibration.

To check the plate sensor:

1 Move the robot to a teachpoint that has a labware.

2 Move the robot up so that it is at the correct robot gripper offset for the 
labware.

3 Close the gripper.

4 In the Teach/Process area, check the Plate present indicator.

If the indicator light is on, the plate sensor is detecting a labware in the 
gripper.

If the indicator light is off, the plate sensor is not detecting labware. 
Contact Automation Solutions Technical Support to see if the sensor needs 
to be recalibrated.

5 Open the gripper to release the labware.

Command Description

 Close gripper Closes the robot gripper by the specified increment.

 Open gripper Opens the robot gripper by the specified increment.
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Scanning a barcode label

You can verify that the barcode reader is working correctly or troubleshoot the 
barcode reader using the Diagnostics software.

To scan a barcode label:

1 Place the labware with the barcode label on a platepad.

2 In the Teach/Process area, select the teachpoint from which to pick up the 
labware in the Position 1 list.

3 In the Position 2 list, select Nowhere.

4 For Position 1, type a value for Approach ht. For the description of the 
parameter, see “Setting new teachpoints” on page 119.

5 Click Pick & Place 1->2. The robot moves to Position 1 and picks up the 
labware. During the pickup process, the barcode reader scans the barcode 
label and displays it in the Bar Code Testing area.

To scan the barcode while the robot grippers are holding the labware, in the 
Bar Code Testing area, click Read barcode. The barcode reader scans the barcode 
label and displays it in the Bar Code Testing area.

Ignoring 3-Axis Robot errors 

You have the option of ignoring robot error messages when using 3- Axis Robot 
Diagnostics. You might want to ignore error messages, for example, when you 
want to simulate the movement of labware without using labware. Under 
normal operating conditions, the software displays a plate- sensor error if you 
request a labware move without picking the labware.

This setting only affects the use of 3- Axis Robot Diagnostics. It does not affect 
VWorks software error settings.

To ignore errors when using 3-Axis Robot Diagnostics:

In the Teach/Process area, select Ignore errors.



8   Using diagnostic tools
3-Axis Robot Diagnostics

236 BioCel System User Guide

Checking communication time

Robot communication time is the length of time it takes for the software to 
receive the positional coordinates from the robot. To ensure optimum 
performance, check that the communication time is shorter than 
100 milliseconds. If the time is consistently longer than 100 milliseconds, 
contact Automation Solutions Technical Support. 

To check the robot communication time:
In the Position Control area, check the Refresh time.

Related information

For information about... See...

Full description of the Robot 
Diagnostics software

“Robot diagnostics software” on page 25

Diagnostics software error 
messages

“Troubleshooting error messages” on 
page 189

Labware Editor VWorks Automation Control Setup 
Guide

Setting and editing teachpoints “Editing existing 3- Axis Robot 
teachpoints” on page 127
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KiNEDx Robot Driver Diagnostics

About KiNEDx Robot Driver Diagnostics 

The KiNEDx Robot Driver Diagnostics software allows you to control the 
motions of the KiNEDx Robot. The software has three tabs: Controls, 
Waypoints, and Profiles. You use the command and parameters available in the 
Controls tab when troubleshooting robot- motion problems.

This topic explains the following:

• “Homing the KiNEDx Robot” on page 238

• “Changing the KiNEDx Robot speed” on page 238

• “Opening and closing KiNEDx Robot grippers” on page 239

• “Retracting the KiNEDx Robot arm” on page 239

See “Quick reference” on page 355 for the complete list of available commands 
you can use.

To jog the robot or to disable the robot motors, in the Controls tab, click 
Launch Peak KiNEDx teach GUI. The KiNEDx Robot Teach Pendant dialog box 
opens. For instructions on using the KiNEDx Robot Teach Pendant software, 
see the Peak KiNEDx Robot user documentation. 

For instructions on setting and verifying teachpoints and waypoints, see 
“Setting KiNEDx Robot teachpoints” on page 135.

For information about using the Profiles tab, see “Creating and managing 
KiNEDx Robot profiles” on page 131 and “Quick reference” on page 355.
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Homing the KiNEDx Robot

Homing the robot sends the robot to the factory- defined home position for 
each of the four axes of motion.

Home the robot if you notice that the robot is not accurately picking up or 
placing labware. You might also want to home the robot after recovering from 
an emergency stop.

Note: The robot homes automatically each time you start the VWorks software.

To home the robot:
In the Controls tab, click Rehome.

Changing the KiNEDx Robot speed

You can select the robot speed to accommodate the task you are performing. 
For example, you can select the Slow speed when you are creating new 
teachpoints, creating and testing protocols, or diagnosing problems with the 
system. When you are ready to run a protocol that you have tested, you can 
select the Medium or Fast speed.

To select the robot speed:

In the Controls tab, select one of the following from the Robot speed list: Slow, 
Medium, or Fast.
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The speed you select in KiNEDx Robot Driver Diagnostics applies only to the 
robot commands in KiNEDx Robot Driver Diagnostics and KiNEDx Robot Teach 
Pendant. If the robot is holding a microplate, the slower of the following will 
be applied: the speed you selected in the Labware Editor or the speed you 
selected in KiNEDx Robot Driver Diagnostics.

Note: During a protocol run, the robot will use the speed selection in the 
VWorks software Tools > Options dialog box. If the robot is holding a 
microplate, the slower of the following will be applied: the speed in the 
Labware Editor or the speed in the Tools > Options dialog box. For more 
information, see the VWorks Automation Control User Guide.

Opening and closing KiNEDx Robot grippers

You can open the robot grippers to release labware. You can close the robot 
grippers to hold labware.

To open or close the robot grippers:

In the Controls tab, click Open gripper or Close gripper.

Retracting the KiNEDx Robot arm

You can retract the robot arm to ensure a minimum footprint.

To retract the robot arm:

In the Controls tab, click Retract elbow.
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Related information

For information about... See...

KiNEDx Robot Driver Diagnostics “Robot diagnostics software” on page 25

Using the KiNEDx Robot Teach 
Pendant software

Peak KiNEDx Robot user documentation

Setting and editing teachpoints 
and waypoints

“Setting KiNEDx Robot teachpoints” on 
page 135
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Additional BioCel System Devices

This chapter describes the additional devices available for 
integration in the BioCel System and provides installation and 
configuration instructions. This chapter contains the following 
topics:

• “BioCel System additional devices overview” on page 242

• “Auxiliary barcode reader” on page 244

• “BioCel I/O Interface” on page 251

• “Lid Hotel Station” on page 266

• “Linear Translator” on page 272

• “Microplate Conveyor” on page 285

• “Microplate Shuttle and Rotator” on page 301

• “Orbital Shaking Station” on page 309

• “Phantom Robot” on page 315

• “Plate Hotel and Plate Hub Carousel” on page 319

• “Platepad” on page 329

• “Vacuum Delid Station” on page 332

• “Waste bin” on page 337

• “Weigh Pad” on page 340
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BioCel System additional devices overview 

About this topic

This topic lists and briefly describes additional devices available for integration 
in the BioCel System. For the latest list of devices available, contact 
Automation Solutions Technical Support.

Additional devices list

In addition to the devices that can be integrated (“Device integration options” 
on page 23), you can install and configure one or more of the following 
Automation Solutions devices in the BioCel System.

Device Description See...

Auxiliary barcode 
reader

Scans barcodes on labware. “Auxiliary barcode 
reader” on page 244

BioCel I/O Interface Allows you to configure and manage digital and 
analog signals.

“BioCel I/O Interface” on 
page 251

Device stacking 
shelves

Allows the stacking of devices to maximize the 
use of space.

Automation Solutions 
Technical Support

Labware MiniHub Stores microplates and tipboxes. The device is 
more compact than the Plate Hub Carousel.

Labware MiniHub User 
Guide

Labware Stacker Stores deep- well and shallow- well microplates, 
pintools, tipboxes, and lids. Dispenses and 
receives the labware from robots.

Labware Stacker User 
Guide

Lid Hotel Station Removes and stores microplate lids. “Lid Hotel Station” on 
page 266

Linear Translator Transports microplates, one at a time, from a 
device (or robot) to a device (or robot). The 
device has a fixed- length body with a motorized 
plate stage that moves from one end to another.

“Linear Translator” on 
page 272

Microplate Conveyor Transports microplates, one at a time, from a 
device (or robot) to a device (or robot) on 
conveyor rollers. The device comes in different 
lengths to accommodate different system 
requirements.

“Microplate Conveyor” on 
page 285

Microplate 
Exchanger

Passes microplates between two system robots. Microplate Exchanger 
User Guide

Microplate Shuttle 
and Rotator

Passes microplates between two system robots, 
or rotates a microplate 180° to change its 
orientation.

“Microplate Shuttle and 
Rotator” on page 301

Orbital Shaking 
Station

Shakes labware for a specified length of time. “Orbital Shaking Station” 
on page 309
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Related information

Phantom Robot Permits the manual movement of labware during 
a protocol run.

“Phantom Robot” on 
page 315

Plate Hotel Stores microplates. “Plate Hotel and Plate 
Hub Carousel” on 
page 319

Plate Hub Carousel, 
Landscape or 
Portrait

Stores microplates and tipboxes. “Plate Hotel and Plate 
Hub Carousel” on 
page 319

Platepad Holds a single microplate. “Platepad” on page 329

Vacuum Delid 
Station 

Removes microplate or tipbox lids using 
vacuum.

“Vacuum Delid Station” 
on page 332

Waste bin Receives microplate lids, used pipette tips, or 
other trash.

“Waste bin” on page 337

Weigh Pad Monitors and maintains the percentage of liquid 
in a container that is on the Weigh Pad.

“Weigh Pad” on page 340

Device Description See...

For information about... See...

Using the device in a protocol VWorks Automation Control User 
Guide

BioCel System setup workflow “Setup Workflow” on page 28
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Auxiliary barcode reader 

About this topic

This topic describes the auxiliary barcode reader, explains its use, and 
provides the setup instructions.

Description

The auxiliary barcode reader is either attached to a platepad or a device. 
Depending on the setup, the barcode reader scans barcodes on one of four 
sides of microplates. The following diagram shows an example barcode reader 
that is attached to a platepad and is oriented to scan barcodes on the east and 
west sides of microplates.

Setup workflow 

Step Procedure See...

1 Install the barcode reader. Automation Solutions 
Technical Support

2 Add the barcode reader in the 
device file.

“Adding the barcode reader 
in the device file” on 
page 245

3 Add the platepad or device to 
which the barcode reader is 
attached.

“Adding the platepad or 
device” on page 245

4 Create a profile for the barcode 
reader.

“Creating a profile for the 
barcode reader” on page 247

5 Set and edit the teachpoint for the 
barcode reader platepad or device.

One of the following:

• “Setting Direct Drive 
Robot teachpoints” on 
page 69

• “Setting 3- Axis Robot 
teachpoints” on page 117

• “Setting KiNEDx Robot 
teachpoints” on page 135

6 Test the barcode reader. “Testing the barcode reader” 
on page 248
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Adding the barcode reader in the device file

The VWorks software is set up with the correct device configuration to 
communicate with the barcode reader. You do not need to add a new barcode 
reader to the device file unless you want to use a different teachpoint file. For 
information about device files, see “Devices and device file defined” on 
page 39.

To add the barcode reader to the device file:

1 In the VWorks software, open the device file and add the Keyence Barcode 
Reader. See “Adding and deleting devices in the software” on page 39 for 
instructions.

2 In the Keyence Barcode Reader Properties area, type or select the following:

3 Select File > Save.

Adding the platepad or device

After adding the barcode reader in the device file, you must add the platepad 
or device to which the barcode reader is attached. In addition, you specify the 
barcode reader in the platepad or device properties.

Property Description

Name The name of the barcode reader device.

Profile The profile associated with the device.

Select the desired profile from the list. If 
you have not created a profile, see “Creating 
a profile for the barcode reader” on 
page 247, and then return to this step to 
select the profile.
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To add the platepad or device in the device file:

1 In the device file, add the Plate Pad or the desired device. See “Platepad” 
on page 329 or “Adding and deleting devices in the software” on page 39 
for instructions.

2 In the Devices area, expand the Plate Pad or device, and then select the 
Stage to which the barcode reader is attached.

3 In the PlatePad Stage Location Properties or device stage properties area, type 
or set the parameters. See “Platepad” on page 329 or the device guide for 
detailed instructions. Make sure you specify the location of the barcode 
reader on the platepad or device. 

4 Select File > Save.
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Creating a profile for the barcode reader

The barcode reader profile allows you to set up communication between the 
barcode reader and the controlling computer.

To create a profile for the barcode reader:

1 In the VWorks window, select the Keyence Barcode Reader device, and then 
click Device diagnostics. 

The Keyence Barcode Reader Diagnostics dialog box opens.

2 Click the Profiles tab.

3 Click Create a new profile. The Create Profile dialog box opens.

4 Type a name for the new profile, and then click OK. The new profile name 
appears in the Profile Management area.

5 In the Profile Settings area, select the COM port number used by the barcode 
reader.

6 Click Update this profile to save the changes.
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7 Click Initialize this profile to establish communication with the barcode 
reader.

8 Return to the device file and select the profile for the barcode reader 
device.

Testing the barcode reader

Barcode label specifications
The barcodes must meet the following requirements:

Before you start
Make sure you have the following:

• M2 hex wrench

• Spare microplate that has a barcode label

Test procedure

To test the barcode reader:

1 Place the spare microplate on the Barcode Reader location and make sure 
the barcode label faces the Barcode Reader mirror.

2 Open Keyence Barcode Reader Diagnostics.
                                                        

Characteristic Requirement

Barcode formats Code 39 
Codabar 
Code 128 
Interleaved 2 of 5 
Code 93 
UPC/EAN 
Pharmacode 
PDF417

Barcode height 3.34 mm (0.13 in) or taller

Print contrast 25% at 650 nm

Quiet zone 10 times the dimension of the 
narrowest element in the barcode 
or 6.35 mm (0.25 in), whichever is 
greater

WARNING  The barcode reader sensor head contains a class II laser that emits light at 
650 nm, producing up to 1.5 mW of energy. Do not look directly into the laser beam. Looking 
directly into the laser beam or looking at the reflected beam can cause eye injury.

WARNING  Do not disassemble the barcode reader sensor head. Laser emission does 
not automatically turn off if the sensor head is disassembled.
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3 In the Profiles tab, select the Barcode Reader profile from the Profile list, 
and click Initialize this profile.

4 Click the Controls tab.

5 Click Scan barcode. The barcode reader laser turns on briefly to scan the 
barcode label. One of the following messages appears next to Scan result:

                                                        

Scan result message Description Next step

<barcode text> The barcode was 
successfully scanned.

The setup is 
complete. No further 
adjustment is 
required.

No barcode found Barcode scanning was not 
successful.

Proceed to step 6.
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6 If the No barcode found message appears, click Scan barcode again and 
check that the barcode reader laser beam is projected onto the vertical 
center of the barcode label.

If the laser beam is not at the vertical center of the label, adjust the scan 
angle of the barcode reader.

Adjusting the scan angle
Depending on the setup, the angle adjustment process can differ. If the barcode 
reader is attached to a platepad, you can loosen the screws on both sides of 
the reader to change the scan angle. If the barcode reader is mounted on the 
side of a device, you might have to loosen the screws on the mounting plate to 
change the scan angle. If you need assistance with the process, contact 
Automation Solutions Technical Support.

Troubleshooting
If the reader is unable to scan the barcode after many adjustments, try one or 
more of the following:

• Make sure the barcode label is applied properly onto the microplate.

• Make sure the microplate is sitting level at the Barcode Reader location.

• Make sure the barcode and label meet the format requirements. See 
“Barcode label specifications” on page 248.

• Repeat the adjustment process using a new spare microplate.

Related information

For information about... See...

Set the teachpoint for the barcode 
reader platepad or device

One of the following:

• “Setting Direct Drive Robot 
teachpoints” on page 69

• “Setting 3- Axis Robot teachpoints” 
on page 117

• “Setting KiNEDx Robot teachpoints” 
on page 135

Using the barcode reader in a 
protocol

VWorks Automation Control User 
Guide

Available devices “BioCel System additional devices 
overview” on page 242
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BioCel I/O Interface 

About this topic

This topic describes the BioCel I/O Interface, explains its use, and provides the 
setup and troubleshooting instructions.

Description

The BioCel I/O Interface console, located inside the system cabinet, transmits 
signals from various sensors to the controlling computer. In response to the 
signals, the computer can turn on or off status lights, turn on or off ventilation 
fans, open or close doors, and change the state of other items.

In the software, you can name the signal channels so that you can reference 
them in a protocol and in the IO Manager. The IO Manager allows you to 
assign digital output signals to lights and sounds, specify when to bypass the 
safety interlock, and select the signals to use to automate the opening and 
closing of doors.

When writing a protocol, you can add tasks to turn on or turn off a light, 
sound, or fan. You can also add tasks to wait for certain conditions to be met 
before continuing to the next task. For example, you can specify that a fan be 
turned on while a liquid- handling task is running. You can also specify that 
the temperature and humidity reach a certain level before the Main Protocol 
starts.

Setup workflow

To troubleshoot the BioCel I/O Interface device, see “Troubleshooting I/O 
channels” on page 263.

Step For this task... See...

1 Add the BioCel I/O Interface 
device in the device file.

“Adding the BioCel I/O Interface in 
the device file” on page 252

2 Create a profile for the BioCel 
I/O Interface v3 device.

“Creating a profile for the BioCel I/
O Interface” on page 253

3 Name the signal channels. “Assigning names to signal 
channels” on page 255

4 Manage digital signals for:

• Lights and sound

• Safety interlock

• Automated doors (if 
applicable)

One or more of the following:

• “Managing signals for lights and 
sound” on page 257

• “Managing signals to monitor 
the safety interlock status” on 
page 259

• “Managing signals for 
automated doors” on page 261
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Adding the BioCel I/O Interface in the device file 

The VWorks software is set up with the correct BioCel I/O Interface 
configuration. You do not need to add a new BioCel I/O Interface to the device 
file unless you want to set up additional I/O configurations. For information 
about device files, see “Devices and device file defined” on page 39.

To add BioCel I/O Interface to the device file:

1 In the VWorks window, open the device file and add the BioCel I/O 
Interface. See “Adding and deleting devices in the software” on page 39 for 
instructions.

2 In the BioCel I/O Interface Properties area, type or select the following:

3 Select File > Save.

Property Description

Name The name of the BioCel I/O Interface 
device.

Profile The profile associated with the device.

Select the desired profile from the list. If 
you have not created a profile, see “Creating 
a profile for the BioCel I/O Interface” on 
page 253, and then return to this step to 
select the profile.

Device selected The version of BioCel I/O Interface device 
installed in your system. If your system was 
installed in 2005 or later, select BioCel I/O 
Interface v3. If your system was installed 
before 2005, select BioCel I/O Interface v2. 
To confirm, contact Automation Solutions 
Technical Support.
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Creating a profile for the BioCel I/O Interface 

The BioCel I/O Interface profile allows you to set up communication between 
the BioCel I/O Interface console and the controlling computer.

Note: You do not need to set up a profile for the BioCel I/O Interface v2 
device. The procedure in this section is for systems that use the BioCel I/O 
Interface v3 device.

To create a profile:

1 In the VWorks window, select the BioCel I/O Interface device, and then 
click Device diagnostics. Alternatively, you can double- click the device icon.

The BioCel I/O Interface Diagnostics dialog box opens.

2 Click the Profiles tab.

3 Click Create a new profile. The Create Profile dialog box opens.

4 Type a name for the new profile, and then click OK. The new profile name 
appears in the Profile area.
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5 In the BioCel I/O Interfaces area, click Add BioCel I/O Interface. A new row, 
serial, appears in the table. Each row represents a different I/O device.

6 Click the row and select the correct connection type: serial or ethernet. Click 
the N/A field.

7 If you selected ethernet, in the Discovered BioNet Devices dialog box that 
opens:

8 If you selected serial, select the COM port number used by the BioCel I/O 
Interface console.

9 Click Update this profile to save the changes.
                                                        

Step Instruction

1 Select the correct Ethernet card for the device connection. A list 
of devices appear in the dialog box.

2 Select the BioCel I/O Interface console. You can use the MAC 
Address to identify the BioCel I/O Interface console in the list. 
To successfully communicate with the BioCel I/O Interface 
console, the device must show New or Matched in the Status 
column.

3 When you are finished, click OK to return to the BioCel I/O 
Interface Diagnostics dialog box.
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10 Click Initialize this profile to establish communication with the BioCel I/O 
Interface console.

11 Return to the device file and select the profile for the BioCel I/O Interface 
device.

Assigning names to signal channels 

If you have the BioCel I/O Interface v3 device, you can assign names to the 
signal channels so that you can reference them in the protocol and in the IO 
Manager.

Note: The BioCel I/O Interface v2 device does not have this feature. If your 
system has the BioCel I/O Interface v2 device, you can skip the procedures in 
this section.

To assign names to the signal channels:

1 In BioCel I/O Interface Diagnostics, click the Digital I/O tab. Two lists appear. 
One list displays all available digital output channels, the other list displays 
the available digital input channels. 

The following example shows the channels from one BioCel I/O Interface 
device. The device has 16 output channels and 20 input channels. If you 
added more than one BioCel I/O Interface device in the profile, additional 
channels would appear in these lists.
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2 Double- click an output or input name field, and then type the name you 
want to assign to that channel.

 IMPORTANT The physical wire connections at the BioCel I/O Interface 
console are numbered. The connection numbers must match the channel 
(Output or Input) numbers in the BioCel I/O Interface Diagnostics.

To verify the identity of the digital output connections, select an output, 
and then click Turn on selected outputs. The on state should help you find the 
correct signal channel.

3 Repeat step 2 to name all existing digital signal channels.

4 Click the Analog Inputs tab. A list of all the available analog input channels 
are shown.

5 Double- click an input name field, and then type the name you want to 
assign to that channel.

6 When you are finished, click OK to save the changes and return to the 
VWorks window.
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Managing digital signals 

IMPORTANT Make sure you have correctly configured the BioCel I/O Interface 
device before setting up signals in the IO Manager. 

You use the IO Manager for:

• Managing signals for lights and sound

• Managing signals to monitor the safety interlock status

• Managing signals for automated doors

Note: The IO Manager is for digital signals only.

Managing signals for lights and sound

To specify the signals for turning on lights or creating sound:

1 In the VWorks window, select the BioCel I/O Interface device, and then 
click Initialize selected devices.

2 Select Tools > Manage IO. The Manage IO dialog box opens. 

3 Click the Light and Alarm tab. Notice the following:

• The Outputs list contains the digital output channels.

• The Inputs list contains the digital input channels.

• For BioCel I/O Interface v3 devices, only the channels that were 
assigned names appear in this dialog box.

• For BioCel I/O Interface v2 devices, all channels appear in this dialog 
box.
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4 In the Outputs area, specify the output signals that will turn on lights or 
create sounds:

a Drag names of channels that should turn on lights into the Lights box. 
Select the type of light you want to use: Blue or X’Mas (red, green, and 
yellow).

If your system does not use lights to indicate output signals, select 
None under Flash Pattern.

Note: To use the Blue light, you must have eight channels, one for 
each of the eight blue status lights at the top corners of the BioCel 
System. To use the X’mas lights, you need three channels, one for 
each of the colored lights: red, green, and yellow. 
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b Drag names of channels that should create sounds into the Sound box.

Managing signals to monitor the safety interlock status
In the Manage IO dialog box, you can specify the signals to use to monitor the 
status of the safety interlock and enclosure windows.

To specify the safety interlock and enclosure window signals:

1 In the Inputs area, drag the safety interlock channel or channels into the 
Bypass Keys box.

If the BioCel System consists of multiple connecting systems, make sure 
you drag the interlock channel from each system into the Bypass Keys 
area. In the following example, Zone A -  Input 1 and Zone B -  Input 1 are 
the interlock signals for systems A and B, respectively.

2 In the Bypass Active When area, select when the interlock state should be 
ignored: when ANY input is (any one signal) or when ALL inputs are (all 
signals) in a designated state.

Always select ALL inputs are. The system should always bypass the safety 
interlock if all the interlock input signals are in the specified state.

3 In the Bypass Active When area, select the state that indicates the safety 
interlock should be bypassed: High (status light is on)or Low (status light is 
off).

Always select Low. All systems are physically wired such that when the 
interlock is turned on at the power panel, the interlock status light in the 
BioCel IO Interface Diagnostics is on (High). When the interlock is turned 
off (bypassed), the status light is off (Low). 

In the following example, Zone A -  Input 1 is the signal for the safety 
interlock.
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Managing signals to monitor the enclosure-window status

To set the enclosure window state:

1 In the Inputs area, drag the enclosure- window channel or channels into the 
Enclosure Window Sensors box.

If the BioCel System consists of multiple connecting systems, make sure 
you drag the enclosure- window channel from each system into the 
Enclosure Window Sensors area. In the example shown, Zone A -  Input 2 
and Zone B -  Input 2 are the enclosure- window signals for systems A and 
B, respectively.

2 In the Enclosure Window Open When area, select one of the following: when 
ANY input is (any enclosure window) or when ALL inputs are (all enclosure 
windows) in a designated state.

Always select Any input is. The safety interlock circuit should stop system 
operations when any enclosure window is opened.
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3 In the Enclosure Window Open When area, select the state that indicates the 
enclosure window is open: High (status light is on) or Low (status light is 
off).

Always select High. All systems are physically wired such that when an 
enclosure window is opened, the status light in the BioCel IO Interface 
Diagnostics is on (High). When all enclosure windows are closed, the status 
light is off (Low).

In the following example, Zone A -  Input 2 is the signal for the enclosure 
windows.

Managing signals for automated doors 
Some BioCel Systems have an environmental- control option that creates fully 
contained environments within the system chamber. Automated doors can be 
used to permit labware to move between the system and separated devices 
while maintaining the enclosed environment. Separated devices include an 
incubator below the system table or next to the system, the Linear Translator 
that moves labware between two connecting systems, the waste bin below the 
system table, and so on.

For each separated device that sits just beyond an automated door, make sure 
you:

• Set up the signals for the automated door in the BioCel I/O Interface 
Diagnostics Digital I/O tab. For each door, two input signals and one output 
signal are required. One input signal is used to detect whether the door is 
open. Another input signal is used to detect whether the door is closed. 
The output signal is used to open or close the door, depending on the 
control signal received.

• Select the signals that will be used to automate the door actions.

• Associate the door to a device.

• Specify the signals to use to automatically open or close doors during a 
run. 

To select signals to automate door actions:

1 In the Manage IO dialog box, click the Doors tab.

2 Click New to add a door.
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3 Specify the following:

Parameter Description

Door Name The name of the door. Double- click in the 
field to type the name.

BioIO Input(open) The I/O signal that detects whether the 
door is open. The value for this parameter 
must match the assignment in BioCel I/O 
Interface Diagnostics.

Click the field to display the list of named 
signals and select one. If you do not see the 
signals in the list, initialize the BioCel I/O 
Interface device.

BioIO Input(close) The I/O signal that detects whether the 
door is closed. The value for this parameter 
must match the assignment in BioCel I/O 
Interface Diagnostics.

Click the field to display the list of named 
signals and select one. If you do not see the 
signals in the list, initialize the BioCel I/O 
Interface device.

BioIO Output The I/O signal that changes to open or close 
the door. The value for this parameter must 
match the assignment in BioCel I/O 
Interface Diagnostics.

Click the field to display the list of named 
signals and select one. If you do not see the 
signals in the list, initialize the BioCel I/O 
Interface device.

Door Close Delay (sec) The length of time, in seconds, between 
when the robot moves labware through the 
doorway and when the door closes.

Double- click in the field to type an integer.
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4 When you are finished, click OK to save the changes and return to the 
VWorks window.

To associate the door to a device:

1 In the device file, select the device.

2 In the device properties area, select the door associated with the device.

Note: You can open the IO Manager from the device properties area to 
edit or add doors. From the Door list, click <Edit...>.

In the following example, an automated door was set up in the BioCel I/O 
Interface and IO Manager for the Cytomat incubator device. The door that was 
defined for the incubator in the IO Manager must be selected in the Cytomat 
device properties area.

 

Troubleshooting I/O channels

You can use BioCel I/O Interface Diagnostics to check the I/O channels for 
troubleshooting purposes.

BioIO 3 device

To troubleshoot BioCel I/O Interface v3 channels:

1 With the device file open, select the BioCel I/O Interface device, and then 
click Device diagnostics. Alternatively, you can double- click the device icon. 
The BioCel I/O Interface Diagnostics dialog box opens.

2 Click the Digital I/O tab.

3 In the Digital Outputs area, do one of the following:

• Select the single output channel you want to check, and then click the 
status light next to it to turn it on or off.

• SHIFT+click multiple output channels, and then click Turn on selected 
outputs or Turn off selected outputs. The lights adjacent to the selected 
channels turn on or off accordingly.
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4 In the Digital Inputs area, check the indicator light next to the channel name 
to verify that the sensor is functioning correctly. For example, you can 
open or close an enclosure window, and then check the indicator light to 
see if it is turned on (window open) or off (window closed).

5 To reset the circuit breaker, click Reset circuit breaker.
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BioIO 2 device

To troubleshoot BioCel I/O Interface v2 channels:

1 With the device file open, select the BioCel I/O Interface device, and then 
click Device diagnostics. The BioCel I/O Interface Diagnostics dialog box 
opens.

2 Click the light indicator next to the channel name to turn it on or off.

Related information

For information about... See...

Location of the BioCel I/O 
Interface console

“Communication hubs” on page 18

Status light description “Status lights” on page 19

Writing protocols VWorks Automation Control User 
Guide

I/O- handling tasks VWorks Automation Control User 
Guide
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Lid Hotel Station 

About this topic

This topic describes the Lid Hotel Station, explains its use, and provides the 
configuration instructions.

Description

The Lid Hotel Station1 is a vertical rack that holds microplate lids while the 
microplates are processed. Rollers at each storage bay (or slot) hold onto a lid 
while the robot pulls the microplate downward to remove the lid. When the 
microplate returns to the storage bay, the robot pushes the microplate upward 
for relidding, and then pulls the lidded microplate out of the bay.

1 Concept developed by Novartis Pharma AG, NIBR/DT/IAT, Basel, Switzerland.

Setup workflow
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Step Procedure See...

1 Install the Lid Hotel Station. Automation Solutions 
Technical Support

2 Add the Lid Hotel Station in the 
device file.

“Adding the Lid Hotel Station 
in the device file” on 
page 267

3 Create a profile for the Lid Hotel 
Station.

“Creating a profile for the Lid 
Hotel Station” on page 268

4 Set, edit, and verify the teachpoint 
for each storage bay (slot).

“Setting storage bay 
teachpoints” on page 270
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Adding the Lid Hotel Station in the device file 

The VWorks software is set up with the correct device configuration to 
communicate with the Lid Hotel Station. You do not need to add a new Lid 
Hotel Station to the device file unless you want to reference different profiles 
or use a different teachpoint file. For information about profiles and device 
files, see “Devices and device file defined” on page 39.

Note: After adding the Lid Hotel Station, you must add each storage bay (slot) 
as a device to the device file.

To add the Lid Hotel Station to the device file:

1 In the VWorks software, open the device file and add the Lid Hotel Station. 
See “Adding and deleting devices in the software” on page 39 for 
instructions.

2 In the Lid Hotel Station Properties area, type or select the following:

3 In the Devices area, expand Lid Hotel Station, and then select a storage bay 
(slot) number.

                                                        

Property Description

Name The name of the Lid Hotel Station device.

Profile The profile associated with the device.

Select the desired profile from the list. If 
you have not created a profile, see “Creating 
a profile for the Lid Hotel Station” on 
page 268, and then return to this step to 
select the profile.
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4 In the Lid Hotel Station Properties area, type or set the following:

5 Select File > Save.

Creating a profile for the Lid Hotel Station 

The Lid Hotel Station profile allows you to set up communication between the 
Lid Hotel Station and the controlling computer. You can also indicate the 
number of hotel slots that will be used.

Property Description

Allowed/prohibited 
labware

Permitted labware class for the selected 
location.

For example, you might specify that only 
tipboxes are allowed at a given location. For 
details on labware classes, see the VWorks 
Automation Control Setup Guide.

Teachpoint for robot 
<BioCel System Robot>

The name of the teachpoint for the stage 
location. This selection enables the robot to 
move correctly to and from the storage bay 
(slot) during a protocol run.

For example, if the robot teachpoint file 
contains a teachpoint for this slot, you must 
select that teachpoint.

Note: In simulation mode, select 
<accessible>.

Use for deadlock 
avoidance

Option to permit the location to be used for 
deadlock avoidance.

IMPORTANT Always select No for the Lid 
Hotel Station.
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To create a profile:

1 In the VWorks software, open Lid Hotel Station Diagnostics.

2 The Lid Hotel Station Diagnostics dialog box opens.

3 Click the Profiles tab.

4 Click Create. The New Profile dialog box opens.

5 Type a name for the new profile, and then click OK. The new profile name 
appears in the Profile Control area.

6 In the Parameters area:

• In the COM Port list, select the serial port that connects the Lid Hotel 
Station to the controlling computer.

• In the Number of slots box, type the number of storage bays in the hotel. 
This number should match the number of storage bays you added in 
the device file.

7 Click Save settings.
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Setting storage bay teachpoints

To set teachpoints for the storage bays (slots) in the hotel, see one of the 
following:

• “Setting Direct Drive Robot teachpoints” on page 69

• “Setting 3- Axis Robot teachpoints” on page 117

• “Setting KiNEDx Robot teachpoints” on page 135

Direct Drive Robot procedure

When you set the storage bay (slot) teachpoints:

1 Use the provided teaching jig to set a teachpoint at the top of the hotel. 
The platepad at the top of the hotel is similar to a standard platepad, so 
set the teachpoint as if it is a standard platepad.

2 With the teaching jig still in the robot grippers, position the robot such 
that the teaching jig is centered within the rollers (top view, 1), and the 
bottom of the teaching jig is touching the top of the rubber rollers at the 
desired storage bay (side view, 2).

Note: If you are using a labware to set the teachpoints, make sure the 
gripper offset is at least 5 mm.

3 Set the teachpoint. Make sure you:

• Set Approach Ht (with labware) and Approach Ht (no labware) at 0.

• For Pick Custom Action, select Lid Hotel relid.

• For Place Custom Action, select Lid Hotel delid.

4 Repeat steps 2 and 3 for the remaining storage bays (slots).

3-Axis Robot and KiNEDx Robot procedure

When you set the storage bay (slot) teachpoints:

1 Use the provided teaching jig to set a teachpoint at the top of the hotel. 
The platepad at the top of the hotel is similar to a standard platepad, so 
set the teachpoint as if it is a standard platepad.

2 Open the robot grippers and remove the teaching jig.

3 Without using the teaching jig, teach the top- most storage bay (Bay 10, 
which is the first bay under the hotel platepad) as follows:

a Jog the robot approximately 80 mm away from the hotel (or until the 
robot grippers are clear of the hotel).

b Jog the robot down approximately 40 mm.

c Jog the robot approximately 80 mm toward the hotel so that the robot 
grippers are in the target storage bay (slot).

A1

1 2
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4 Refine the robot position as follows: Make sure the bottom of the rollers 
are not quite touching the top of the robot grippers. If possible, jog the 
robot only along the z- axis.

5 Set the teachpoint.

6 Repeat steps 3 through 5 for the remaining storage bays (slots).

Monitoring the hotel-slot status 

Sensors at each hotel storage bay (slot) detect the presence of a lid, and the 
software displays the status in Lid Hotel Diagnostics.

To view the hotel storage bay (slot) status:

In Lid Hotel Diagnostics, click the Controls tab. The list of storage bays (slots) and 
corresponding indicator lights are displayed in the Plates Present area. If a bay 
(slot) is occupied, the corresponding light turns on.

Related information

For information about... See...

Using the Lid Hotel Station in a 
protocol

VWorks Automation Control User 
Guide

Vacuum Delid Station “Vacuum Delid Station” on page 332

Available devices “BioCel System additional devices 
overview” on page 242
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Linear Translator 

About this topic

This topic describes the Linear Translator, explains its use, and provides the 
configuration instructions.

Description

The Linear Translator has a fixed- length body with motorized plate stage that 
transports a microplate in one of the following ways:

• Between two robots residing in adjacent BioCel Systems

• Between a BioCel System robot and an incubator that has its own robot

The translator has two axes that enable two types of movements:

• Transports microplates linearly along the mover.

• Rotates microplates in any orientation at both ends of the mover.

Enabling microplate rotation accommodates different device or robot- access 
requirements. For example, the incubator at one end of the translator might 
require landscape microplate- orientation while the robot at the opposite end of 
the mover might require the microplate to be at a specific angle.

Setup workflow
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Step Procedure See...

1 Install the Linear Translator. Automation Solutions 
Technical Support

2 Add the Linear Translator in the 
device file.

“Adding the Linear Translator 
to the device file” on 
page 273
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Adding the Linear Translator to the device file

The VWorks software is set up with the correct device configuration to 
communicate with the Linear Translator. You do not need to add a new Linear 
Translator to the device file unless you want to reference different profiles or 
use a different teachpoint file. For information about device files and profiles, 
see “Devices and device file defined” on page 39.

When setting up the Linear Translator, you must:

1 Add the Linear Translator in the device file and specify how the translator 
will interact with the BioCel System robot.

2 Revise the incubator device properties to specify how the translator will 
interact with the incubator.

To add the Linear Translator to the device file:

1 In the VWorks software, open the device file and add the Linear 
Translator. See “Adding and deleting devices in the software” on page 39 
for instructions.

2 In the Linear Translator Properties area, type or select the following:

3 Create a profile for the Linear 
Translator.

“Creating a profile for the 
Linear Translator” on 
page 277

4 Set and edit the teachpoints for the 
Linear Translator.

“Setting teachpoints for the 
translator” on page 280

5 Verify the Linear Translator 
teachpoints.

“Verifying translator 
teachpoints” on page 281

Step Procedure See...
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3 In the Devices area, expand Linear Translator, and then select the Start 
stage.

4 In the Linear Translator Properties area, set up the end that will interact with 
the BioCel System robot:

Property Description

Name The name of the Linear Translator device.

Profile The profile associated with the device.

Select the desired profile from the list. If 
you have not created a profile, see “Creating 
a profile for the Linear Translator” on 
page 277, and then return to this step to 
select the profile.

Property Description

Allowed/prohibited 
labware

Permitted labware class for the selected 
location.

For example, you might specify that only 
tipboxes are allowed at a given location. For 
details on labware classes, see the VWorks 
Automation Control Setup Guide.

BCR on south/west/north/
east side

The location of the barcode reader and the 
desired barcode reader device.

Use these fields only if a barcode reader is 
installed on this device.
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5 In the Devices area, select the End stage under Linear Translator.

6 In the Linear Translator Properties area, set up the end that will interact with 
the incubator robot:

Teachpoint for robot 
<BioCel System Robot>

The name of the teachpoint for the Start 
location. This selection enables the BioCel 
System robot to move correctly to and from 
the Start location during a protocol run.

For example, if the robot teachpoint file 
contains a teachpoint for this location, you 
must select that teachpoint.

Note: In simulation mode, select 
<accessible>.

Teachpoint for robot 
<Linear Translator>

The teachpoint that is set up for the Linear 
Translator. Select Start.

For setup instructions, see “Setting 
teachpoints for the translator” on page 280.

Use for deadlock 
avoidance

Option to permit the location to be used for 
deadlock avoidance.

IMPORTANT Always select No for the 
Linear Translator.

Door The internal system door associated with 
this device. For the Linear Translator, this 
is one of the doors between two connecting 
systems.

Property Description
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7 Select File > Save.
                                                        

Property Description

Allowed/prohibited 
labware

Permitted labware class for the selected 
location.

For example, you might specify that only 
tipboxes are allowed at a given location. For 
details on labware classes, see the VWorks 
Automation Control Setup Guide.

BCR on south/west/north/
east side

The location of the barcode reader and the 
desired barcode reader device.

Use these fields only if a barcode reader is 
installed on this device.

Teachpoint for robot 
<BioCel System Robot>

The name of the teachpoint for the stage 
location. Because the End location will only 
interact with the incubator, select <not 
accessible>.

Teachpoint for robot 
<Linear Translator>

The teachpoint that is set up for the Linear 
Translator. Select End.

For setup instructions, see “Setting 
teachpoints for the translator” on page 280.

Use for deadlock 
avoidance

Option to permit the location to be used for 
deadlock avoidance.

Select Yes to permit labware to be moved to 
this location to avoid a deadlock in the 
system.

Select No if you do not want to move 
random labware to this location to avoid 
deadlock.

Door The internal system door associated with 
this device. For the Linear Translator, this 
is one of the doors between two connecting 
systems.
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To update the incubator device properties:

1 In the Devices area, expand the incubator and select the Load/Unload or 
equivalent location.

2 In the incubator Properties area, update the fields that will enable 
interaction with the Linear Translator:

3 Select File > Save.

Creating a profile for the Linear Translator

The Linear Translator profile allows you to set up communication between the 
translator and the controlling computer. You can also set the speed at which 
the translator should transport microplates.

To create a profile:

1 In the VWorks software, open Linear Translator Robot Driver Diagnostics.

Property Description

Teachpoint for robot 
<BioCel System Robot>

Select <not accessible>.

Note: In simulation mode, select <not 
accessible>.

Teachpoint for robot 
<Linear Translator>

Select End, because this is the teachpoint 
that is set up to interact with the incubator.
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The Linear Translator Robot Driver Diagnostics dialog box opens.

2 Click the Profiles tab.

3 Click Create a new profile. The Create Profile dialog box opens.

4 Type a name for the new profile, and then click OK. The new profile name 
appears in the Profile Management area.
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5 In the Profile settings area, set the following parameters:

Selection or parameter Description

Hardware type Select One-axis Linear Translator or Two-axis 
Linear Translator.

To determine whether the translator has 
two axes, try to manually rotate the plate 
stage. If it rotates, it has two axes.

Linear serial Select the serial port that connects the 
linear motor to the controlling computer.

Rotate serial port Select the serial port that connects the 
rotational motor to the controlling 
computer.

Teachpoint file Browse and select the translator 
teachpoint file you want to use.

Note: The translator teachpoint file is 
different from the system robot 
teachpoint file.

To set up translator teachpoints, see 
“Setting teachpoints for the translator” on 
page 280.

Speed Select the speed at which you want the 
translator to move: Fast, Medium, or Slow.

Velocity Type the percentage of factory- set 
maximum speed for the speed you 
selected. 

For example, if you selected Slow, you 
can set the Slow speed at 15% of the 
factory- set maximum speed.

Acceleration Type the percentage of maximum 
factory- set acceleration for the speed you 
selected. 

For example, if you selected Slow, you 
can set the Slow acceleration at 15% of 
the factory- set maximum acceleration.
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6 When you are finished, click Update this profile to save the changes.

7 Click Initialize this profile.

Setting teachpoints for the translator

To set the teachpoints for the translator, you need to:

1 Use Linear Translator Diagnostics to set a teachpoint at each end of the 
translator. One teachpoint is accessed by the BioCel System robot, the 
other teachpoint is accessed by the incubator.

2 Use the instructions in one of the following topics to set a BioCel System 
robot teachpoint at the start location of the translator.

• “Setting Direct Drive Robot teachpoints” on page 69

• “Setting 3- Axis Robot teachpoints” on page 117

• “Setting KiNEDx Robot teachpoints” on page 135

Make sure you turn off the translator motors before you start. To turn off 
the motors, see “Turning on and turning off the translator motors” on 
page 282.

3 Follow instructions in the incubator user documentation to set a teachpoint 
at the end location of the translator.

Make sure you turn off the translator motors before you start. To turn off 
the motors, see “Turning on and turning off the translator motors” on 
page 282.

To set the teachpoints using Linear Translator Diagnostics:

1 In Linear Translator Diagnostics, click the Controls tab.

2 In the Both Axes area, click Disable motors. The translator motors are turned 
off.

3 Manually push the translator plate stage to the end where the BioCel 
System robot will place or pick up microplates.
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4 Manually move the BioCel System robot to the plate stage. Use the 
instructions in one of the following topics to set and edit the BioCel 
System robot teachpoint at the translator.

• “Setting Direct Drive Robot teachpoints” on page 69

• “Setting 3- Axis Robot teachpoints” on page 117

• “Setting KiNEDx Robot teachpoints” on page 135

5 In Linear Translator Diagnostics, in the Teachpoints area, select Start Location, and 
then click Teach teachpoint.

6 Manually move the translator plate stage to the end where the incubator 
will place or pick up microplates.

7 Manually move the incubator robot to the plate stage. Use the incubator 
user documentation to set and edit the teachpoint at the translator.

8 In Linear Translator Diagnostics, in the Teachpoints area, select End Location, and 
then click Teach teachpoint.

9 In the Both Axes area, click Enable motors to turn on the translator motors.

Verifying translator teachpoints

To verify the translator teachpoints:

1 In Linear Translator Driver Diagnostics, in the Teachpoints area, select a 
teachpoint you want to verify, and then click Move to teachpoint. Check that 
the translator plate stage moved to the selected teachpoint and is 
positioned accurately. If necessary, edit the teachpoint (see “Setting 
teachpoints for the translator” on page 280).

2 For the BioCel System robot, use the instructions in one of the following 
sections to verify and edit the teachpoint:

• “Verifying Direct Drive Robot teachpoints” on page 90

• “Verifying 3- Axis Robot teachpoints” on page 124

• “Verifying KiNEDx Robot teachpoints and waypoints” on page 143

3 For the incubator robot, follow the incubator user documentation to verify 
and edit the teachpoint.

Using Linear Translator Diagnostics

You can use the commands and parameters in the Linear Translator 
Diagnostics Controls tab to:

• Home the plate stage

• Turn on or turn off the translator motors

• Change the translator speed

• Jog the plate stage

CAUTION Use only the commands and parameters in the Controls tab as described. Do not 
click the buttons in the Calibration area. The Use current position as homing offset button 
resets the current plate stage position as the home position (0, 0). The Track length value was 
set at the factory and should not be changed. If you believe the Linear Translator is not 
working properly, contact Automation Solutions Technical Support.
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Homing the plate stage
Homing sends the plate stage to the factory- defined home position for each 
axis of motion. Home the plate stage when recovering from an emergency stop.

To home the plate stage:

1 In Linear Translator Diagnostics, click the Controls tab.

2 In the Both Axes area, click Home.

Turning on and turning off the translator motors
Turning off the translator motors allows you to move the plate stage by hand, 
making it easier to set and edit teachpoints. You must turn on the translator 
motors for operation.
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To turn on or turn off the translator motors:
In the Both Axes area, click one of the following:

Alternatively, you can turn on or turn off the motor of a single axis. To do 
this, in the X-Axis or Theta-Axis area, click either Enable motor or Disable motor to 
turn on or turn off the motor for that axis. The x- axis motor moves the plate 
stage linearly. The theta- axis motor rotates the plate stage.

Changing the translator speed
You can select the robot speed to accommodate the task you are performing. 
For example, you can select the Slow speed when you are setting teachpoints 
or diagnosing problems.

To change the translator speed:
In the Speed list, select the speed at which you want the plate stage to move: 
Fast, Medium, or Slow.

Note: The speed you select in the Controls tab applies only to the commands 
you use in the diagnostics software (Jog and Move to teachpoint).

Jogging the plate stage
Jogging the translator plate stage moves the plate stage in small, precise 
increments along one of the axes. You can jog the plate stage to fine- tune its 
position when setting teachpoints.
                                                        

Command Description

Enable motors Turns on the translator motors.

Disable motors Turns off the translator motors.
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To jog the plate stage:

In the Jog Axes area, click one of the following:

To change the jog increment, click the down arrow, and then select the desired 
increment in millimeters or degrees.

Related information

Command Description

 CCW Jogs the plate stage counterclockwise by the 
specified increment.

 CW Jogs the plate stage clockwise by the specified 
increment.

 Left Jogs the plate stage left from the current position 
by the specified increment.

 Right Jogs the robot head right from the current position 
by the specified increment.

For information about... See...

Using the Linear Translator in a 
protocol

VWorks Automation Control User 
Guide

Incubator device Incubator device driver guide

Microplate rotators “Microplate Shuttle and Rotator” on 
page 301

Available devices “BioCel System additional devices 
overview” on page 242
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Microplate Conveyor 

About this topic

This topic describes the Microplate Conveyor, explains its use, and provides 
the configuration instructions.

Description

The Microplate Conveyor is a device that transports microplates in one of the 
following ways:

• Between two robots residing in adjacent BioCel Systems

• Between a BioCel System robot and another device that has its own robot

The Microplate Conveyor has three axes of movements:

• The plate stage at the end of the device moves vertically up and down 
when delivering microplates to and from the conveyor.

• The plate stage rotates microplates in any orientation to accommodate 
device-  or robot- access requirements.

• The conveyor rollers move microplates from one end to the other when 
delivering microplates between two robots.

The Microplate Conveyor can be configured to meet different requirements. In 
most systems, the conveyor has a plate stage at both ends for transporting 
microplates between two robots. In some systems, the conveyor transports 
microplates onto a third- party conveyor that feeds the microplates to storages 
devices, so a plate stage is installed only at one end.

To increase throughput, two conveyors can be stacked, as the following 
diagram shows. 
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Setup workflow

To troubleshoot the conveyor, you use the commands and selections in 
Microplate Conveyor Diagnostics. For more information, see “Using Microplate 
Conveyor Diagnostics” on page 294.

Adding the Microplate Conveyor to the device file

The VWorks software is set up with the correct device configuration to 
communicate with the Microplate Conveyor. You do not need to add a new 
Microplate Conveyor to the device file unless you want to reference different 
profiles or use a different teachpoint file. For information about device files 
and profiles, see “Devices and device file defined” on page 39.

When setting up the Microplate Conveyor, you must:

1 Add the Microplate Conveyor in the device file and specify how the 
conveyor will interact with the BioCel System robot. See “Adding the 
conveyor to the device file” on page 286.

2 Revise the third- party device properties to specify how the conveyor will 
interact with the device. See “Revising the third- party device properties” 
on page 290.

Adding the conveyor to the device file

To add the Microplate Conveyor to the device file:

1 In the VWorks software, open the device file and add the Microplate 
Conveyor. See “Adding and deleting devices in the software” on page 39 for 
instructions.

2 In the Microplate Conveyor Properties area, type or select the following:

Step Procedure See...

1 Install the Microplate Conveyor. Automation Solutions 
Technical Support

2 Add the Microplate Conveyor in the 
device file.

“Adding the Microplate 
Conveyor to the device file” 
on page 286

3 Create a profile for the Microplate 
Conveyor.

“Creating a profile for the 
Microplate Conveyor” on 
page 291

4 Set and edit the teachpoints for the 
Microplate Conveyor.

“Setting teachpoints for the 
Microplate Conveyor” on 
page 293

5 Verify the Microplate Conveyor 
teachpoints.

“Verifying conveyor 
teachpoints” on page 294
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3 In the Devices area, expand Microplate Conveyor, and then select Station 1.

4 In the Microplate Conveyor Station 1 Location Properties area, set the parameters 
for the end that will interact with the BioCel System robot.

Property Description

Name The name of the Microplate Conveyor 
device.

Profile The profile associated with the device.

Select the desired profile from the list. If 
you have not created a profile, see “Creating 
a profile for the Microplate Conveyor” on 
page 291, and then return to this step to 
select the profile.
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Property Description

Allowed/prohibited 
labware

Permitted labware class for the selected 
location.

For example, you might specify that only 
tipboxes are allowed at a given location. For 
details on labware classes, see the VWorks 
Automation Control Setup Guide.

BCR on south/west/north/
east side

The location of the barcode reader and the 
desired barcode reader device.

Use these fields only if a barcode reader is 
installed on this device.

Teachpoint for robot 
<BioCel System Robot>

The name of the teachpoint for the 
Station 1 location. This selection enables 
the BioCel System robot to move correctly 
to and from the Station 1 location during a 
protocol run.

For example, if the robot teachpoint file 
contains a teachpoint for this location, you 
must select that teachpoint.

Note: In simulation mode, select 
<accessible>.

Teachpoint for robot 
<Microplate Conveyor>

The teachpoint that is set up for the 
Microplate Conveyor. Select Station 1.

For setup instructions, see “Setting 
teachpoints for the Microplate Conveyor” on 
page 293.
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5 If the conveyor has two plate stages, in the Devices area, select Station 2 
under Microplate Conveyor.

6 In the Microplate Conveyor Stage 2 Location Properties area, set up the end that 
will interact with the other robot:

Use for deadlock 
avoidance

Option to permit the location to be used for 
deadlock avoidance.

IMPORTANT Always select No for the 
Microplate Conveyor.

Door The internal system door associated with 
this device. For the Microplate Conveyor, 
this is one of the doors between two 
connecting systems.

Note: The door must be configured in the 
BioCel I/O Interface. See “BioCel I/O 
Interface” on page 251.

Property Description

Property Description

Allowed/prohibited 
labware

Permitted labware class for the selected 
location.

For example, you might specify that only 
tipboxes are allowed at a given location. For 
details on labware classes, see the VWorks 
Automation Control Setup Guide.

BCR on south/west/north/
east side

The location of the barcode reader and the 
desired barcode reader device.

Use these fields only if a barcode reader is 
installed on this device.
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7 Select File > Save.

Revising the third-party device properties
Depending on the third- party device you have installed at the Station 2 end of 
the conveyor, you might need to configure the third- party device to interact 
with the Station 2 location.

This section explains how to set the Nexus Universal Store device properties 
for the conveyor. For information on how to set up other devices, see the 
device driver user guide, or contact Automation Solutions Technical Support.

To update the Nexus Universal Store device properties:

1 In the Devices area, expand Nexus Universal Store and select the Nexus 
conveyor location.

2 In the Nexus Universal Store Location Properties area, update the fields that 
will enable interaction with the Microplate Conveyor:

Teachpoint for robot 
<BioCel System Robot>

The name of the teachpoint for the 
Station 2 location. 

If the Station 2 location will interact with 
another BioCel System robot, select the 
teachpoint for that robot.

If the Station 2 location will only interact 
with the another device robot, select <not 
accessible>.

Teachpoint for robot 
<Microplate Conveyor>

The teachpoint that is set up for the 
Microplate Conveyor. If Station 2 is used, 
select Station 2.

For setup instructions, see “Setting 
teachpoints for the Microplate Conveyor” on 
page 293.

Use for deadlock 
avoidance

Option to permit the location to be used for 
deadlock avoidance.

IMPORTANT Always select No for the 
Microplate Conveyor.

Door The internal system door associated with 
this device. For the Microplate Conveyor, 
this is one of the doors between two 
connecting systems.

Note: The door must be configured in the 
BioCel I/O Interface. See “BioCel I/O 
Interface” on page 251.

Property Description
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3 Select File > Save.

Creating a profile for the Microplate Conveyor

The Microplate Conveyor profile allows you to set up communication between 
the translator and the controlling computer. You can also specify other 
parameters, such as the number of plate stages (stations) and the traverse time 
before timeout error is displayed.

To create a profile:

1 In the VWorks software, open Microplate Conveyor Diagnostics.

Property Description

Teachpoint for robot 
<BioCel System Robot>

Select <not accessible>.

Note: In simulation mode, select <not 
accessible>.

Teachpoint for robot 
<Microplate Conveyor>

Select Station 2, because this is the 
teachpoint that will interact with the 
storage device.
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2 Click the Profiles tab.

3 Click Create a new profile. The Create Profile dialog box opens.

4 Type a name for the new profile, and then click OK. The new profile name 
appears in the Profile Management area.

5 In the Profile settings area, set the following parameters:

6 When you are finished, click Update this profile to save the changes.

7 Click Initialize this profile.

Selection or parameter Description

Serial port Select the serial port that connects the 
Microplate Conveyor to the controlling 
computer.

Number of lift/rotate stations Select the number of plate stages present 
on the conveyor.

Plate traverse timeout (sec) Type the length of time, in seconds, the 
microplates are allowed to travel the 
length of the conveyor before a timeout 
error message is displayed.

For each segment of the conveyor, allow 
at least 3 seconds. In the following 
example, the conveyor has two segments.
292 BioCel System User Guide



A   Additional BioCel System Devices
Microplate Conveyor
Setting teachpoints for the Microplate Conveyor

To set the teachpoints for the conveyor, you need to:

• Use Microplate Conveyor Diagnostics to set a teachpoint at each conveyor 
plate stage. The Station 1 teachpoint will be accessed by the BioCel System 
robot. If Station 2 is used, its teachpoint will be accessed by a second 
BioCel System robot or a third- party device.

• Use the instructions in one of the following topics to set a BioCel System 
robot teachpoint at Station 1, and, if applicable, Station 2.

– “Setting Direct Drive Robot teachpoints” on page 69

– “Setting 3- Axis Robot teachpoints” on page 117

– “Setting KiNEDx Robot teachpoints” on page 135

Make sure you turn off the conveyor motors before you start. To turn off 
the motors, see “Turning on and turning off the plate stage motors” on 
page 295.

• If applicable, follow instructions in the third- party user documentation to 
set a teachpoint at Station 2.

Make sure you turn off the conveyor motors before you start. To turn off 
the motors, see “Turning on and turning off the plate stage motors” on 
page 295.

To set the teachpoints using Microplate Conveyor Diagnostics:

1 In Microplate Conveyor Diagnostics, click the Controls tab.

2 In the Lift/Rotate area, select Station 1, and then click Z Disable and 
Theta Disable. The Station- 1 Z and Theta motors are turned off. You should 
be able to rotate and move the Station- 1 plate stage up and down by hand 
without resistance from the motors.
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3 Manually move the BioCel System robot to the Station- 1 plate stage. Use 
the instructions in one of the following topics to set and edit the BioCel 
System robot teachpoint at Station 1.

• “Setting Direct Drive Robot teachpoints” on page 69

• “Setting 3- Axis Robot teachpoints” on page 117

• “Setting KiNEDx Robot teachpoints” on page 135

Note: As you are setting the robot teachpoint, you might need to adjust 
the position of the conveyor plate stage so that the robot can access it 
correctly.

4 In Microplate Conveyor Diagnostics, in the Robot access teachpoint area, click 
Teach robot access.

5 In the Lift/Rotate area, click Z Enable and Theta Enable to turn on the Station-
1 motors.

6 If Station 2 will be accessed by a different BioCel System robot, repeat 
steps 2 through 5 for Station 2.

7 In the Profiles tab, click Update this profile to save the changes.

Verifying conveyor teachpoints

To verify the conveyor teachpoints:

1 Place a microplate on the Station- 1 plate stage.

2 In Microplate Conveyor Diagnostics:

a Click Transfer 1 -> 2 in the Plate transfer area. The conveyor moves the 
microplate from Station 1 to Station 2.

b Click Transfer 2 -> 1 in the Plate transfer area. The conveyor moves the 
microplate from Station 2 to Station 1. 

Check that the conveyor moved the microplate successfully. If necessary, 
edit the teachpoints.

3 For the BioCel System robot, use the instructions in one of the following 
sections to verify and edit the teachpoint:

• “Verifying Direct Drive Robot teachpoints” on page 90

• “Verifying 3- Axis Robot teachpoints” on page 124

• “Verifying KiNEDx Robot teachpoints and waypoints” on page 143

4 For the third- party device or robot, follow the device user documentation 
to verify and edit the teachpoint.
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Using Microplate Conveyor Diagnostics

You can use the commands and parameters in the Microplate Conveyor 
Diagnostics Controls tab to move individual components for troubleshooting 
purposes.

This section explains the following:

• “Homing the plate stage” on page 295

• “Turning on and turning off the plate stage motors” on page 295

• “Moving and rotating the plate stage” on page 296

• “Moving the plate stage to the conveyor teachpoint” on page 297

• “Parking the plate stage” on page 298

• “Moving the conveyor rollers” on page 298

• “Checking the microplate sensor” on page 299

Homing the plate stage
Homing sends the plate stage to the factory- defined home position for each 
axis of motion. You should home the plate stage when recovering from an 
emergency stop.

To home the plate stage:

1 In Microplate Conveyor Diagnostics Controls tab, select the plate stage you want 
to home: Station 1 or Station 2.
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2 Click Home station. The plate stage moves to its home position.

Turning on and turning off the plate stage motors
Turning off the plate stage motors allows you to move the plate stage by hand, 
making it easier to set and edit teachpoints. You must turn on the motors for 
operation.

To turn on or turn off the plate stage motors:

1 In the Lift/Rotate area, select the plate stage you want to work with: 
Station 1 or Station 2.

2 Click one of the following:

Command Description

Z Disable/Enable Turns on or turns off the Z motor. The Z 
motor moves the plate stage up or down. 

Theta Disable/Enable Turns on or turns off the Theta motor. The 
Theta motor rotates the plate stage.
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Moving and rotating the plate stage
You can move the plate stage up and down along the z- axis, or rotate the plate 
stage a specific number of degrees when setting teachpoints or diagnosing 
problems.

To move the plate stage incrementally along the z-axis:

1 In the Lift/Rotate area, select the plate stage you want to work with: 
Station 1 or Station 2.

2 Select the distance you want to move the plate stage from the Up or Down 
list.

To rotate the plate stage:

1 In the Lift/Rotate area, select the plate stage you want to work with: 
Station 1 or Station 2.

2 Select the number of degrees you want to rotate the plate stage from the 
CW (clockwise) or CCW (counterclockwise) list.
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Moving the plate stage to the conveyor teachpoint 
You can move the plate stage to the robot access position. The robot access 
position is also the conveyor teachpoint.

To move the plate stage to the teachpoint:

1 In the Lift/Rotate area, select the plate stage you want to work with: 
Station 1 or Station 2.

2 Click Move to robot access.

Parking the plate stage
The park position is the position at which the plate stage is recessed at one 
end of the conveyor. Move the plate stage to the park position when you want 
the plate stage out of the way while you troubleshoot other parts of the 
conveyor or system. 

To park the plate stage:

1 In the Lift/Rotate area, select the plate stage you want to work with: 
Station 1 or Station 2.

2 Click Move to park position.
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Moving the conveyor rollers
You can move the conveyor rollers in either direction to check that the motors 
are working.

To move the conveyor rollers:

1 Multi- track conveyor only. In the Conveyor area, select the track you want 
to check. Track 1 or Track 2. Track 1 is the set of rollers closest to Station 1. 
Track 2 is the set of rollers closest to Station 2.

2 Click Start conveyor. The conveyor rollers start to move in one direction.

3 To change the direction of the rolling movement, click the Direction button: 
1 -> 2 or 2 -> 1.

Checking the microplate sensor
The microplate sensor at the plate- stage end of the conveyor is used to detect 
the presence of labware at the plate stage. You can check the sensor to see if 
it is working correctly. 
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To check the microplate sensor:

1 Place a microplate on the conveyor plate stage.

2 In the Station 1 Status or Station 2 status area, check the Plate presence 
indicator light. 

If the indicator light is on, the microplate sensor is detecting a labware on 
the plate stage. If the indicator light is off, the microplate sensor is not 
detecting labware. Contact Automation Solutions Technical Support to 
repair or replace the sensor.

Note: The Sensor 1 and Sensor 2 indicator lights are not used.

Related information

For information about... See...

Using the Microplate Conveyor in 
a protocol

VWorks Automation Control User 
Guide

Incubator device Incubator device driver guide

Available devices “BioCel System additional devices 
overview” on page 242
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Microplate Shuttle and Rotator

About this topic

This topic describes the Shuttle and Rotator, explains their uses, and provides 
the configuration instructions.

Descriptions

Shuttle 
A Shuttle has two decks, each with a rotating plate stage containing a pair of 
platepads. The Shuttle allows two BioCel System robots to pass microplates to 
each other concurrently:

1 The BioCel System robot places a microplate on a platepad (1 or 2).

2 The Shuttle turns the platepad pair 180°.

3 The adjacent BioCel System robot picks up the microplate on the platepad 
(2 or 1).

Note: The microplates that are passed between robots maintain the same 
orientation.

Rotator 
A Rotator has a single deck with a rotating plate stage containing a single 
platepad. The Rotator is used to change the orientation of microplates before 
the microplates are placed in devices that require the rotated orientation:

1 The BioCel System robot places a microplate on a Rotator platepad.

2 The Rotator turns the platepad 180°.

3 The BioCel System robot picks up the rotated microplate from the Rotator 
platepad.

4 The BioCel System robot places the rotated microplate in the device that 
requires that orientation.

22
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Setup workflow

Adding the microplate Shuttle or Rotator in the device file 

The VWorks software is set up with the correct device configuration to 
communicate with the microplate Shuttle or Rotator. You do not need to add it 
to the device file unless you want to use a different teachpoint file. For 
information about device files, see “Devices and device file defined” on 
page 39.

Adding the Shuttle or the Rotator to the device file
The software views each Shuttle deck as an independent device with two 
platepads. Therefore, when adding a Shuttle to the device file, you need to add 
two individual decks as devices. In addition, for each deck in the device file, 
you need to add two platepads.

To add a Shuttle to the device file:

1 In the VWorks software, open the device file and add the Shuttle or the 
Rotator. See “Adding and deleting devices in the software” on page 39 for 
instructions.

2 In the Shuttle Properties or the Rotator Properties area, type or select the 
following:

Step Procedure See...

1 Install the Shuttle or Rotator. Automation Solutions 
Technical Support

2 Add the Shuttle or Rotator in the 
device file.

“Adding the microplate 
Shuttle or Rotator in the 
device file” on page 302

3 Create a profile for the Shuttle or 
Rotator.

“Creating a profile for the 
Shuttle or Rotator” on 
page 306

4 Set the teachpoints for the Shuttle 
or Rotator.

“Setting teachpoints for the 
Shuttle or Rotator” on 
page 307
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3 In the Devices area, expand Shuttle or Rotator, and then select the stage 
that will interact with the BioCel System robot.

4 In the Shuttle Properties or the Rotator Properties area, set up the stage that 
will interact with the BioCel System robot:

Property Description

Name The name of the Shuttle or Rotator device.

Profile The profile associated with the device.

Select the desired profile from the list. If 
you have not created a profile, see “Creating 
a profile for the Shuttle or Rotator” on 
page 306, and then return to this step to 
select the profile.
303BioCel System User Guide



A   Additional BioCel System Devices
Microplate Shuttle and Rotator
5 Shuttle only. In the Devices area:

a Select Stage 2 under Shuttle.

b In the Shuttle Properties area, type or set the following parameters:

Property Description

Allowed/prohibited 
labware

Permitted labware class for the selected 
location.

For example, you might specify that only 
tipboxes are allowed at a given location. For 
details on labware classes, see the VWorks 
Automation Control Setup Guide.

BCR on south/west/north/
east side

The location of the barcode reader and the 
desired barcode reader device.

Use these fields only if a barcode reader is 
installed on this device.

Teachpoint for robot 
<BioCel System Robot>

The name of the teachpoint for the Stage 1 
or Stage 2 location. This selection enables 
the BioCel System robot to move correctly 
to and from the location during a protocol 
run.

For example, if the robot teachpoint file 
contains a teachpoint for this location, you 
must select that teachpoint.

Note: In simulation mode, select 
<accessible>.

Shuttle only.  
Teachpoint for robot 
<Shuttle>

The teachpoint that is set up for the 
Shuttle. Select Stage 1.

For setup instructions, see “Setting 
teachpoints for the Shuttle or Rotator” on 
page 307.

Use for deadlock 
avoidance

Option to permit the location to be used for 
deadlock avoidance.

Select Yes to permit labware to be moved to 
this location to avoid a deadlock in the 
system.

Select No if you do not want to move 
random labware to this location to avoid 
deadlock.
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6 Select File > Save.

Property Description

Allowed/prohibited 
labware

Permitted labware class for the selected 
location.

For example, you might specify that only 
tipboxes are allowed at a given location. For 
details on labware classes, see the VWorks 
Automation Control Setup Guide.

BCR on south/west/north/
east side

The location of the barcode reader and the 
desired barcode reader device.

Use these fields only if a barcode reader is 
installed on this device.

Teachpoint for robot 
<BioCel System Robot>

The name of the teachpoint for the stage 
location. Because the Stage 2 location will 
not interact with the robot, select <not 
accessible>.

Teachpoint for robot 
<Shuttle>

The teachpoint that is set up for the 
Shuttle. Select Stage 2.

For setup instructions, see “Setting 
teachpoints for the Shuttle or Rotator” on 
page 307.

Use for deadlock 
avoidance

Option to permit the location to be used for 
deadlock avoidance.

Select Yes to permit labware to be moved to 
this location to avoid a deadlock in the 
system.

Select No if you do not want to move 
random labware to this location to avoid 
deadlock.
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Creating a profile for the Shuttle or Rotator 

The profile allows you to set up communication between the Shuttle or Rotator 
and the controlling computer.

Note: The Shuttle Diagnostics and the Rotator Diagnostics are identical. 
Therefore, the instructions in this section are applicable to both diagnostics 
software.

To create a profile:

1 In the VWorks software, open Shuttle Diagnostics or Rotator Diagnostics.

The Shuttle Diagnostics or Rotator Diagnostics dialog box opens.

2 Click the Profiles tab.

3 Click Create a new profile. The New Profile dialog box opens.

4 Type a name for the new profile, and then click OK. The new profile name 
appears in the Profile Control area.
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5 In the Profile Setting area:

• In the Serial port list, select the serial port that connects the Shuttle or 
Rotator to the controlling computer.

• In the Motion timeout box, type the length of time, in milliseconds, the 
Shuttle or the Rotator will wait for a response before timing out.

You adjust the timeout according to the rotation speed. For example, if 
you adjusted the air pressure so that the rotation speed is slower, you 
should increase the timeout value.

6 Click Update this profile to save the changes.

7 Click Initialize this profile to establish communication with the Shuttle or 
Rotator.

8 Return to the device file and select the profile for the Shuttle or Rotator 
device.

Setting teachpoints for the Shuttle or Rotator

To set teachpoints for the microplate rotators, see one of the following:

• “Setting Direct Drive Robot teachpoints” on page 69

• “Setting 3- Axis Robot teachpoints” on page 117

• “Setting KiNEDx Robot teachpoints” on page 135

When you set the Shuttle or Rotator teachpoints:

1 Teach both system robots simultaneously.

2 Make sure both robots are aligned perfectly with the Shuttle or Rotator. 
You might have to move the Shuttle or Rotator slightly to a position that 
allows the system robots to align perfectly.

Using Diagnostics 

You can use the commands and parameters in the Diagnostics to rotate the 
plate stage pair on one of the decks.

Note: The Shuttle Diagnostics and the Rotator Diagnostics are identical. 
Therefore, the instructions in this section are applicable to both diagnostics 
software.

To turn the plate stage on a deck:

1 In Shuttle Diagnostics or Rotator Diagnostics, click the Controls tab.
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2 In the Motion Control area, click one of the following:

In the Sensors area, the indicator light shows:

Related information

Button Description

Toggle Alternately rotates the plate stage 180° 
clockwise or counterclockwise.

For example, if clicking Toggle rotates the 
plate stage clockwise, the next click will 
rotate the plate stage counterclockwise.

Position 1 Rotates the plate stage 180° clockwise.

The Position 1 button is only active after you 
have clicked Position 2.

Position 2 Rotates the plate stage 180° 
counterclockwise.

The Position 2 button is only active after you 
have clicked Position 1.

Indicator light Description

Position 1 The Position 1 button is active.

Position 2 The Position 2 button is active.

For information about... See...

Using the Shuttle or Rotator in a 
protocol

VWorks Automation Control User 
Guide

Linear Translator “Linear Translator” on page 272

Available devices “BioCel System additional devices 
overview” on page 242
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Orbital Shaking Station 

About this topic

This topic describes the Orbital Shaking Station, explains its use, and provides 
the configuration instructions.

Description

An Orbital Shaking Station is a microplate shaker that can be installed in 
place of a platepad on the BioCel System table. For a full description of the 
Orbital Shaking Station, see the manufacturer’s documentation.

Setup workflow

Step Procedure See...

1 Install the Orbital Shaking Station. Automation Solutions 
Technical Support

2 Add the Orbital Shaking Station in 
the device file.

“Adding the Orbital Shaking 
Station in the device file” on 
page 310

3 Create a profile for the Orbital 
Shaking Station.

“Creating a profile for the 
Orbital Shaking Station” on 
page 312

4 Set, edit, and verify the teachpoint 
for the Orbital Shaking Station.

One of the following:

• “Setting Direct Drive 
Robot teachpoints” on 
page 69

• “Setting 3- Axis Robot 
teachpoints” on page 117

• “Setting KiNEDx Robot 
teachpoints” on page 135
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Adding the Orbital Shaking Station in the device file 

The VWorks software is set up with the correct device configuration to 
communicate with the Orbital Shaking Station. You do not need to add a new 
Orbital Shaking Station to the device file unless you want to use a different 
teachpoint file. For information about device files, see “Devices and device file 
defined” on page 39.

Before you start, make sure that at the Orbital Shaking Station speed control 
(on the power cord), the speed dial is set to PC RS232. This setting allows the 
VWorks software to control the Orbital Shaking Station.

To add the Orbital Shaking Station to the device file:

1 In the VWorks software, open the device file and add the Teleshake 
(Orbital Shaking Station) device. See “Adding and deleting devices in the 
software” on page 39 for instructions.

2 In the Orbital Shaking Station Properties area, type or select the following:

3 In the Devices area, expand the Orbital Shaking device, and then select the 
Stage location.

4 In the Orbital Shaking Station Stage Location Properties area, type or set the 
following:

Property Description

Name The name of the Orbital Shaking Station 
device.

Profile The profile associated with the device.

Select the desired profile from the list. If 
you have not created a profile, see “Creating 
a profile for the Orbital Shaking Station” on 
page 312, and then return to this step to 
select the profile.
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5 Select File > Save.

Property Description

Allowed/prohibited 
labware

Permitted labware class for the selected 
location.

For example, you might specify that only 
tipboxes are allowed at a given location. For 
details on labware classes, see the VWorks 
Automation Control Setup Guide.

BCR on south/west/north/
east side

The location of the barcode reader and the 
desired barcode reader device. Use this field 
only if a barcode reader is installed on the 
device.

Teachpoint for robot 
<BioCel System Robot>

The name of the teachpoint to use for the 
stage location. This selection enables the 
robot to move correctly to and from the 
platepad or device during a protocol run.

For example, if the robot teachpoint file 
contains a teachpoint for this platepad, you 
must select that teachpoint.

Note: In simulation mode, select 
<accessible>.

Use for deadlock 
avoidance

Option to permit the location to be used for 
deadlock avoidance.

Select Yes to permit labware to be moved to 
this location to avoid a deadlock in the 
system.

Select No if you do not want to move 
random labware to this location to avoid 
deadlock.
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Creating a profile for the Orbital Shaking Station 

The Orbital Shaking Station profile allows you to set up communication 
between the Orbital Shaking Station and the controlling computer.

To create a profile:

1 In the VWorks window, select the Orbital Shaking Station device, and then 
click Device diagnostics.

The Orbital Shaking Station Diagnostics dialog box opens.

2 Click the Profiles tab.

3 Click Create a new profile. The Create Profile dialog box opens.

4 Type a name for the new profile, and then click OK. The new profile name 
appears in the Profile area.

5 In the COM port list, select the COM port number used by the Orbital 
Shaking Station.
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6 In the Module type list, select the shaking speed: Standard or High-speed.

7 Click Update this profile to save the changes.

8 Click Initialize this profile to establish communication with the Orbital 
Shaking Station.

9 Return to the device file and select the profile for the Orbital Shaking 
Station.

Using Orbital Shaking Station Diagnostics 

You can use the parameters and commands in Orbital Shaking Station 
Diagnostics to do the following for troubleshooting purposes:

• Set shaking parameters

• Start and stop shaking

To set the shaking parameters:

1 In the Orbital Shaking Station Diagnostics dialog box, click the Controls tab.

2 If you have more than one shaking station installed, select the one you 
want to use in the Select Teleshake to work with list.

3 In the RPM area, set the speed at which you want to shake the microplate.

4 In the Stir Direction area, select the direction in which you want to shake 
the microplate.

To start or stop shaking:

Click Start or Stop.
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Related information

For information about... See...

Using the Orbital Shaking Station 
in a protocol

VWorks Automation Control User 
Guide

Set teachpoints at the Orbital 
Shaking Station

One of the following:

• “Setting Direct Drive Robot 
teachpoints” on page 69

• “Setting 3- Axis Robot teachpoints” 
on page 117

• “Setting KiNEDx Robot teachpoints” 
on page 135
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Phantom Robot 

About this topic

This topic describes the Phantom Robot, explains its use, and provides the 
configuration instructions.

Description

In the VWorks software, every task is associated with a device. The Phantom 
Robot is the virtual device that represents the operator who will manually 
perform a task (move labware) during a programmed pause in a protocol run. 
The software displays a message during the pause. You can indicate the 
completion of the task in the message dialog box so the protocol can continue.

Setup workflow

Adding the Phantom Robot in the device file 

The VWorks software is set up with the correct device configuration. You do 
not need to add a new Phantom Robot to the device file unless you want to 
make adjustments. For information about device files, see “Devices and device 
file defined” on page 39.

To add the Phantom Robot to the device file:

1 In the VWorks software, open the device file and add the Phantom Robot. 
See “Adding and deleting devices in the software” on page 39 for 
instructions.

2 In the Phantom Robot Properties area, type or select the following:

Step Procedure See...

1 Add the Phantom Robot in the 
device file.

“Adding the Phantom Robot 
in the device file” on 
page 315

2 Create a profile for the Phantom 
Robot.

“Creating a profile for the 
Phantom Robot” on page 316
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3 Select File > Save.

Creating a profile for the Phantom Robot 

To create a profile for the Phantom Robot:

1 In the VWorks window, select the Phantom Robot device, and then click Device 
diagnostics.

Property Description

Name The name of the Phantom Robot.

Profile The profile associated with the device.

Select the desired profile from the list. If 
you have not created a profile, see “Creating 
a profile for the Phantom Robot” on 
page 316, and then return to this step to 
select the profile.
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The Phantom Robot Diagnostics dialog box opens.

2 In the Profiles tab, click Create new profile.

3 In the Create Profile dialog box that opens, type a name for the profile, 
and then click OK.

4 Optional. If you want the software to prompt the operator for each robot 
movement, select Prompt user for each robot move.

5 Click Update this profile to save the changes.

6 Click Initialize this profile.

7 Return to the device file and select the profile for the Phantom Robot 
device.
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Related information

For information about... See...

Mounting devices on the docking 
table

Automation Solutions Technical Support

Devices that can be integrated in 
the BioCel System

“Device integration options” on page 23

Available devices “BioCel System additional devices 
overview” on page 242
318 BioCel System User Guide



A   Additional BioCel System Devices
Plate Hotel and Plate Hub Carousel
Plate Hotel and Plate Hub Carousel 

About this topic

This topic describes the Plate Hotel and Plate Hub Carousel, explains their 
uses, and provides the configuration instructions.

Description

Plate Hotel
A Plate Hotel is a vertical rack that stores microplates. The microplates sit on 
individual shelves and are not stacked directly on top of one another. 
Therefore, the microplates can be accessed randomly.

Plate Hub Carousel
Two models of the Plate Hub Carousel are available: Landscape (1) and 
Portrait (2). Both consists of twelve racks (cassettes) that store microplates, 
tipboxes, or other labware. Different rack types are available for each model:

Note: You can use a combination of rack types in each model to meet your 
application requirements.

Feature and rack type Landscape model Portrait model

Maximum number of racks 12 12

Regular microplate rack 16 slots 16 slots

Tall labware rack 6 or 8 slots 7 slots

00253
single plate hotel

0
0
2
5
3
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The Plate Hub Carousel must be used with the VWorks software inventory 
management system for random and dynamic access. For information about 
setting up and using the software inventory management system, see the 
VWorks Automation Control Setup Guide.

Setup workflow

The following setup workflow applies to both the Plate Hotel and the Plate 
Hub Carousel.

                                                        

00247
BioCel
Plate hub

00247

1 2

Step Procedure See...

1 Install the Plate Hotel or Plate Hub 
Carousel.

Automation Solutions 
Technical Support

2 Add the Plate Hub Carousel in the 
device file.

Note: The VWorks software views 
the Plate Hotel as a single rack 
from the Plate Hub Carousel. 
Therefore, to set up a Plate Hotel, 
you add the Plate Hub Carousel in 
the device file.

“Adding the Plate Hub 
Carousel in the device file” 
on page 321

3 Create a profile for the Plate Hotel 
or Plate Hub Carousel.

“Creating a profile for the 
Plate Hotel or Plate Hub 
Carousel” on page 323

4 Set, edit, and verify the teachpoints 
for the Plate Hotel or Plate Hub 
Carousel.

“Setting teachpoints for the 
Plate Hotel or Plate Hub 
Carousel” on page 327
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Adding the Plate Hub Carousel in the device file

Note: The VWorks software views the Plate Hotel as a single rack from the 
Plate Hub Carousel. Therefore, to set up a Plate Hotel, you add the Plate Hub 
Carousel in the device file.

The VWorks software is set up with the correct device configuration to 
communicate with the Plate Hotel or Plate Hub Carousel. You do not need to 
add a new Plate Hub Carousel to the device file unless you want to reference 
different profiles or use a different teachpoint file. For information about 
device files, see “Devices and device file defined” on page 39.

To add the Plate Hub Carousel to the device file:

1 In the VWorks software, open the device file and add the Plate Hub 
Carousel. See “Adding and deleting devices in the software” on page 39 for 
instructions.

2 In the Plate Hub Carousel Properties area, type or select the following:

3 In the Devices area, expand Plate Hub Carousel, and then select Slot 1.
                                                        

Property Description

Name The name of the Plate Hub Carousel device.

Profile The profile associated with the device.

Select the desired profile from the list. If 
you have not created a profile, see “Creating 
a profile for the Plate Hotel or Plate Hub 
Carousel” on page 323, and then return to 
this step to select the profile.
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4 In the Plate Hub Carousel Slot 1 Properties area, type or set the following:

Property Description

Allowed/prohibited 
labware

Permitted labware class for the selected 
location.

For example, you might specify that only 
tipboxes are allowed at a given location. For 
details on labware classes, see the VWorks 
Automation Control Setup Guide.

BCR on south/west/north/
east side

The location of the barcode reader and the 
desired barcode reader device.

Use this field only if a barcode reader is 
installed on the device.

Teachpoint for robot 
<BioCel System Robot>

The name of the teachpoint for the Slot 1 
(bottom- most slot) location. This selection 
enables the robot to move correctly to and 
from the Slot 1 location during a protocol 
run.

For example, if the robot teachpoint file 
contains a teachpoint for this slot, you must 
select that teachpoint.

Note: In simulation mode, select 
<accessible>.

Top teachpoint for robot 
<BioCel System Robot>

The name of the teachpoint for the top-
most slot location.

For example, if the robot teachpoint file 
contains a teachpoint for this slot, you must 
select that teachpoint.

Note: In simulation mode, select 
<accessible>.
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5 Select File > Save.

Creating a profile for the Plate Hotel or Plate Hub Carousel 

You use Plate Hub Carousel Diagnostics to create a profile for both the Plate 
Hotel and Plate Hub Carousel. The Plate Hub Carousel profile allows you to set 
up communication between the Plate Hotel or carousel and the controlling 
computer. You can also set the speed at which the carousel turns and indicate 
the number of cassettes and rack types that will be used.

To create a profile:

1 In the VWorks software, open Plate Hub Carousel Diagnostics.

                                                        

Use for deadlock 
avoidance

Option to permit the location to be used for 
deadlock avoidance.

Select Yes to permit labware to be moved to 
this location to avoid a deadlock in the 
system.

Select No if you do not want to move 
random labware to this location to avoid 
deadlock.

IMPORTANT Always select No for the Plate 
Hub Carousel.

Property Description
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The Plate Hub Carousel Dialog box opens.

2 Click the Profiles tab.

3 Click Create a new profile. The Create Profile dialog box opens.

4 Type a name for the new profile, and then click OK. The new profile name 
appears in the Profile Management area.

5 Plate Hotel only. In the Profile settings area, select Use as plate hotel. Type the 
following values:

6 Plate Hub Carousel only. In the Profile settings area:

• In the Serial port list, select the serial port that connects the Plate Hub 
Carousel to the controlling computer.

• In the Default speed list, select the speed at which you want the Plate 
Hub Carousel to turn: Slow, Medium, or Fast.

                                                        

Parameter Description

Number of slots The number of slots in the Plate Hotel.

Slot spacing (mm) The vertical distance, in millimeters, 
between each Plate Hotel slot.
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7 Plate Hotel only. In the Speed Definitions area, define the three possible 
speeds (High, Medium, Low) as a percentage of the factory- set maximum 
speed. To do this:

a In the Speed list, select the speed you want to define.

b In the Velocity box, type the percentage of factory- set maximum speed. 
For example, you can set the Slow speed at 15% of the factory- set 
maximum speed.

c In the Acceleration box, type the percentage of maximum factory- set 
acceleration. For example, you can set the Slow acceleration at 15% of 
the factory- set maximum acceleration.

8 Plate Hotel only. In the Cassette Number table, select the type of rack to be 
used in each cassette: 6, 8, or 16. Each type is distinguished by the 
maximum number of slots the cassette contains.

9 When you are finished, click Update this profile to save the changes.

10 Click Initialize this profile.

11 Return to the device file and select the profile for the Plate Hub Carousel 
device.

Using Plate Hub Carousel Diagnostics 

You can use the commands and parameters in the Plate Hub Carousel 
Diagnostics Controls tab to:

• Set the home position.

• Turn the carousel to a specific position.
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To set the home position:

1 In the Servo area, click Servo off to turn off the Plate Hub Carousel motors.

2 Manually turn the carousel so that cassette 1 lines up with the robot. You 
can use the teaching jig to make sure the alignment is accurate. For 
information about using the teaching jig, see “Setting Direct Drive Robot 
teachpoints” on page 69, “Setting 3- Axis Robot teachpoints” on page 117, 
or “Setting KiNEDx Robot teachpoints” on page 135.

3 When you are finished aligning the cassette 1 with the robot, move the 
robot and its grippers away from the carousel.

4 In the Servo area, click Servo on to turn on the Plate Hub Carousel motors.

5 Click Set as home in the Home Stop area.

To turn the Plate Hub Carousel:

1 Move the robot away from the Plate Hub Carousel.

2 To move a cassette to the cassette- 1 home position:

a In the Movement area, in the list next to the Move to cassette button, 
select the cassette number.

b Click Move to cassette. The carousel turns until the selected cassette is at 
the cassette- 1 home position.
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3 To turn the carousel a specified number of degrees relative to the home 
position:

a In the box next to the Move to degree button, type an angular position 
(0–360) in degrees.

b Click the Move to degree button. The carousel turns the specified number 
of degrees from the home position.

4 To return the carousel to its home position, in the Home Stop area, click Go 
Home.

Setting teachpoints for the Plate Hotel or Plate Hub Carousel

To set, edit, and verify teachpoints for the Plate Hub Carousel, see one of the 
following:

• “Setting Direct Drive Robot teachpoints” on page 69

• “Setting 3- Axis Robot teachpoints” on page 117

• “Setting KiNEDx Robot teachpoints” on page 135

When you set the teachpoints, use the provided teaching jig to set a teachpoint 
at the following locations:

• Top shelf

• Bottom shelf
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Related information

For information about... See...

Using the Plate Hotel or the Plate 
Hub Carousel in a protocol

VWorks Automation Control User 
Guide

Available devices “BioCel System additional devices 
overview” on page 242
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Platepad 

About this topic

This topic describes the standard platepad, explains its use, and provides the 
configuration instructions.

Description

The standard platepad is a metal block on which a single microplate sits. 
Raised tabs on each side keeps the microplate in place.

Setup workflow

Adding the platepad in the device file

To place a microplate on or remove a microplate from a platepad, you must 
add the platepad device in the device file. The VWorks software is set up with 
the correct device configuration. You do not need to add a new platepad to the 
device file unless you want to use a different teachpoint file. For information 
about device files, see “Devices and device file defined” on page 39.

To add a platepad to the device file:

1 In the device file, add the Plate Pad. See “Adding and deleting devices in 
the software” on page 39 for instructions.

                                                        

Step Procedure See...

1 Install the platepad. Automation Solutions 
Technical Support

2 Add the platepad in the device file. “Adding the platepad in the 
device file” on page 329

3 Set, edit, and verify the teachpoints 
for the platepad.

One of the following:

• “Setting Direct Drive 
Robot teachpoints” on 
page 69

• “Setting 3- Axis Robot 
teachpoints” on page 117

• “Setting KiNEDx Robot 
teachpoints” on page 135
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2 In the PlatePad Properties area, type the name of the platepad.

3 In the Devices area, expand the Plate Pad, and then select the Stage location.

4 In the PlatePad Stage Location Properties area, type or set the following:

Property Description

Allowed/prohibited 
labware

Permitted labware class for the selected 
location.

For example, you might specify that only 
tipboxes are allowed at a given location. For 
details on labware classes, see the VWorks 
Automation Control Setup Guide.
330 BioCel System User Guide



A   Additional BioCel System Devices
Platepad
5 Select File > Save.

Related information

BCR on south/west/north/
east side

The location of the barcode reader and the 
desired barcode reader device. Use this field 
only if a barcode reader is installed on the 
device.

Teachpoint for robot 
<BioCel System Robot>

The name of the teachpoint to use for the 
stage location. This selection enables the 
robot to move correctly to and from the 
platepad or device during a protocol run.

For example, if the robot teachpoint file 
contains a teachpoint for this platepad, you 
must select that teachpoint.

Note: In simulation mode, select 
<accessible>.

Use for deadlock 
avoidance

Option to permit the location to be used for 
deadlock avoidance.

Select Yes to permit labware to be moved to 
this location to avoid a deadlock in the 
system.

Select No if you do not want to move 
random labware to this location to avoid 
deadlock.

Property Description

For information about... See...

Setting a platepad teachpoint One of the following:

• “Setting Direct Drive Robot 
teachpoints” on page 69

• “Setting 3- Axis Robot teachpoints” 
on page 117

• “Setting KiNEDx Robot teachpoints” 
on page 135

Available devices “BioCel System additional devices 
overview” on page 242
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Vacuum Delid Station 

About this topic

This topic describes the Vacuum Delid Station, explains its use, and provides 
the configuration instructions.

Description

The Vacuum Delid Station is a static arm that sits over the waste- bin opening 
in the BioCel System table. Vacuum in the suction cups is used to remove 
labware lids that are dropped into the waste bin below the table.

Note: Vacuum is created using an air source.

Setup workflow

Vacuum-Based Delidder

00308

Step Procedure See...

1 Install the Vacuum Delid Station. Automation Solutions 
Technical Support

2 Add the Vacuum Delid Station in 
the device file.

“Adding the Vacuum Delid 
Station in the device file” on 
page 333

3 Set, edit, and verify the teachpoint 
for the Vacuum Delid Station.

“Setting the teachpoint at the 
Vacuum Delid Station” on 
page 335
332 BioCel System User Guide



A   Additional BioCel System Devices
Vacuum Delid Station
Adding the Vacuum Delid Station in the device file 

The VWorks software is set up with the correct device configuration to 
communicate with the vacuum- based lid remover. You do not need to add a 
new vacuum- based lid remover to the device file unless you want to use a 
different teachpoint file. For information about device files, see “Devices and 
device file defined” on page 39.

To add the Vacuum Delid Station to the device file:

1 In the device file, add the Vacuum Delid Station device. See “Adding and 
deleting devices in the software” on page 39 for instructions.

2 In the Vacuum Delid Station Properties area, type or select the following:

3 In the Devices area, expand the Vacuum Delid Station, and then select the 
Stage location.

                                                        

Property Description

Name The name of the Vacuum Delid Station 
device.

Output point The BioCel I/O Interface port number that 
is used to turn on or turn off the vacuum.

Sensor input point The BioCel I/O Interface port number that 
is used to detect whether the vacuum is 
turned on or turned off.
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4 In the Vacuum Delid Station Location Properties area, type or set the following:

5 Select File > Save.

Property Description

Allowed/prohibited 
labware

Permitted labware class for the selected 
location.

For example, you might specify that only 
tipboxes are allowed at a given location. For 
details on labware classes, see the VWorks 
Automation Control Setup Guide.

Teachpoint for robot 
<BioCel System Robot>

The name of the teachpoint for the stage 
location. This selection enables the robot to 
move correctly to and from the Vacuum 
Delid Station during a protocol run.

For example, if the robot teachpoint file 
contains a teachpoint for this Vacuum Delid 
Station, you must select that teachpoint.

Note: In simulation mode, select 
<accessible>.

Use for deadlock 
avoidance

Option to permit the location to be used for 
deadlock avoidance.

Select Yes to permit labware to be moved to 
this location to avoid a deadlock in the 
system.

Select No if you do not want to move 
random labware to this location to avoid 
deadlock.
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Setting the teachpoint at the Vacuum Delid Station

To set the teachpoint at the Vacuum Delid Station, see one of the following:

• “Setting Direct Drive Robot teachpoints” on page 69

• “Setting 3- Axis Robot teachpoints” on page 117

• “Setting KiNEDx Robot teachpoints” on page 135

Direct Drive Robot procedure

When you set the Vacuum Delid Station teachpoint:

1 Install the provided teaching jig in the robot grippers.

2 Position the robot such that it is centered over the waste bin, and the 
bottom of the teaching jig is touching the top of the metal bar of the 
Vacuum Delid Station.

3 Set the teachpoint. Make sure you:

• Set Approach Ht (with labware) and Approach Ht (no labware) at 0.

• For Place Custom Action, select Vacuum delid.

4 Save the teachpoint.

3-Axis Robot and KiNEDx Robot procedure

When you set the Vacuum Delid Station teachpoint:

1 Open Labware Editor and:

a Make sure the labware definition for the lidded labware is correct. You 
will use the lidded labware for the teaching procedure.

b Record the Lidded Thickness and Robot Gripper Offset values on a piece of 
paper. You will use these values when you set the teachpoint at the 
Vacuum Delid Station.

2 Place the lidded labware at Plate Pad 1 (or at an existing teachpoint that 
the robot can access).

3 In robot diagnostics, use the correct commands to pick up the labware 
from Plate Pad 1 and move it to Nowhere. The robot should still be holding 
the labware at Nowhere.

4 Turn off the robot horizontal- axes motors.

5 Manually move the robot until the labware is centered over the waste bin 
and the top of the lidded labware should just touch the Vacuum Delid 
Station suction cups. You might have to jog the robot along the z- axis to 
correctly position the labware.

Note: If possible, center the labware under the suction cups.

6 From this location, jog the robot up by 5 mm.

7 Turn on the robot horizontal- axes motors.

8 Open the robot grippers and remove the labware.

9 Jog the robot up by the Lidded Thickness value you recorded in step 1.

10 Jog the robot down by the Robot Gripper Offset value you recorded in 
step 1.

11 Set the teachpoint.

12 Save the teachpoint.
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Related information

For information about... See...

Setting up the BioCel I/O Interface “BioCel I/O Interface” on page 251

Using the Vacuum Delid Station in 
a protocol

VWorks Automation Control User 
Guide

Lid Hotel Station “Lid Hotel Station” on page 266

Available devices “BioCel System additional devices 
overview” on page 242
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Waste bin 

About this topic

This topic describes the waste bin, explains its use, and provides the 
configuration instructions.

Description

Waste bin is a container that receives waste in the BioCel System. The 
software views the waste bin as a location (teachpoint) where the robot 
releases the labware that it has in its grippers. A receptacle for trash is 
typically positioned under this teachpoint.

Because it is a teachpoint and can be accessed by the robot, the waste bin is 
treated as a device in the software. 

Setup workflow

Adding the waste bin in the device file 

The VWorks software is set up with the correct device configuration. You do 
not need to add a new waste bin to the device file unless you want to use a 
different teachpoint file. For information about device files, see “Devices and 
device file defined” on page 39.

If the BioCel System is designed with an environmental chamber and an 
automated door separates the waste bin from the system, make sure you also 
add the door to the device file.

To add a waste bin to the device file:

1 In the VWorks software, open the device file and add the Waste Bin device. 
See “Adding and deleting devices in the software” on page 39 for 
instructions.

                                                        

Step Procedure See...

1 Install the waste bin. Automation Solutions 
Technical Support

2 Add the waste bin in the device 
file.

“Adding the waste bin in the 
device file” on page 337

3 Set, edit, and verify the teachpoints 
for the waste bin.

One of the following:

• “Setting Direct Drive 
Robot teachpoints” on 
page 69

• “Setting 3- Axis Robot 
teachpoints” on page 117

• “Setting KiNEDx Robot 
teachpoints” on page 135
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2 In the Waste Bin Properties area, type a name for the Waste Bin.

3 In the Devices area, expand Waste Bin -  1, and then select Hole, the 
location where the robot will drop waste.

4 In the Waste Bin Hole Location Properties area, type or set the following:

Property Description

Allowed/prohibited 
labware

Permitted labware class for the selected 
location.

For example, you might specify that only 
tipboxes are allowed at a given location. For 
details on labware classes, see the VWorks 
Automation Control Setup Guide.
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5 Select File > Save.

To add a waste-bin door to the device file:

1 In the VWorks software, add the waste bin Door device. See “Adding and 
deleting devices in the software” on page 39 for instructions.

2 When setting up the waste bin door, be sure to specify the BioCel I/O 
Interface input and output signals to be used. For detailed instructions, 
contact Automation Solutions Technical Support.

3 Select File > Save.

Related information

BCR on south/west/north/
east side

The location of the barcode reader and the 
desired barcode reader device.

Use this field only if a barcode reader is 
installed on the device.

Teachpoint for robot 
<BioCel System Robot>

The name of the teachpoint to use for the 
Hole location. This selection enables the 
robot to move correctly to and from the 
Waste Bin during a protocol run.

For example, if the robot teachpoint file 
contains a teachpoint for this Waste Bin, 
you must select that teachpoint.

Note: In simulation mode, select 
<accessible>.

Use for deadlock 
avoidance

Option to permit the location to be used for 
deadlock avoidance.

Select Yes to permit labware to be moved to 
this location to avoid a deadlock in the 
system.

Select No if you do not want to move 
random labware to this location to avoid 
deadlock.

Property Description

For information about... See...

Setting a waste teachpoint One of the following:

• “Setting Direct Drive Robot 
teachpoints” on page 69

• “Setting 3- Axis Robot teachpoints” 
on page 117

• “Setting KiNEDx Robot teachpoints” 
on page 135

Setting up the BioCel I/O Interface “BioCel I/O Interface” on page 251

Available devices “BioCel System additional devices 
overview” on page 242
339BioCel System User Guide



A   Additional BioCel System Devices
Weigh Pad
Weigh Pad 

About this topic

This topic describes the Weigh Pad, explains its use, and provides the 
configuration instructions.

Description

A Weigh Pad is an electronic monitor that checks the percentage of liquid in 
the bottle resting on the Weigh Pad. By monitoring the weight of the bottle, the 
Weigh Pad controls when the Pump Module is activated. The Weigh Pad works 
with the Pump Module to maintain an optimum level of liquid and ensures the 
bottle is not overfilled. If no Pump Module is used, an alarm can be set up to 
sound when the liquid level is too low or too high.

Multiple Weigh Pads are connected to the Weigh Pad hub. The hub enables 
communication between the Weigh Pads and the controlling computer. For a 
detailed description and location of the Weigh Pad hub, see “Weigh Pad hub 
(optional)” on page 20.

Two sizes of Weigh Pads are available: Large and small. The Weigh Pad size 
should accommodate the bottle size.

Setup workflow

Note: Weigh Pads are typically installed under the system table and do not 
interact with the robot. Therefore, you do not need to set teachpoints for 
Weigh Pads.

00110
Weighpads

Step Procedure See...

1 Install the Weigh Pad. Automation Solutions 
Technical Support

2 Add the Weigh Pad in the device 
file.

“Adding the Weigh Pad in the 
device file” on page 341

3 Create a profile for the Weigh Pad. “Creating a profile for the 
Weigh Pad” on page 341

4 Set up the bottle library. “Setting up the bottle library” 
on page 343

5 Calibrate the Weigh Pads. “Calibrating the Weigh Pads” 
on page 344

6 View the bottle status. “Viewing the bottle status” on 
page 345
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Adding the Weigh Pad in the device file 

The VWorks software is set up with the correct device configuration for the 
Weigh Pad. You do not need to add a new Weigh Pad to the device file unless 
you want to add more Weigh Pads to the system. For information about device 
files, see “Devices and device file defined” on page 39.

To add the Weigh Pad to the device file:

1 In the VWorks software, open the device file and add the Weigh Pad. See 
“Adding and deleting devices in the software” on page 39 for instructions.

2 In the Weigh Pad Properties area, type or select the following:

3 Select File > Device File > Save.

Creating a profile for the Weigh Pad 

The Weigh Pad profile allows you to set up communication between the Weigh 
Pad and the controlling computer.

To create a profile:

1 In the VWorks software, open Weigh Pad Diagnostics.

Property Description

Name The name of the Weigh Pad device.

Profile The profile associated with the device.

Select the desired profile from the list. If you 
have not created a profile, see “Creating a 
profile for the Weigh Pad” on page 341, and 
then return to this step to select the profile.
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The Weigh Pad Diagnostics dialog box opens.

2 Click the Profiles tab.

3 Click Create a new profile. The Create Profile dialog box opens.

4 Type a name for the new profile, and then click OK. The new profile name 
appears in the Profile area.

5 In the Profile Properties area:

a In the COM port list, select the serial port that connects the Weigh Pad 
to the controlling computer.

b In the Number of list, select the number of Weigh Pads that are installed.

c If you are not sure how many Weigh Pads are connected to the system, 
click Auto-detect modules. The Number of Weigh Pads updates.
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6 Click Update this profile to save the changes.

7 Click Initialize this profile to establish communication with the Weigh Pad.

8 Return to the device file and select the profile for the Weigh Pad device.

Setting up the bottle library 

For each bottle you want the system to monitor, you must specify the weight 
of the bottle and the density of its contents. The software will use the 
information to maintain optimum liquid level and prevent overfilling.

To set up the bottle library:

1 In Weigh Pad Diagnostics, click the Bottle Library tab.

2 In the Bottle Profiles area, click Create a new bottle. A new default bottle name 
appears in the Select list.

3 To change the bottle name, double- click the default bottle name, type a 
new name, and then click Rename this bottle. The new name appears in the 
Select list.
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4 In the Bottle Properties area:

a In the Mass of empty bottle box, type the mass (weight) of the empty 
bottle in grams.

b In the Density of liquid box, type the density of the liquid in grams per 
liter.

5 Click Update this bottle.

6 Repeat steps 2 through 5 for the remaining bottles.

Calibrating the Weigh Pads 

To ensure the system accurately monitors the bottles and their contents, you 
must calibrate the Weigh Pads.

To calibrate the Weigh Pads:

1 In Weigh Pad Diagnostics, click the Calibration tab.
344 BioCel System User Guide



A   Additional BioCel System Devices
Weigh Pad
2 In the Weigh Pad Calibration and Readings table, select the Weigh Pad you want 
to calibrate.

3 Click Calibrate selected pads. A dialog box opens. Follow the instructions in 
the dialog box to add or remove the liquid you want to use for the 
calibration process. If the calibration is correct for the density of the 
liquid, the dialog box displays a volume, in milliliters.

4 Place the empty bottle on the Weigh Pad.

5 Click Tare selected pads to set the Weight and Volume reading at 0.

6 When you are finished calibrating and taring the Weigh Pad, click OK to 
save the changes.

Viewing the bottle status

To view the bottle status:

1 In Weigh Pad Diagnostics, click the Calibration tab.

2 In the Weigh Pad Calibration and Readings table, check the following:

Related information

Column Description

Pad # The numeric identifier that is 
assigned to a Weigh Pad as it is 
added in the software.

Pad name The name associated with the 
Weigh Pad.

You can provide a name for the 
Weigh Pad. To do this, double-
click in the Pad name cell, and 
then type a name.

Bottle type The bottle on the Weigh Pad. The 
bottle type information is 
obtained from the bottle profile.

Weight, g The current weight of the bottle 
and its contents.

Volume, mL The current volume of liquid in 
the bottle. The software 
calculates the volume from the 
bottle information (weight of 
empty bottle and liquid density).

Calibration mass, g The weight used to calibrate the 
Weigh Pad.

For information about... See...

Using the Weigh Pad in a protocol VWorks Automation Control User 
Guide

Available devices “BioCel System additional devices 
overview” on page 242
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Block diagrams

This appendix provides block diagrams and descriptions of the 
following:

• “Power system” on page 348

• “Air system” on page 351

• “Vacuum system” on page 353
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Power system

About this topic

This topic summarizes the power system of the BioCel System. Becoming 
familiar with how your BioCel System is wired will help you to understand the 
behavior of your BioCel System and solve problems.

Overview diagram

The power system is summarized in the following diagram. Dotted lines are 
signal circuits and solid lines are AC and DC power circuits. Those elements 
that lie inside the power panel are enclosed in red dotted lines.

Note: By default, the system contains the following power strip connections: 
two post- UPS/post- emergency stops, one post- UPS/pre- emergency stop, and 
one optional pre- UPS/pre- emergency stop.
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Main power

The main AC power enters at the external connections and travels down inside 
the corner post to the power panel. It passes through a main fuse, through the 
main switch, and out of the power panel to the UPS.

Pre-UPS, pre-emergency stop current

One or more electrical lines branch off before the UPS to supply current to 
devices that do not require backup power supply. Some examples of these 
optional devices include:

• Cooling and heating water baths

• Environmental controller console that houses the controllers for the main 
BioCel (not for any separate environmental enclosures)

• Incubators (environmental control, not transfer mechanism)

Because these devices receive pre- UPS, pre- emergency stop current, they are 
not affected by emergency stops or interlocks. However, they are not buffered 
by the UPS from power outages.

UPS connections

From the UPS, current is passed back into the power panel and through the 
main switch to the rest of the BioCel System. This means that when you turn 
off the main switch, current is cut to the UPS, but it is also cut between the 
UPS and the main part of the BioCel System, preventing the BioCel System 
and its devices from draining the UPS. The UPS will continue to be drained by 
the computer, monitor, and communication hubs, which is why the shutdown 
procedure includes a step for turning off the UPS. 

Pre-emergency stop

After the main switch, the electrical line enters a bank of connections in the 
power panel known as the pre- emergency stop block. A pre- emergency stop 
power strip is connected to this block. Devices wired from the pre- emergency 
stop power strip do not have their power cut when an emergency stop is 
activated. For example, the robot retains power after activation of an 
emergency stop because its DC power is supplied by the robot DC power 
supply fed from the pre- emergency stop block. 

Emergency stop and interlocks

An electrical line from the pre- emergency stop block enters the emergency 
stop relay which controls the emergency stop circuit. One output from the 
emergency stop relay powers an interlock circuit switch. Another output 
supplies the BioCel System power strips from which most of the BioCel System 
devices and system components receive current. These devices and system 
components are all wired after the emergency stop and therefore receive no 
current when an emergency stop is activated. This includes the BioCel I/O 
Interface and cooling fans, which use DC electricity produced by the system 
DC power supply. 

If an emergency stop is activated, the reset button must be pushed to reset the 
emergency stop relay to a position that allows current to flow.
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The window interlock system creates a circuit with the emergency stop relay. 
If an interlock relay (window) is opened during a run, the circuit is disrupted, 
thus stopping the robot servos, the Vertical Pipetting Station motors, and the 
Bravo Platform motors, and turns on their respective z- axis brakes. The brakes 
make sure that the pipette head and robot do not drop, preventing damage and 
eliminating a crushing hazard.

The interlock system is bypassed when the interlock override switch is 
activated by turning a key on the power panel. This maintains current in the 
enable wires even when the interlock relays are open.

Related information

For information about... See...

Systems affected by interlocks and 
emergency stops

“Power system” on page 348

Stopping a run in an emergency BioCel System Safety Guide

Turning the BioCel System off “Starting up and shutting down the 
BioCel System” on page 32
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Air system

Air and power interaction

The following diagram shows how the air and power systems interact. 
Becoming familiar with these systems will help you to understand the behavior 
of your BioCel System and solve problems.

Note: The Direct Drive Robot does not require air supply to operate.

Air system description

Air is used on the BioCel System to:

• Move parts, such as the 3- Axis Robot or KiNEDx Robot grippers, Labware 
Stacker grippers, and Vertical Pipetting Station shelves

• Create a vacuum, such as for the Vacuum Delid Station

The flow of air through the system is controlled by air pressure regulators. 
Many devices have their own built- in regulators. Air pressure to other parts is 
controlled by regulators in the air panel of the BioCel System.

The diagram above shows how air to the BioCel System can be cut off:

• Turning off the AIR switch on the power panel

• Turning off the main air shutoff valve in the air panel

• Turning off the main power in the power panel

• Pressing an emergency stop button (for emergency stops only)
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Related information

For information about... See...

Power system “Power system” on page 348

Vacuum system “Vacuum system” on page 353

Emergency stop BioCel System Safety Guide
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Vacuum system

Vacuum flow diagram

The following diagram shows the vacuum flow in the optional vacuum system.

Vacuum system description

A vacuum may be used on the BioCel System for:

• Filtration stations

• Suction to hold plates flat on a Vertical Pipetting Station shelf

• Third- party devices

The vacuum can be supplied by a pump or house vacuum system. If a house 
vacuum system is used, the main vacuum line enters the BioCel System with 
the other external connections. If a pump is used, it will be located on the 
floor of the BioCel System.

A reserve vacuum tank may be used to ensure an instantaneous vacuum 
supply.

Waste liquid produced by filtration stations is collected in one or more waste 
containers.

Vacuums are also created in devices using vacuum ejectors that create the 
vacuum at the site where it is required, such as at the Vacuum Delid Station. 
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Related information

For information about... See...

Power system “Power system” on page 348

Air system “Air system” on page 351

Emergency stop BioCel System Safety Guide
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Quick reference

This appendix provides a quick reference of the following:

• “DDR Diagnostics” on page 356

• “3- Axis Robot Diagnostics” on page 375

• “KiNEDx Robot Driver Diagnostics” on page 381

For information about the Staubli robot, see the Staubli TX60 
Device Driver User Guide.

http://www.chem.agilent.com/Library/usermanuals/Public/G5415-90049_DDUG_EN.pdf
http://www.chem.agilent.com/Library/usermanuals/Public/G5415-90049_DDUG_EN.pdf
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DDR Diagnostics

This topic explains the menu commands, selections, options, and status 
information in the DDR Diagnostics dialog box. The topics are:

• “Robot status area” on page 356

• “Log area” on page 358

• “Jog/Move tab” on page 359

• “Teachpoints tab” on page 365

• “Cycler tab” on page 368

• “Setup tab” on page 369

• “Advanced tab” on page 371

• “Profiles tab” on page 373

Robot status area

Selection or command Description

Labware Allows you to select a labware.

Editor Opens the Labware Editor.

Speed Sets the robot speed: Slow, Medium, or Fast.
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Plate sensor Indicates the presence of labware in the robot 
grippers.

If the indicator light is on, a labware is in the 
robot grippers. If the indicator light is off, the 
sensor does not detect a labware in the robot 
grippers.

Robot homed Indicates that the robot is in the factory- defined 
home position.

Gripper homed Indicates that the robot grippers are in the 
factory- defined home position.

Z (mm) Displays the current z- axis coordinate relative to 
the home position.

Waist (°) Displays the current waist coordinate relative to 
the home position.

Elbow (°) Displays the current elbow coordinate relative to 
the home position.

Wrist (°) Displays the current wrist coordinate relative to 
the home position.

Gripper (mm) Displays the current distance between the two 
grippers.

 Pans, or moves the image. Click the button, and 
then drag the image in the desired direction.

 Rotates the image. Click the button, and then drag 
the image to rotate it in the desired direction. 
Alternatively, click the middle mouse button or 
wheel, and then drag the image to rotate it.

 Increases or reduces the image magnification. 
Click the button, and then drag the image upward 
or downward to increase or decrease the 
magnification respectively. Alternatively, scroll the 
mouse wheel to change the magnification.

 Resets the image to the default view.

 Saves the current view as the default view.

Selection or command Description
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Log area

Shows the status of the commands, actions, and progress as you work in the 
dialog box.
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Jog/Move tab

General commands

Command Description

New teachpoint here Creates a new teachpoint at the current 
coordinates.

Disable Motors/Enable Motors Disables or enables the robot joint 
motors. When disabling the motors, the 
robot will first finish the current 
command before stopping.

For safety reasons, disabling the motors 
disables the joint motors only. You cannot 
disable the z- axis motor.

Home robot Sends the robot to the factory- defined 
home position for each of the axes of 
motion.

Home gripper Sends the grippers to the factory- defined 
home position.

Note: Homing the grippers does not home 
the rest of the robot.
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Retrace to safe zone Enables the robot to search for the 
closest teachpoint, and then use the path 
from that teachpoint to return to the safe 
zone.

If the robot is unable to find a teachpoint 
nearby, it will retreat into the safe zone 
by retracing the path it took to reach the 
current location.

Use the Retrace to safe zone command 
when, for example, the robot grippers are 
within a device, and using the Move to 
safe zone command might cause the robot 
to run into the sides of the device or 
other obstacles.

Move to safe zone Enables the robot to search for the 
closest teachpoint, and then use the path 
from that teachpoint to return to the safe 
zone.

If the robot is unable to find a teachpoint 
nearby, it retracts radially into the safe 
zone.

Use the Move to safe zone command if it 
is close to a teachpoint and the path 
from that teachpoint to the safe zone is 
clear or obstacles.

Stop Motors Immediately cuts power to the robot 
motors, thus stopping the robot.

About Displays the DDR Diagnostics version 
number and copyright information.

Command Description
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Jog area: Tool space commands

Command or parameter Description

Tool space Displays the jog buttons to move the 
robot waist, elbow, wrist, and arm so that 
the labware moves to its target location 
along the x- or y- axis. In addition, you 
can rotate the labware (Phi angle) and 
move the robot arm up and down along 
the mast or z- axis. In tool space, all 
movements are measured with respect to 
the center of the labware.

Tool space jog buttons:

X:   

Y:   

Phi:  

Jogs the robot in the specified direction 
by the specified distance in millimeters 
or by the specified angle.

X and Y jog increment Specifies the distance, in millimeters, the 
robot moves when you click an x-  or y-
axis jog button.

Phi jog increment Specifies the distance, in degrees, the 
labware rotates when you click a rotating 
jog button.
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Jog area: Joint space commands

                                                        

Command or parameter Description

Joint space Displays the jog buttons to rotate the 
robot’s entire body about its waist joint, 
rotate its forearm about its elbow joint, 
and rotate its hand about the wrist joint. 
In addition, you can move the robot arm 
up and down along the mast or z- axis.

Wrist/Elbow/Waist jog buttons:

  

Jogs the robot in the specified direction 
by the specified degrees.

Joint jog increment Specifies the angle, in degrees, the robot 
rotates when you click a rotating jog 
button.
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Jog area: Gripper commands

Jog area: Z-axis commands

Command or parameter Description

Landscape: Open/Close Opens or closes the robot grippers to 
accommodate the landscape labware 
orientation.

Portrait: Open/Close Opens or closes the robot grippers to 
accommodate the portrait labware 
orientation.

Gripper jog buttons:

  

Opens or closes the robot grippers by the 
specified distance.

Gripper jog increment Specifies the distance, in millimeters, the 
robot grippers move when you click an 
open or close gripper jog button.

Command or parameter Description

Z Axis jog buttons:

  

Jogs the robot along the z- axis in the 
specified direction by the specified 
distance.

Z Axis jog increment Specifies the distance, in millimeters, the 
robot moves when you click one of the 
Z Axis jog buttons.
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Move area

Selection or command Description

Teachpoint selection Allows you to select from the list of available 
teachpoints.

Right/Left/Optimal Specifies the robot- arm orientation at the 
selected teachpoint.

Transfer buttons:

  

Picks up labware from a selected teachpoint 
and places the labware at the other selected 
teachpoint. 

Pick from Picks up labware from the selected 
teachpoint.

Place to Places labware at the selected teachpoint.

Move to Moves the robot grippers to the selected 
teachpoint.
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Teachpoints tab

Commands

Teachpoints table

Command Description

Teach mode Enables you to move the robot arm and 
hand freely without resistance.

 (Maximize/Minimize) Displays all of the columns or displays 
the first few columns in the teachpoints 
table.

New teachpoint Adds a new teachpoint in the table.

Delete selections Deletes the selected teachpoints.

Save teachpoints Saves the changes made to the 
teachpoints.

Column name Description

Name The name of the teachpoint. To change 
the name, double- click the box and type 
the new name.
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 Orientation The orientation of the labware from the 
robot’s perspective. Double- click to 
change the A1 well orientation.

Note: You cannot change the robot- arm 
orientation (R or L) or the labware 
orientation (portrait or landscape). The 
software automatically sets these 
orientations when you set the teachpoint.

 Regrip Station The regrip station designation. Select the 
check box to designate the teachpoint as 
a regrip station.

Note: Regrip stations cannot be used for 
other purposes such as deadlock 
avoidance.

Approach Ht (with labware) The height clearance, in millimeters, the 
robot must maintain above the teachpoint 
as it moves towards or away from the 
teachpoint with labware in its grippers. 

Approach Ht (no labware) The height clearance, in millimeters, the 
robot must maintain above the teachpoint 
as it moves towards or away from the 
teachpoint with no labware in its 
grippers.

Approach Distance The distance, in millimeters, from the 
teachpoint within which the robot must:

• Maintain the specified approach 
height.

• Move in a straight line toward or 
away from the teachpoint.

Minimum Gripper Offset The vertical distance, in millimeters, from 
the teachpoint to the lowest point where 
the grippers will hold the labware at the 
teachpoint. The default value is 0 mm.

This value is used with the Maximum 
gripper offset value to define a range 
within which the grippers can hold the 
labware at the teachpoint location.

IMPORTANT During the run, the 
VWorks software checks the gripper 
offset range defined in this tab and the 
range in the labware’s definition. 

IMPORTANT For regrip stations, make 
sure the range can accommodate all 
labware.

Column name Description
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Maximum Gripper Offset The vertical distance, in millimeters, from 
the teachpoint to the highest point where 
the grippers will hold the labware at the 
teachpoint. The default value is 10 mm.

This value is used with the Minimum 
gripper offset value to define a range 
within which the grippers can hold the 
labware at the teachpoint location.

Position Z The z- axis coordinate of the robot 
measured in millimeters.

Waist The waist joint coordinate.

Elbow The elbow joint coordinate.

Wrist The wrist joint coordinate.

Pick Custom Action The actions that the robot will perform at 
the teachpoint.

Use the Pick Custom Action to:

• Relid labware at a Lid Hotel Station.

• Stir the labware at the teachpoint.

Place Custom Action The actions that the robot will perform at 
the teachpoint.

Use the Place Custom Action to:

• Delid labware at the Lid Hotel 
Station or the Vacuum Delid Station.

• Press down labware to secure 
placement.

Last modified The timestamp that shows when a 
teachpoint was changed.

Column name Description



C   Quick reference
DDR Diagnostics

368 BioCel System User Guide

Cycler tab

Command or option Description

Insert teachpoints Allows you to select the desired 
teachpoints from the existing teachpoints 
list.

Remove teachpoints Removes the selected teachpoints from 
the Teachpoints list.

Pause after ___ cycles Pauses the cycling after the specified 
number of cycle times.

All permutations Runs the all- permutations cycling 
sequence.

Start/Pause Starts the cycling.

Stop Stops the cycling. The robot will stop 
after the current pick- and- place action.
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Setup tab

Speed definitions
The following robot speeds are definable as a percentage of the factory- set 
maximum speed. The default percentage settings are as follows:

Gripper Settings (mm)

Speed Default

Slow 20%

Medium 50% 

Fast 80%

Command or option Description

Open pos The distance, in millimeters, between the 
grippers when they are open. The default 
values are 132 mm (landscape) and 
95 mm (portrait).

Close target The approximate distance, in millimeters, 
between the grippers when they are 
closed. The default values are 123.5 mm 
(landscape) and 81.5 mm (portrait).

The Close target value is always used in 
conjunction with the Close tolerance 
value.
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Table dimensions and Robot Position

Commands

Close tolerance The distance, in millimeters, the Close 
target is allowed to vary without causing 
an error. The default value is +/- 3 mm.

Base clearance The z- axis coordinate at which the 
bottom of the grippers touches the top of 
the base.

Finger height The height of the grippers, measured 
from the midpoint of the gripper pads.

Command or option Description

W1/2 The width of the robot- attachment 
surface. W1 and W2 specify the lengths 
of the two segments of the width. The 
line that intercepts the end of W1 and 
the beginning of W2 runs through the 
center of the robot base.

D1/2 The depth of the robot- attachment 
surface. D1 and D2 specify the lengths of 
the two segments of the depth. The line 
that intercepts the end of D1 and the 
beginning of D2 runs through the center 
of the robot base.

Robot angle The angle between the robot 0° position 
relative to the D- axis.

Command or option Description

Save ALL advanced settings to 
file

Saves the current robot settings to a file.

Restore ALL advanced settings to 
file

Restores the robot settings from the 
selected file.

Command or option Description
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Advanced tab

Commands

Temperatures (°C)

Command or option Description

Dump controller’s log to file Saves the robot controller log to a file.

Move to shipping position Tucks the robot forearm and hand under 
the bicep to permit the installation of the 
shipping brace.

Update robot firmware Backs up the existing robot firmware, 
and then updates, restores, or installs the 
selected firmware.

Caution: If you have robot firmware 
version 1.1 or earlier, contact Automation 
Solutions Technical Support before 
starting the update procedure.

Update gripper firmware Updates the selected gripper firmware.

Back up robot firmware Backs up the robot firmware.

Component Description

Z motor The temperature of the z- axis motor.

Bicep cavity The temperature of the bicep interior.
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Bus Voltages (V)

                                                        

Controller CPU The temperature of the contoller CPU.

Z amplifier The temperature of the z- axis amplifier.

Waist The temperature of the waist interior.

Elbow The temperature within the elbow.

Wrist The temperature inside the wrist.

Component Description

Z motor The voltage delivered to the z- axis motor.

Waist The voltage delivered to the waist motor.

Elbow The voltage delivered to the elbow motor.

Wrist The voltage delivered to the wrist motor.

Component Description
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Profiles tab

Profile Management area

Selection or command Description

Profile name Displays the selected profile. Also allows you 
to select from the list of available profiles.

Create a new profile Creates a new profile.

Create a copy of this profile Creates a duplicate copy of the selected 
profile.

Rename this profile Renames the selected profile.

Delete this profile Deletes the selected profile.

Update this profile Saves changes to the selected profile.

Initialize this profile Initiates communication with the robot using 
the selected profile.
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Robot Identifiers area

Teachpoint File area

Miscellaneous area

Display value or command Description

Device ID Displays the name of the robot. This name is 
displayed in the Discovered BioNet Devices 
dialog box.

MAC address Displays the MAC address that identifies the 
robot. The address is displayed in the 
Discovered BioNet Devices dialog box.

IP address Displays the IP address that uniquely 
identifies the robot. The address is displayed 
in the Discovered BioNet Devices dialog box.

Find available Direct Drive 
Robot

Opens the Discovered BioNet Devices dialog 
box so that you can locate and select the 
robot.

Display value or command Description

File path Displays the location of the selected 
teachpoint file.

New Allows you to create a new teachpoint file.

Select Allows you to select an existing teachpoint 
file.

Save as Allows you to change the teachpoint file 
name or storage location from the default.

The default teachpoint file name is 
Teachpoints_<profilename>.xml, where 
<profilename> is the name of the profile. The 
software saves the file in the C:\VWorks 
Workspace folder.

Option Description

All regrip stations are safe 
from above

Indicates sufficient clearance at all regrip 
stations to permit the robot to rotate its 
wrist at the approach height.

Use this option if one or more regrip stations 
will be used for changing labware orientation.
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3-Axis Robot Diagnostics

This topic explains the menu commands, selections, options, and status 
information in the 3- Axis Robot Diagnostics dialog box. The topics are:

• “Controls tab” on page 375

• “Profiles tab” on page 379

Controls tab

Robot Speed area

Servo control area

Selection Description

Slow Sets the robot speed at Slow.

Medium Sets the robot speed at Medium.

Fast Sets the robot speed at Fast.

Selection Description

R & T servos on Turns on the robot r- axis and t- axis motors.

R & T servos off Turns off the robot r- axis and t- axis motors.
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Teach/Process area

Command or parameter Description

Position 1 The teachpoint from which the robot will 
either pick up or place a labware.

Position 2 The teachpoint from which the robot will 
either place or pick up a labware. 

Approach height (mm) The height clearance (in millimeters) the 
robot must maintain above the teachpoint as 
it:

• Moves towards the teachpoint to place 
labware. Use this setting if raised tabs or 
walls at the front of the teachpoint might 
obstruct the robot.

• Moves away from the teachpoint after 
picking up labware. Use this setting if 
raised tabs or walls at the front of the 
teachpoint might obstruct the robot.

• Moves to and from the teachpoint when 
the Drop into position option is selected. 
Use this setting if raised tabs or walls at 
the sides of the teachpoint do not 
obstruct but might be in contact with the 
robot grippers during labware pickup or 
placement. The contact does not damage 
the grippers or the platepad, stage, or 
shelf.

You can reduce the approach height to 
prevent collision with shelves or other 
obstacles above the teachpoint.

Regrip offset (mm) The height difference between the specified 
robot gripper offset and the actual allowable 
offset because of structural constraints at the 
teachpoint.

Use this parameter if the teachpoint location 
has high walls or other structures that 
prevent the robot from holding the labware at 
the correct height during pickup.

Plate present The indicator that shows whether a labware 
is present in the robot grippers.

Ignore errors The option of ignoring errors when using the 
diagnostics software.

Move to point Moves the robot to the selected teachpoint.
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Position Control area

Pick & Place 1 - > 2 Picks up labware from Position 1 and places 
it at Position 2.

Teachpoint here Sets the teachpoint at the current robot 
position.

Drop into position The option of maintaining the specified 
approach height as robot picks up and places 
labware during a protocol run. 

Use this option if the teachpoint has raised 
tabs or walls at the sides that might obstruct 
the robot grippers.

Add new point Allows you to create a new teachpoint in the 
teachpoint file.

Rename point 1 Allows you to rename the selected teachpoint 
in the Position 1 list.

Interpolate points Opens a wizard that allows the software to 
set multiple teachpoints between two 
specified teachpoints.

Stop Stops the robot.

Command or display value Description

Refresh time The length of time it takes for the software to 
receive the positional coordinates from the 
robot.

Z (mm) The current z- axis coordinate relative to the 
home position.

R (mm) The current r- axis coordinate relative to the 
home position.

T (°) The current t- axis coordinate relative to the 
home position.

Home Sends the robot to the factory- defined home 
position for each axis of motion. The homing 
process recalibrates the robot position along 
each axis.

Move to rest position Sends the robot directly to the factory-
defined home position without recalibrating 
each axis of motion. (Resting the robot is 
faster than homing the robot.)

 Down Jogs the robot down from the current 
position by the specified z- axis increment.

 Up Jogs the robot up from the current position 
by the specified z- axis increment.

Command or parameter Description
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Labware Settings area

Barcode Testing area

Teachpoint File area

 In Jogs the robot toward its home position by 
the specified r- axis increment.

 Out Jogs the robot away from its home position 
by the specified r- axis increment.

 CW Jogs the robot clockwise from the current 
position by the specified t- axis increment.

 CCW Jogs the robot counterclockwise from the 
current position by the specified t- axis 
increment.

 Close gripper Closes the robot grippers by the specified 
grip increment.

 Open gripper Opens the robot grippers by the specified 
grip increment.

Jog increment (mm or 
degrees)

The distance, in millimeters or in degrees, the 
robot moves when you click a jog direction 
command.

Command or parameter Description

Edit Allows you to edit the selected labware 
definition.

Labware list The list of labware definitions.

Gripper offset (mm) The height at which the robot should grip the 
labware.

Note: The setting is temporary and is used 
only during the current diagnostic session. To 
save the new value for the labware, use the 
Labware Editor.

Command Description

Read barcode Uses the barcode reader under the robot 
gripper to scan the labware barcode.

Selection Description

Create New Allows you to create a new teachpoint file.

 Browse Allows you to open an existing teachpoint file 
on the computer.

Command or display value Description
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Profiles tab

Profile Management area

Profile Settings area

Selection or command Description

Profile The list of profiles.

Create a new profile Creates a new profile.

Create a copy of this profile Creates a duplicate copy of the selected 
profile.

Rename this profile Renames the selected profile.

Delete this profile Deletes the selected profile.

Update this profile Saves changes to the selected profile.

Initialize this profile Initiates communication with the robot using 
the selected profile.

Selection or command Description

Robot COM port The serial port that connects the controlling 
computer to the robot.

BCR COM port The serial port that connects the robot 
barcode reader to the controlling computer.
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Gripper open delay (ms) The length of time, in milliseconds, that the 
robot waits after the grippers start to open. 

An optimum value allows the robot to fully 
release the labware before moving to the next 
destination. A lower- than- optimum value 
causes the robot to drag the labware from its 
current location before releasing it at an 
unintended location.

Gripper close delay (ms) The length of time, in milliseconds, that the 
robot waits after the grippers start to close.

An optimum value allows the robot to pick 
up the labware at the correct height before 
moving to the next destination. A lower- than-
optimum value causes the robot to hold the 
labware higher than the specified height.

Retry pushdown (mm) The distance, in millimeters, that the robot 
will push down on a labware after the 
absence of vacuum is detected at a vacuum 
filtration station, vacuum platepad, and 
vacuum shelf. The pressing down on the 
labware against the station, platepad, or shelf 
can help ensure a vacuum seal.

Record serial history on 
servo errors

The option that enables the software to 
record the robot communication messages to 
a log file when a servo error occurs. The log 
file can be used for troubleshooting the 
system.

Max lines in history The maximum number of lines to keep in the 
history file.

Path to history file The folder in which the history file is stored.

Test Dump History Now The command that writes data to the history 
file.

Selection or command Description



381

C   Quick reference
KiNEDx Robot Driver Diagnostics

BioCel System User Guide

KiNEDx Robot Driver Diagnostics

This topic explains the menu commands, selections, options, and status 
information in the KiNEDx Robot Diagnostics dialog box. The topics are:

• “Controls tab” on page 381

• “Waypoints tab” on page 384

• “Profiles tab” on page 385

Controls tab

Robot speed and command buttons

Selection or command Description

Robot speed The speed at which the KiNEDx Robot moves.

Rehome Moves the robot to its home position.

Open gripper Opens the robot gripper.

Closer gripper Closes the robot gripper.

Retract elbow Retracts the robot arm to ensure a minimal 
footprint.

About Displays the software version number.
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Simple Move area

Relative Move area

Source-to-Destination Move area

STOP Stops the robot.

Launch Peak KiNEDx teach 
GUI

Opens the KiNEDx Robot Teach Pendant 
dialog box.

Parameter or command Description

Teachpoint The list of teachpoints in the teachpoint file.

Departure height The height clearance, in millimeters, that the 
robot must maintain above the teachpoint as 
it moves away from the teachpoint.

Arrival height The height clearance, in millimeters, that the 
robot must maintain above the teachpoint as 
it moves toward it.

Offset The height at which the robot gripper holds 
the labware. Always set Offset at 0.

Move Moves the robot to the selected teachpoint.

Parameter or command Description

mm The vertical distance, in millimeters, to move 
the robot from its current z- axis position.

Move Z Moves the robot by the specified distance 
along the z- axis.

Parameter or command Description

Source teachpoint The teachpoint from which the robot will pick 
up labware.

Offset The height at which the robot gripper holds 
the labware at the source teachpoint. Always 
set Offset at 0.

Departure height The height clearance, in millimeters, that the 
robot must maintain above the teachpoint as 
it moves away from the teachpoint.

Selection or command Description
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KiNEDx Robot Status area

Destination teachpoint The teachpoint at which the robot will place 
labware.

Offset The height at which the robot gripper holds 
the labware at the destination teachpoint. 
Always set Offset at 0.

Arrival height The height clearance, in millimeters, that the 
robot must maintain above the teachpoint as 
it moves toward it.

Push- down overextend The additional z- axis distance, in millimeters, 
that the robot moves down past the 
teachpoint to secure the placement of the 
labware.

Set Pushdown overextended at 0 unless it is 
a vacuum station that requires the slight 
pushdown.

Swap source and destination Exchanges the source and destination 
teachpoints (the source becomes the 
destination, the destination becomes the 
source).

Move Moves the robot from the selected source 
teachpoint to the selected destination 
teachpoint.

Status Description

Shoulder position The coordinate that describes its current 
shoulder position.

Z position (mm) The coordinate that describes its current z-
axis position.

Elbow position (°) The coordinate that describes its current 
elbow position.

Wrist position (°) The coordinate that describes its current 
wrist position.

Parameter or command Description
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Waypoints tab

Waypoints table

Column Description

To reach this point The name of the teachpoint or waypoint to 
which the robot moves.

Must go to this point first The name of the teachpoint or waypoint from 
which the robot moves to reach the 
teachpoint selected in the first column.

At this speed The robot speed as it moves from the selected 
teachpoint in the second column to the 
selected teachpoint in the first column.

Using offset The option to have the robot use the device 
approach height specified in the device file. 
Doing so allows the robot to approach the 
teachpoint at the correct clearance height.

The check box is not available for terminal 
waypoints (points closest to the home 
position).
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KiNEDx Robot Status area

Profiles tab

Profile Management area

Status Description

Shoulder position The coordinate that describes its current 
shoulder position.

Z position (mm) The coordinate that describes its current z-
axis position.

Elbow position (°) The coordinate that describes its current 
elbow position.

Wrist position (°) The coordinate that describes its current 
wrist position.

Selection or command Description

Profile The list of profiles.

Create a new profile Creates a new profile.

Create a copy of this profile Creates a duplicate copy of the selected 
profile.
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Initialization Files area

Speed Definitions area

Rename this profile Renames the selected profile.

Delete this profile Deletes the selected profile.

Update this profile Saves changes to the selected profile.

Initialize this profile Initiates communication with the robot using 
the selected profile.

Selection or command Description

Parameters file The file that contains the robot home 
coordinates and other data.

Teachpoints file The file that contains the robot teachpoint 
data.

Waypoints file The file that contains the robot waypoint 
data.

Create new waypoints file Allows you to create a new waypoints file.

Selection or parameter Description

Robot- speed name The three speeds at which the KiNEDx Robot 
will move:

• Slow

• Medium

• Fast

You can use the Velocity and Acceleration 
parameters to set each speed (Slow, Medium, 
and Fast) as a percentage of the factory- set 
maximum speed.

Velocity (%) The percentage of factory- set maximum 
speed. By default:

• Slow is set at 25%.

• Medium is set at 50%.

• Fast is set at 100%.

Selection or command Description
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Options

KiNEDx Robot Status area

Acceleration (%) The percentage of factory- set maximum 
acceleration. By default:

• Slow is set at 25%.

• Medium is set at 50%.

• Fast is set at 100%.

Option Description

Always rehome during 
initialize

The option to return the robot to its home 
position during each initialization process.

Note: The robot will always rehome if power 
was disrupted since the last robot 
initialization process.

Check plate sensor after 
plate pickup

The option to verify whether the robot has 
picked up a labware.

Status Description

Shoulder position The coordinate that describes its current 
shoulder position.

Z position (mm) The coordinate that describes its current z-
axis position.

Elbow position (°) The coordinate that describes its current 
elbow position.

Wrist position (°) The coordinate that describes its current 
wrist position.

Selection or parameter Description
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compressed air requirements, 5
described, 2
device integration, 23
devices, 242
electrical requirements, 5
laboratory requirements, 5
maintenance, 174
power panel, 7
preparing for a run, 152
recovering from emergency stop, 175
robots, 15
shutting down, 36
starting up, 32

BioCel System robot
adding in device file, 40
described, 15
setting up (3-Axis Robot), 112
setting up (Direct Drive Robot), 46
setting up (KiNEDx Robot), 130

block diagrams, 347
bottle library, 343
bus voltage, Direct Drive Robot, 223

C
cleanup procedure, 36
Close command (Direct Drive Robot grippers), 218
Close gripper command (3-Axis Robot), 234
Close gripper command (KiNEDx Robot), 239
communication hubs, 18
components of system, 2
compressed air

pressure regulation, 12
requirements, 5
shutoff valve, 13
turning off, 36
turning on, 35
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computer, 2
connecting to the device, 198
described, 17
monitor, 17
monitor, adjusting angle of, 31
switching monitor display, 31
turning off, 36
turning on, 33

configuration file (Direct Drive Robot), 223
context-sensitive help, xi
custom actions, 84

D
DC power supply, 349
DDR Diagnostics, 25, 206

Advanced tab, 222, 223, 225, 226, 227
Cycler tab, 108
log area, 228
Profiles tab, 48
Setup tab, 54, 57, 219, 223
Teachpoints tab, 62

DDRFirmwareBackup_.zip, 227
DDRFirmwareUpdate_x_x_x-.zip, 225
DDRGripperx.x.sw, 225, 227
delidder air pressure regulator, 13
Departure height parameter, 144, 146
description

3-Axis Robot, 15
BioCel System, 2
Direct Drive Robot, 15
KiNEDx Robot, 16

device files
adding devices, 40
creating, 24, 40
defined, 39
saving, 40

device stacking shelves, 242
devices, 154, 243

adding and removing docking table, 9
adding to device file, 40
Automation Solutions, 23
barcode reader, auxiliary, 242, 244
communicating with, 42, 47, 113, 131
defined, 23, 39
deleting in software, 42
initializing, 42
integration in system, 23
Labware MiniHub, 242
Lid Hotel Station, 242, 266
Linear Translator, 242, 272
Microplate Conveyor, 242, 285
Microplate Exchanger, 242
Microplate Shuttle and Rotator, 242
Orbital Shaking Station, 242, 309

Phantom Robot, 243, 315
Plate Hotel, 243, 319
Plate Hub Carousel, 243, 319
platepad, 243, 329
profiles in, 47, 113, 131
stacking shelves, 242
third-party, 23
turning off, 36
turning on, 33
Vacuum Delid Station, 243, 332
waste bin, 243, 337
Weigh Pad, 243, 340

diagnostics software
3-Axis Robot, 229
described, 25
Direct Drive Robot, 206
KiNEDx Robot Driver, 237
version number, viii

digital signal channels, 255
dimensions, BioCel System, 5
Direct Drive Robot

adding in device file, 46
axes, 15
bus voltage, 223
closing grippers, 217
custom actions, 84
described, 15
disabling and enabling motors, 210, 211
elbow, 15
error messages, 189
firmware installation, 226
firmware update, 224
firmware version, 225
firmware, described, 224
gripper firmware update, 224
gripper firmware version, 225
gripper firmware, described, 224
homing grippers, 208
homing robot, 207
installing teaching jig, 72
IP address, 49
jog increments, 215, 217
jogging, 215
joints, 15
MAC address, 49
mast, 15
movements, 15
moving to safe zone, 209
moving to teachpoint, 90
multiple robots in a system, 47
opening grippers, 217
orientation coordinates, 61
orientation information, 61
orientations, atypical, 77
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orientations, common, 75
picking up labware from a teachpoint, 93
placing labware at a teachpoint, 96
profile, 47, 48, 51
regrip stations, 78
removing teaching jig, 73
restoring existing firmware, 226
specifying A1-well orientation, 75
specifying labware orientation, 75
specifying robot-arm orientation, 75
speed, selecting, 211
Teach Mode, 72
teaching jig, 71, 72
teachpoint file, 50, 69
teachpoints (examples), 64
teachpoints, creating, 74
teachpoints, defined, 60
teachpoints, editing, 102
teachpoints, replacing, 104
teachpoints, saving, 85
teachpoints, setting using labware, 88
teachpoints, setting using teaching jig, 70
teachpoints, verifying, 90
temperature, 222
transferring labware between teachpoints, 98
view, changing, 221
waist, 15
wrist, 15

disabling robot motors (3-Axis Robot), 231
disabling robot motors (Direct Drive Robot), 210, 211
disabling robot motors (KiNEDx Robot), 138
Discovered BioNet Devices (Direct Drive Robot), 48
docking tables

automated procedure, 158
described, 9
manual procedure, 161, 163
pendant for, 160
QuickDock feature, 158
windows for, 10, 156

doors, automating, 251
Drop into position option, 122
dry runs, described, 153

E
Elbow coordinate, 84
electrical requirements, 5, 183
EMERGENCY STOP

buttons, 9, 33, 175
circuit, 349
connections, 349
light curtain, using, 172
procedure, 171
recovering from, 175

enabling robot motors (3-Axis Robot), 231

enabling robot motors (Direct Drive Robot), 210, 211
enclosure windows, 257
errors

hardware, 183
ignoring, 235
messages, 189
messages (3-Axis Robot), 198
messages (Direct Drive Robot), 189
plate-sensor, 182
reporting, 203, 204
servo, 180
software, 177, 189
teachpoint, 86, 153

Ethernet switch, 18

F
filtration station, 353
firmware, 226

checking version (Direct Drive Robot), 225
described (Direct Drive Robot), 224
installing (Direct Drive Robot), 226
updating (Direct Drive Robot), 224

fuse, 9, 183, 349

G
gas supply, turning on, 35
Gripper close delay parameter, 115
gripper firmware

checking version (Direct Drive Robot), 225
described (Direct Drive Robot), 224
update (Direct Drive Robot), 224

Gripper offset parameter, 83, 232
Gripper open delay parameter, 115
grippers

opening and closing (3-Axis Robot), 233
opening and closing (Direct Drive Robot), 216
opening and closing (KiNEDx Robot), 239
opening and closing manually, 73

guidelines for setting teachpoints, 63, 71

H
hardware

errors, 183, 203
Home command (3-Axis Robot), 230
Home grippers command (Direct Drive Robot), 208
Home robot command (Direct Drive Robot), 207

I
incubator device properties, 277
interlock

air shutoff valve, 13
air system, 351
safety, 7, 10, 34, 166, 176
switch, 8, 34
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IP address, Direct Drive Robot, 49

J
job roles for readers of this guide, viii
jogging the robot (3-Axis Robot), 232
jogging the robot (Direct Drive Robot), 215
jogging the robot (KiNEDx Robot), 237
Joint space selection, 214

K
keyboard shelf, adjusting, 30
KiNEDx Robot

adding in device file, 130
arm, retracting, 239
axes, 16
described, 16
diagnostics software, 25
disabling and enabling motors, 237
disabling motors, 138
homing, 141, 238
jogging, 237
movements, 16
moving labware between teachpoints, 145
moving to teachpoints, 143
moving to waypoints, 143
profile, 131
speed, selecting, 238
teaching jig, 137, 139
teachpoints file, 136
teachpoints, defined, 135
teachpoints, editing, 149
teachpoints, setting, 137
teachpoints, verifying, 143, 147
turning off motors, 138
waypoints file, 136
waypoints, defined, 135
waypoints, editing, 149

KiNEDx Robot Driver Diagnostics, 25, 136, 237, 381
KiNEDx Robot Teach Pendant software, 138, 237
knowledge base, x

L
laboratory requirements, 5
labware

definition, 24, 184
gripper offset adjustment, 121
landscape orientation, 61
loading in system, 169
loading into Plate Hotel, 170
loading into Plate Hub Carousel, 170
moving between teachpoints (KiNEDx Robot), 145
orientation (Direct Drive Robot), 61, 63, 75
orientation in system, 169
picking up from teachpoint (Direct Drive Robot), 93

placing at teachpoint (3-Axis Robot), 125
portrait orientation, 61
transferring between teachpoints (Direct Drive Ro-

bot), 98
Labware MiniHub

described, 242
landscape labware orientation, 61
left-arm orientation, 61, 75
Lid Hotel Station

adding in device file, 267
described, 242, 266
profiles, 269
setting up, 266
status, 271
storage bays, 267, 268
teachpoints, setting, 270

lid remover, 243, 332
Light Curtain, 10, 172, 177
Linear Translator, 242

adding in device file, 273
changing the speed, 283
described, 272
homing the plate stage, 281, 282
incubator device properties, 277
jogging the plate stage, 283
profiles, 277
teachpoints, setting, 280
teachpoints, verifying, 281
turning off the motors, 282
turning on the motors, 282

Linear Translator Robot Driver Diagnostics, 281, 294
liquid-handling tubing, 174

M
MAC address, Direct Drive Robot, 49
main power, 349

switch, 9, 32
turning off, 37
turning on, 32

maintenance, 174
manifold, air distribution, 351
Max gripper offset parameter, 83
Max lines in history option, 116
Microplate Conveyor, 242

adding in device file, 286
checking the plate presence sensor, 299
described, 285
homing the plate stage, 294, 295
moving the plate stage, 296
moving the rollers, 298
moving to robot access position, 297
parking the plate stage, 298
profiles, 291
rotating the plate stage, 296
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setting up third-party devices with, 290
storage device properties, 290
teachpoints, setting, 293
teachpoints, verifying, 294
turning off the motors, 295
turning on the motors, 295

Microplate Exchanger
described, 242

Microplate Shuttle and Rotator, 242
adding in device file, 302
profiles, 306
teachpoints, 307
turning the platepad, 307

Min gripper offset parameter, 83
Move to rest position command (3-Axis Robot), 230
Move to safe zone command (Direct Drive Robot), 210
multi-color status lights, 19

N
network cards, 17

O
online help, x
Open command (Direct Drive Robot grippers), 218
Open gripper command (3-Axis Robot), 234
Open gripper command (KiNEDx Robot), 239
Orbital Shaking Station, 242, 309
orientation coordinates, 61
orientation information, 61

A1 well, 62
labware, 61
robot arm, 61

P
parameters file, 133
Path to history file option, 116
PDF guide, x
Phantom Robot, 243

adding in software, 315
described, 315

physical dimensions, 5
Pick Custom Action parameter, 84
pinch valve, 353
Place Custom Action parameter, 85
Plate Hotel, 243

adding in device file, 310
described, 319
loading, 170
teachpoints, setting, 327

Plate Hub Carousel, 243
adding in device file, 321
described, 319
home position, setting, 326
loading, 170

profile, creating, 323
teachpoints, setting, 327
turning the carousel, 326

Plate Hub Diagnostics, 325
Plate present indicator, 234
plate sensor errors, 182, 220, 234
Plate sensor indicator, 220
platepad, 243

adding in device file, 329
described, 329

plugins
loading, 41
storage location, 41

plumbing, 21
portrait labware orientation, 61
Position Z coordinate, 84
power

block diagram, 348
connection, 14, 183
outage, recovering from, 179
panel, 7
switch, 32
turning off, 36, 37
turning on, 32

power panel door lock, 9
pre-emergency stop current, 349
pre-run checks, performing, 166
pre-UPS current, 349
profiles

creating, 48, 113, 119, 131
defined, 47, 113, 131
described, 25, 47, 113, 131
initializing, 50, 134
managing, 51, 116, 134
selecting, 41

protocol runs
performing dry runs, 153
power outage, 179
resuming, 177
setup guidelines, 154
starting, 24
stopping in emergency, 171

Pump Modules, 21
Pushdown overextended parameter, 146

Q
QuickDock feature, 158

R
R & T servos off and on option, 231
Record serial history on servo errors option, 116
recovering the system, 175
Regrip offset parameter, 121
regrip stations
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described, 77
designating teachpoints as, 78

regulators, 351
Rehome command, 238
Reload Plugins command, 41
reserve tank, 353
Reset button, 8, 34, 176, 349
resting the robot, 230
restoring existing (Direct Drive Robot), 226
Retrace to safe zone (Direct Drive Robot), 210
Retract elbow command, 239
Retry pushdown parameter, 115
right-arm orientation, 61, 75
robot

adding in device file, 40
arm, retracting (KiNEDx Robot), 239
axes (3-Axis Robot), 15
axes (Direct Drive Robot), 15, 214
axes (KiNEDx Robot), 16
brakes, 350
communication time (3-Axis Robot), 236
homing (3-Axis Robot), 230
homing (Direct Drive Robot), 207
homing (KiNEDx Robot), 238
jog increments (3-Axis Robot), 232, 233
jog increments (Direct Drive Robot), 215, 217
jogging (3-Axis Robot), 232
jogging (Direct Drive Robot), 215
jogging (KiNEDx Robot), 237
opening and closing grippers (3-Axis Robot), 233
opening and closing grippers (Direct Drive Robot), 216
opening and closing grippers (KiNEDx Robot), 239
power switch, 9
recovering from servo errors, 180
speed, selecting (3-Axis Robot), 231
speed, selecting (Direct Drive Robot), 211
speed, selecting (KiNEDx Robot), 238
turning off, 37
turning on, 32, 33
view, changing (Direct Drive Robot), 221

Robot COM port parameter, 115
robot gripper air pressure regulator, 13
robot gripper pads, maintaining, 174
robot grippers

closing (3-Axis Robot), 233
closing (Direct Drive Robot), 216, 217
closing (KiNEDx Robot), 239
homing (Direct Drive Robot), 208
offset (3-Axis Robot), 232
offset (Direct Drive Robot), 83
opening (3-Axis Robot), 233
opening (Direct Drive Robot), 216, 217
opening (KiNEDx Robot), 143, 239

robot motors

disabling and enabling (3-Axis Robot), 231
disabling and enabling (Direct Drive Robot), 210, 211
disabling and enabling (KiNEDx Robot), 237

robot pressure, 184
robot-arm orientation, 61, 63, 75
Rotator

adding in software, 302
profiles, 306
teachpoints, 307
turning the plate stage, 307

run
checks before starting, 166
during power outage, 179
monitoring, 19
preparing for, 152
resuming, 177

S
safe zone, described, 208
safety

EMERGENCY STOP, 171
enclosure overhead windows, 10
general information, 4
Light Curtain, 10, 172, 177
sliding windows, 10
windows, 10
windows on docking tables, 10, 156

safety interlock, 7, 10
bypassing, 257, 349
signals for, 251, 257
turning off, 176
turning on, 34, 166

Scheduler Paused dialog box, 177
serial hub, 18
servo errors, recovering from, 180
setup workflow

3-Axis Robot, 112
Direct Drive Robot, 46
KiNEDx Robot, 130
system, 28

Show robot position command, 79
shutdown procedure, 36
Shuttle

adding in software, 302
profiles, 306
teachpoints, 307
turning the plate stage, 307

software
automation control, 24
described, 24
errors, 177, 189, 198, 203
reporting errors, 203
version number, viii, 203

specifications, BioCel System, 5
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speed, selecting
3-Axis Robot, 231
Direct Drive Robot, 211
KiNEDx Robot, 238

stack status lights, 19
Stacker, 242
stacking shelves for devices, 242
startup procedure, 32
status lights, 19, 251, 257
Staubli Robot, 16
storage device properties, 290
storage, lids, 266

T
Teach Mode command, 72
teaching jig

3-Axis Robot, 120
Direct Drive Robot, 71, 72, 73
height adjustment, 121
KiNEDx Robot, 137, 139

teachpoints
A1-well orientation (Direct Drive Robot), 75
coordinates, changing, 84
creating (Direct Drive Robot), 74
creating a copy (Direct Drive Robot), 106
defined (3-Axis Robot), 117
defined (all robots), 25
defined (Direct Drive Robot), 60
defined (KiNEDx Robot), 135
deleting (Direct Drive Robot), 106
editing (3-Axis Robot), 127
editing (Direct Drive Robot), 102
editing (KiNEDx Robot), 147, 149
file (3-Axis Robot), 118
file (Direct Drive Robot), 50, 69
file (KiNEDx Robot), 133, 136
labware orientation (Direct Drive Robot), 75
moving to (3-Axis Robot), 124
moving to (Direct Drive Robot), 90
moving to (KiNEDx Robot), 143
naming (Direct Drive Robot), 74
naming (KiNEDx Robot), 140
orientation coordinates, 61
orientation information, 61
picking up labware from (Direct Drive Robot), 93
placing labware at (Direct Drive Robot), 96
planning, 60
profile references (general), 47, 113, 131
renaming (3-Axis Robot), 128
renaming (Direct Drive Robot), 106
replacing (Direct Drive Robot), 104
robot-arm orientation (Direct Drive Robot), 75
saving, 85
setting (3-Axis Robot), 118

setting (Direct Drive Robot), 63, 70
setting (KiNEDx Robot), 137
setting, using labware (Direct Drive Robot), 88
storage location, 69, 118, 136
verifying (3-Axis Robot), 124
verifying (Direct Drive Robot), 90
verifying (KiNEDx Robot), 143

temperature, Direct Drive Robot, 222
third-party devices, 23
Tool space selection, 214
trash door, 21
troubleshooting, 25, 173, 205

hardware errors, 183
I/O channels, 263
software errors, 189

U
UPS, 21

connections, 349
turning off, 37
turning on, 33
using during power outage, 179

user accounts, 24
user guide

described, viii
related guides, ix

V
vacuum

creating, 351
system, 353

Vacuum Delid Station, 243
adding to software, 333
described, 332
teachpoints, setting, 335

Velocity parameter, 279
version numbers, software, viii
Vertical Pipetting Station

brakes, 350

W
Waist coordinate, 84
waste bin, 243

adding door to device file, 339
adding to device file, 337
described, 337
replacing, 167

waste bottle, 353
waypoints

defined, 135
editing, 149
file, 133, 136
missing, 149
moving to, 143
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naming, 140
sequence, 142
setting, 141
verifying, 143

Weigh Pad, 243
adding to device file, 341
bottle library, 343
bottle status, 345
calibrating, 344
described, 340
hub, 20
profile, creating, 341

Weigh Pad Diagnostics, 341
Windows registry files, 47, 113, 131
workflows

3-Axis Robot setup, 112
barcode reader setup, 244
Direct Drive Robot setup, 46
KiNEDx Robot setup, 130
Lid Hotel Station setup, 266
Linear Translator setup, 272
Microplate Conveyor setup, 286
Plate Hotel setup, 309
Plate Hub Carousel setup, 315, 320
preparing for a run, 152
Rotator setup, 302
Shuttle setup, 302
system setup, 28
teachpoints setup (3-Axis Robot), 118
teachpoints setup (Direct Drive Robot), 70
teachpoints setup (KiNEDx Robot), 137
Vacuum Delid Station setup, 332
Weigh Pad setup, 340

Wrist coordinate, 84

Z
Z-Brake Normal Override switch, 133
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